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The Patient Centered Management Module (PCMM) Web application assists VA facilities in implementing and monitoring patient and staff assignments in both primary care and non‑primary care teams. PCMM Web is a web application running in a browser. 
The newly developed Primary Care (PC) system balances productivity with quality, access, and patient service. In a PC setting and in the Patient-Aligned Care Team (PACT) model, patients are assigned a Primary Care Provider (PCP) who is responsible for delivering essential health care, coordinating all health care services, and serving as the point of access for VA care. A team is formed based on specific care type (i.e., Primary Care, Mental Health) and aligned around a patient, including providers across multiple VA sites and in non-VA settings for efficient care coordination and communication. The PCP works together with a team of professionals which includes nurses, pharmacists, social workers, health care professions, trainees, clerks, and more. Additionally, teams can be grouped together for a larger collaborative team.
Within PCMM Web, users can establish and define a healthcare team, assign staff and health professions trainees to positions within the team, assign patients to the team, and assign patients to practitioners, including trainees. A patient can be assigned to multiple PACT teams. Those assignments are tracked across VA stations through Multiple PACT requests, which require an approval or a denial from all involved stations. Multiple assignment requests for the same patient for different stations are allowed, but there can only be one active assignment per patient, per station at a time.
When PCMM data is entered in a standardized manner, it can be used to analyze the system and PACT workload nationally by Veterans Integrated Service Network (VISN), and by a facility and its substations, as well as at the team level. PACTs manage the overall care provided to a majority of VA health care systems, and their workload capacity is an important factor in determining the total number of patients that can be cared for in the system. 
For additional PCMM Web documentation, refer to the VA Software Document Library (VDL) Web site. 
http://www.va.gov/vdl/
Note: The new helpdesk system ServiceNow (SN) will provide PCMM Web technical support. Contact SN at [REDACTED] or use the YourIT icon on your desktop to enter a new helpdesk ticket.
[image: YourIT Help Desk icon.]
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The following are system requirements for utilizing the Patient Centered Management Module (PCMM) Web application:
Access to the Veterans Health Administration (VHA) Intranet via Microsoft Edge browser or Google Chrome Browser.
Users are required to login using a PIV Card unless the user has a PIV exemption to login with network credentials.
Required “Divisions” are assigned in PCMM Web by the Principal Facility Coordinator, Principal MH Coordinator or VISN/National PCMM Staff using PCMM Webs User Management functionality via the User Management button. 
Required “Divisions” for Vista stations are assigned to their Vista Profile by local/regional IT staff or ADPAC.  These divisions should at a minimum match what is assigned to the user in PCMM Web. (Example: If user has division 123, 123AB, 123AC and 123AD assigned in PCMM Web, they should also have these stations assigned in VistA.)
The “SCMC PCMMR WEB USER MENU” will need to be assigned as a secondary menu option in Vista for Vista mapped stations. 
[bookmark: _Toc131158843][bookmark: _Toc164156675]Access PCMM Web
Requests for access to the PCMM application, updates to the VSSC National Coordinators List, and PCMM Mailgroup are entered and managed through [REDACTED].
Once given access, users can access PCMM Web using a web browser via single sign-on capabilities. Single Sign-On Internal (SSOi) is an authentication service provided by Identity Access Management (IAM) and designated for operations-based applications such as PCMM Web.  This service provides an extra layer of security when accessing the application, while reducing time associated with multiple logon/logoff activities. A PIV card is required, unless an exception to use VA User Credentials is allowed.
Upon successful login, if user is assigned multiple facilities, the user is directed to the Select/Change Facility Screen or to the PCMM Web Home Page. If a user is assigned to multiple facilities, the user must select the appropriate facility before proceeding.
Refer to Select/Change Facility section for additional information.  If a user is only assigned to one facility, the PCMM Web Home Page displays for that facility. Once a user has selected the default facility, the PCMM Web Home Page displays it. The system then uses this Facility in all subsequent functions. 
[bookmark: _Toc131158844][bookmark: _Toc164156676]SSOi with PIV
1. Ensure your PIV card is inserted in the card reader.
1. Access PCMM Web through the web browser.
1. The VA Single Sign-On Screen displays. Click Sign In with VA PIV Card.
If the VA Single Sign-On Screen is not displaying using Internet Explorer, ensure SSL 2.0 and SSL 3.0 are unselected in the browser security settings. In your browser's top right corner, click the Tools icon and select Internet Options. Click the Advance tab and ensure the options are unselected.
[bookmark: _Toc131159022][bookmark: _Toc164156854]Figure 1 - Single Sign-On with PIV Card
[image: VA Single Sign-on shown on web page.]
The system will verify and read the PIV card. If found, the Windows Security box displays with the list of certificates associated with the PIV card.
3. Select the certificate and click OK to display the ActivClient Login window.
4. If more than one certificate displays, select Click here to view certificate properties link to display the Certificate Details box. Select the Certificate Path tab and scroll to ensure the certificate ends internal PIV Authentication. 
5. Enter your Pin Number and click OK.
6. Once the system verifies the PIV card and Pin Number match, the Select/Change Facility Screen displays or the PCMM Web Home Page. 
If the user is only authorized to a single facility, the system defaults to the authorized facility. The user does not have to select it upon login. The System recognizes this access and uses the selected facility in all subsequent functions
If the user is authorized to access multiple facilities:
If the user has previously selected a default facility, the user does not have to select a facility upon login. The system defaults to the specified default facility and uses this facility in all subsequent functions.  To change the facility, click the Facility name link in the header bar to display the Select/Change Facility page 
[bookmark: _Toc475956446][bookmark: _Toc164156677]Using VA Network ID and Password
In some cases, a user may sign-in with their VA Network Username and Password. This is only to be utilized when a PIV exemption is required.  User must call VA Help Desk and request this exemption for this option to be utilized
1. On the VA Single Sign-On Screen, click the View Other Sign-On Options link to display the VA Single Sign-On box.
[bookmark: _Toc131159026][bookmark: _Toc164156855]Figure 2 - Signing in Using VA Network ID and Password
[image: VA Single Sign-on image]
8. Click Sign in with VA Network ID.
9. The VA Single Sign-On box displays text fields to enter your VA Network ID and Password. Click Sign-In.
10. The system will verify the user and be redirected to the Select/Change Facility Screen or the PCMM Web Home Page. 
[bookmark: _Toc475956447][bookmark: _Toc164156678]Windows Authentication
1. On the VA Single Sign-On Screen, click the View Other Sign-On Options link to display the VA Single Sign-On box.
[bookmark: _Toc131159029][bookmark: _Toc164156856]Figure 3 - Signing In with Windows Authentication
[image: P669#y1][image: VA Single Sign-On image.]
12. Click Sign in with Windows Authentication.
13. The system will verify the user and the following attestation will appear.
[bookmark: _Toc164156857]Figure 4 Terms and Conditions Attestation
[image: Terms and Conditions
This U.S. Government system is intended to be used for viewing and retrieving information only, except as otherwise explicitly authorized. VA information resides on and transmits through computer systems and networks funded by VA. All use is considered to be with an understanding and acceptance that there is no reasonable expectation of privacy for any data or transmissions on Government Intranet or Extranet (non-public) networks or systems. All transactions that occur on this system and all data transmitted through this system are subject to review and action including (but not limited to) monitoring, recording, retrieving, copying, auditing, inspecting, investigating, restricting access, blocking, tracking, disclosing to authorized personnel, or any other authorized actions by all authorized VA and law enforcement personnel. All use of this system constitutes understanding and unconditional acceptance of these terms.
Unauthorized attempts or acts to either (1) access, upload, change, or delete information on this system, (2) modify this system, (3) deny access to this system, or (4) accrue resources for unauthorized use on this system are strictly prohibited. Such attempts or acts are subject to action that may result in criminal, civil, or administrative penalties.]
14. After clicking Accept, you will be redirected to the Select/Change Facility Screen or the PCMM Web Home Page. 

Notes: 
For first time logins after the PCMM Web upgrade from PCMM Legacy, a user may be prompted to set the time zone, if the system clock has changed time zones. This is usually a one-time occurrence.
Ensure each PCMM Web user has VistA privileges for the Vista mapped station(s) they have access to in PCMM Web.
If a user requires access to more than the 3-digit parent site, the user must also have access set up in VistA for that facility.  For example, if a user requires access to site 123abc, the user's new person file must contain that site. If a user only has access for site 123 in VistA, they will only be able to search for patients associated with that site. If the user needs to have access to patients at site 123a and 123ag, the new person file in Vista should have the subdivisions added.
[bookmark: _Toc131158845][bookmark: _Toc164156679]Select/Change Station
If a user is authorized to work at multiple stations, the Select/Change Station screen displays after login with a list of authorized stations. If a user is assigned to only one station, the Patient-Centered Management Module home page displays instead; skip the Select/Change Station section of this guide and refer to the PCMM Web section below for further details. 
1. On the Select/Change Station screen, select the appropriate station in the Select a Station list to access PCMM Web and click Submit. 
Note: For an easier selection, the last station accessed is highlighted in the Select a Station list.
16. To filter through the list, enter the three-digit station code in the Select Station text box and click Submit. The Patient-Centered Management Module screen will display.
[bookmark: _Toc131159031][bookmark: _Toc164156858]Figure 5 - Select/Change Station Screen
[image: Select/Change Station selection.]
[bookmark: _Log_into_PCMM][bookmark: _Toc131158846][bookmark: _Toc164156680]PCMM Web Home Page
After entering VA credentials and the appropriate station is selected (if prompted), the Patient-Centered Management Module home page displays.
To navigate to the Patient-Centered Management Module home page at any time, click the PCMM button in the upper right corner. If a user has access to User Management functionality, the PCMM button and the User Management button are displayed.
The username, station name and number are displayed in the top right corner of the application header. The VISN is displayed below the station information. 
[bookmark: _Toc131159032][bookmark: _Toc164156859]Figure 6 - Station/User Menu Bar
[image: PCMM Station and User menu bar is shown.]
If a user is only authorized to work at a single station, the system will default to that station and the station name along with its parent VISN is displayed. A user will only have access to the data for the station(s) that they are assigned to in PCMM Web.
[bookmark: _Select_or_Change][bookmark: _Toc131158847][bookmark: _Toc164156681]The Menu Bar
The menus across the top of the screen allow access to functions that a user can perform, according to role assigned to the user. 
[bookmark: _Toc131159033][bookmark: _Toc164156860]Figure 7 - PCMM Web Menu Bar
[image: Menu bar of PCMM is shown.]
[bookmark: _Toc131158848][bookmark: _Toc164156682]The Bread Crumb Trail
As a user navigates through the application, the names of screens will appear at the top left of the screen to show your location in the application. A user can click the screen names to go to that location. 
[bookmark: _Toc131159034][bookmark: _Toc164156861]Figure 8 - Breadcrumbs
[image: The bread crumb trail in PCMM is shown.]
[bookmark: _Toc131158849][bookmark: _Toc164156683]The Help Button
Clicking the blue Help button on each screen will display help that is specific to that screen. To access the Table of Contents for the entire help file, click Help > Web Help from the main menu. There is also a bread crumb trail at the top of the window that shows the location of the current help topic in the larger help file.
[bookmark: _Toc131159035][bookmark: _Toc164156862]Figure 9 - Help Icon and Help Menu Item
[image: Help icon is shown.]				[image: Help menu is shown.]
[bookmark: _Toc131158850][bookmark: _Toc164156684]The Content Area
This section of the window has explanatory text, and where all input, viewing, and PCMM Web tasks are performed. 
[bookmark: _Toc131159036][bookmark: _Toc164156863]Figure 10 - Contents Area Screen
[image: Screenshot of the PCMM Welcome screen.]
[bookmark: _Toc131158851][bookmark: _Toc164156685]The Announcements Box
Any important program announcements will display in the Announcements box.
[bookmark: _Toc131159037][bookmark: _Toc164156864]Figure 11 - Announcements Box
[image: Example of announcements area.]
[bookmark: _Toc131158852][bookmark: _Toc164156686]The Alerts Box
Any pending alerts will display in the Alerts box. Select the click here link to view the Alert Summary page.
[bookmark: _Toc131159038][bookmark: _Toc164156865]Figure 12 - Alerts Box
[image: Alerts box example.]
[bookmark: _Toc131158853][bookmark: _Toc164156687]The Footer
This area at the bottom of every application screen contains:
PCMM Audit Warning
Contact information for questions or problems
Time zone
Application Version Number
Background Processes Status
[bookmark: _Toc131159039][bookmark: _Toc164156866]Figure 13 - Footer Screen
[image: PCMM footer is shown.]
[bookmark: _Toc131158854][bookmark: _Toc164156688]PCMM Web Icons
The following table describes the icons used in the PCMM Web.
[bookmark: _Toc131159268]Table 1 - PCMM Web Icons
	Icon
	Meaning
	Page Location Example

	[image: P734C4T2#yIS1]
	Open file
	Completed Reports List

	 [image: P738C7T2#yIS1]
	Save As
	Completed Reports List

	[image: P742C10T2#yIS1]
	Run a Report
	Reports List

	[image: P746C13T2#yIS1]
	Permanently Delete
	Open Alerts List

	[image: P750C16T2#yIS1]
	View Team Roles 
	Team List

	[image: P754C19T2#yIS1]
	Add
	Team Profile
The green icon is used to select an auto inactivation date for a team assignment.

	[image: P759C22T2#yIS1]
	Edit/View Information
	Patient Profile 
Position List 
Modify an Existing Position 
Alerts Summary

	[image: P766C25T2#yIS1]
	Unassign/Remove
	Patient Profile 
Modify an Existing Group 
Open Alerts List 

	[image: P772C28T2#yIS1]
	Add a Comment 
	Open Alerts List

	[image: P776C31T2#yIS1]
	View selected Item
	Model Panel Size Calculation

	[image: P780C34T2#yIS1]
	View information 
	The information button icon is used when information on a page cannot be edited but can only be viewed. 

	[image: P784C37T2#yIS1]
	Edit/Reassign
	The edit icon is used when information on the page can be edited.
Modify an Existing Position 

	[image: P789C40T2#yIS1]
	View Patient Inactivation
	The Scheduled Inactivation Date is between 91 - 120 days

	[image: P793C43T2#yIS1]
	View Patient Inactivation
	The Scheduled Inactivation Date is between 61 - 90 days

	[image: P797C46T2#yIS1]
	View Patient Inactivation
	The Scheduled Inactivation Date is between 31 - 60 days

	[image: P801C49T2#yIS1]
	View Patient Inactivation
	The Scheduled Inactivation Date is between 1 - 30 days

	[image: P805C52T2#yIS1]
	Email
	Email staff member if an email address is associated with the record.

	[image: P809C55T2#yIS1]
	Select an item
	Search for a Group
Search for Room
Search for a Staff
Team Reassignment

	[image: P816C58T2#yIS1]
	Edit an Entry
	Edit a Preceptee assigned

	[image: P820C61T2#yIS1]
	Reassign Patient to Team
	Patient Profile

	[image: P824C64T2#yIS1]
	Convert Assignment to Canceled
	Patient Profile

	[image: P828C67T2#yIS1]
	Revert Assignment to Active
	Patient Profile

	[image: P832C70T2#yIS1]
	Date Select
	Anywhere a date is chosen.

	[image: P836C73T2#yIS1]
	Search
	Anywhere a list can be searched.

	[image: P840C76T2#yIS1]
	Filter
	Anywhere a table can be filtered


[bookmark: _Log_Out_of][bookmark: _Toc131158855][bookmark: _Toc164156689]Log Out of PCMM Web
1. Click the Log Out link on the top right side of the screen.
Figure 14 - Log Out Link
[image: Station bar is shown, highlighting location of logout button.]
18. A confirmation message is displayed. Click OK to confirm or Cancel to remain in the system.
Note: The system will log a user out if no system activity for 15 minutes.
[bookmark: ohrs_help_getting_started_login__7655][bookmark: _Login_Lockout][bookmark: _Toc131158856][bookmark: _Toc164156690]Automatic Timeout
The system automatically logs a user out after 15 minutes of inactivity. A warning message displays, counting down from 60 seconds until a user is logged off the application. 
A user may click the OK button to stop the count-down and continue working. If the system automatically logs off, the current work in PCMM Web is not saved.
[bookmark: _Log_In_Lockout][bookmark: ohrs_help_getting_started_ohrs_g_2826][bookmark: ohrs_help_getting_started_auto_t_8399][bookmark: _Automatic_Timeout][bookmark: ohrs_help_getting_started_basic__8156][bookmark: _Accessing_the_Occupational][bookmark: ohrs_help_getting_started_access_8256][bookmark: _Toc131158857][bookmark: _Toc164156691]Help With Error Messages
If the application displays an error at the time of log on or if error messages that is NOT part of data entry (e.g., a system error message), contact the VA ServiceNow Desk to log a helpdesk ticket. The new helpdesk system ServiceNow (SN) will provide PCMM Web technical support. Contact SN at [REDACTED] or use the YourIT icon on your desktop to enter a new helpdesk ticket.
With the appropriate access, a user may log a helpdesk ticket and capture a screenshot of the error, to be placed with the ticket.
[bookmark: _Toc131158858][bookmark: _Toc164156692]User Management
If a user has a role which allows access to the User Management functionality and the User Management button displays when logging into PCMM Web, the authorized user can click the User Management button to setup a user in PCMM Web. (See Table 3 page 150)
[bookmark: _Toc131158859][bookmark: _Toc164156693]Granting Access to PCMM Web
1. On the PCMM home screen, click the User Management button in the upper right corner to display the User Management screen.  
Figure 15 – Select User Management
[image: An image of the menu bar.]
20. The Search for Existing Users to Manager screen may display or click Users from the Main Menu and then Manage an Existing User to display the Search for Existing Users to Manager screen.
21. The authorized user can search for new or existing users. The system will search first within PCMM Web to see if the user is already established. If not, the system will then search using LDAP for a new user. The following are search options:
Select the Based on User ID radio button to search for a user by the VHA Network ID. This is the default search parameter.
Select the Using the full Last Name OR Using a part of the First Name and the full Last Name radio button to search by the name criteria. The last name is required for this search. If the system gets an exact match, the user will be presented with the previously established data.  If there is more than one user, the user will be presented with a user results list to select the appropriate user.
22. After the user is selected, click Submit to display the User Details screen.
23. The User Details screen enables an authorized user to manage each user’s access into PCMM Web. The authorized user will perform the following on this page:
Assign Role(s)
Search for Station(s)
Assign Station(s)
View Other Assigned Stations
Inactivate a User with a reason
View Application Permissions
[bookmark: _Toc131158860][bookmark: _Toc164156694]Assigning Roles to a User
Assign the appropriate role(s) to each user. This determines the actions the user will be allowed to perform within PCMM Web.
Available Roles – From this list of Available Roles, the authorized user will assign the appropriate Role(s) for each user and a user can have 1 or more roles assigned to perform assigned tasks.
Assigned Roles – This displays all roles the user has been assigned.
The authorized user will be allowed to move a selected role from the Available Roles section to the Assigned Roles section for the new/existing user by:
Select one or more roles and press the spacebar.
Select one or more roles and click the single arrow (Assign SELECTED or Unassign SELECTED)
Double-click a role from one area to the other.
Click the double arrow (Assign ALL or Unassign ALL) which moves ALL roles from one area to the other.
Each user MUST have at least 1 Role assigned.
[bookmark: _Toc131158861][bookmark: _Toc164156695]Assigning Stations to a User
In the Available Stations text box, enter a station number and the system will display the parent station as well as all substations. Click the double arrows to assign/unassign all of the listed stations. Or, move individual stations from one area to the other.
[bookmark: _Toc131159042][bookmark: _Toc164156869]Figure 16 - Available Stations Screen
[image: Available Stations selection box is shown.]
[bookmark: _Toc131158863][bookmark: _Toc164156696]Inactivating a User
1. Select the Inactivate check box to inactivate a user from PCMM Web. All users are setup initially as Active but can be changed by selecting the Inactivate check box.  
If the check box is selected, the user is unable to log into the PCMM Web system and an error message is displayed, indicating the user is Inactivated and unable to log in. 
25. Select the calendar icon in the Inactivation Date field to inactivate a user by a specific date. The date should not be prior to the date the new user information is created.  This option is not available when creating a new user.  
The Inactivation Date for an existing user can be established for a future or past date but cannot be before the user is created as a PCMM Web user. This field is not shown unless the Activation Indicator is selected.
26. Select the reason for a user to become inactive from the Inactivation Reason drop-down list. This feature is not available when creating a new user.
27. When inactivating a user, there MUST be 1 role and 1 station assigned to the user upon inactivation.
28. Traveling Veteran Coordinator (TVC) and VISN Coordinators should have a basic role assigned such as Reports Only when inactivating these users.
[bookmark: _Toc131159043][bookmark: _Toc164156870]Figure 17 - Inactivating a User Screen
[image: Image showing Inactivating Users selections.]
[bookmark: _Toc131158864][bookmark: _Toc164156697]Assigning Time Zone
The time zone is assigned automatically coordinated to the user’s computer.  
[bookmark: _Toc131158865][bookmark: _Toc164156698]Viewing Application Permissions
Expand the View Application Permissions toggle link to display a list of the user’s roles and permissions.
[bookmark: _Toc131158866][bookmark: _Toc164156699]Team Management
Teams consistent of staff members organized by care type (i.e., Primary Care, Mental Health) and aligned around a patient, including providers across multiple VA sites and in non-VA settings for efficient care coordination and communication. 
[bookmark: _Toc131158867][bookmark: _Toc164156700]Create a Team Profile
A user can create a new team using the Create a Team Profile screen. 
1. From the Team drop-down menu, select Create a Team. Alternatively, click the Create a Team button at the top of the Teams List screen (Teams > List All Teams). The Create a New Team screen will display. 
[bookmark: _Toc131159044][bookmark: _Toc164156871]Figure 18 - Create a Team Menu Option Screen
[image: "Create a Team" option in the Teams menu.]
The following screenshot is an example of a Primary Care Team. For other Care Types, the options and fields in the Patient Capacity section will vary. 
[bookmark: _Toc131159045][bookmark: _Toc164156872]Figure 19 - Create a New Team Screen
[image: Image showing the selection of the submit button.]
[bookmark: _Toc131158868][bookmark: _Toc164156701]Team Profile Section
1. Enter a name for the new team (required) in the Team text box. Team names must be between 3 and 30 characters. If the team name already exists for the site, an error message will appear. Teams do not span multiple sites.
31. Select the station the team is associated with from the Station drop-down list.
32. Select the specific team care type from the Care Type drop-down list. The care type available are:
Primary Care 
Primary Care - HBPC
Case Management 
Community Care
InPatient SCI 
Mental Health
NON-PC Specialty (MED/SURG)
NON-VA Care
Integrated Case Management (only 1 team allowed per 3 digit station)
33. Once a team is created, the CARE TYPE and station number cannot be modified.
34. The Primary Care type requires a Focus and an optional second Focus. Select a choice from the Focus 1 drop-down list. Select another choice from the Focus 2 drop-down list, if applicable. Note:  Focus 2 cannot be the same value as Focus 1.
35. Case Management, Mental Health, Community Care, and NON-PC Specialty (MED/SURG) have an option for a Focus. Select a choice from the Focus drop-down list. Primary Care – HBPC does not require a focus.   
36. Enter a Description, if desired.
[bookmark: _Toc131158869][bookmark: _Toc164156702]Patient Capacity section
1. Ensure the Assignment Status (Open) radio button is selected.
[bookmark: _Toc131158870][bookmark: _Toc164156703]Status Setup section
1. The Select Status drop-down defaults to Active. If needed, select Inactive to make the team inactive.
1. The Effective Date for Status Change drop-down defaults to the current date and time. Click the Calendar icon to change the effective date.
1. The Select Status Change Reason drop-down defaults to New Team. 
1. These Status Setup fields may be edited on the Create a New Team screen when a team is created. The activation date and reason are captured in Team History. 
1. Click Submit, or Cancel to exit.
1. Once the team is created, the Modify an Existing Team screen is displayed with a pop-up confirming the team was created successfully. Some team roles may be added due to the automatic model selection. If this confirmation text is not present, the setup was not completed correctly.
[bookmark: _Toc131159046][bookmark: _Toc164156873]Figure 20 – Team Creation Confirmation and display of Modify an Existing Team Screen
[image: Dialog stating "Your team was created successfully"]
[bookmark: _Toc164156704]Point of Contact – Administrative section
Displays the administrator staff member, including a phone number and email address, assigned to the team. POC is assigned at the Team Role (Positions) level. This section displays once Team Roles are established.
[bookmark: _Toc164156705]Point of Contact – Clinical section
Displays the point of contact staff member, including phone number and email address, assigned to the team. The POC is assigned at the Team Role (Positions) level. This section displays once Team Roles are established.
[bookmark: _Toc164156706]Non-Primary Care Teams: 
The Aggregated Modeled Team Capacity calculations will not be applied to Non‑Primary Care teams and therefore, will not be displayed in the Patient Capacity section. 
If the team created is NOT a Primary Care Team, a user can manually enter a panel size on the View/Adjusted Modeled Capacity screen. This number will display in the Patient Capacity section as the Team Capacity
[bookmark: _Toc131158871][bookmark: _Toc164156707]Create a Team Role (Position) Profile
When a new team is created using the team type of Primary Care, the team roles of Primary Care Provider, Care Manager, Clinical Associate and Administrative Associate and their Surrogate roles will auto-populate. When creating specific team profiles (i.e., Mental Health), certain team role (positions) are created according to the automatic model selection chosen. A user must set up team roles that will act as preceptors prior to setting up Associate Providers (preceptees).
1. From the Modify an Existing Team screen, click the View Positions & Staff Assignments link. The Position List screen will display.
[bookmark: _Toc131159047][bookmark: _Toc164156874]Figure 21 - View Positions & Staff Assignments
[image: Team Details Page with View Positions and Staff Assignments highlighted in the upper right.]
45. Click the Create a Position button to display the Create a Position screen.
The team must have a status of Active
Figure 22 – Position List Screen with the Create a Position Button Selected
[image: Position List screen with Create a Position  button highlighted.]
[bookmark: _Toc131159049][bookmark: _Toc164156876]Figure 23 - Create a New Position Screen
[image: Create a new position page with fillable areas.]
[bookmark: _Toc131158872][bookmark: _Toc164156708]General Section 
1. Select a role (e.g., Clinical Pharmacist Practitioner, Associate Provider, Social Worker, etc.) from the Team Role drop-down list. A Team Role may be established more than once within the team. The Description may be used to differentiate between two identical roles. See  Table 2 below for a list of team roles.
For a team with a Focus of Primary Care, there may only be one teamlet role of Primary Care Provider, Care Manager, Clinical Associate, and Administrative Associates for each PACT.  See the Preceptor/Preceptee Relationships section for more information.
Additional Team Roles may be established more than once within the team.
47. Enter a description of the team role in Description text box. The maximum length is 250 characters.
48. Enter the FTE number the team role would be expected to provide for in the Expected FTE field. It must be greater than 0.00 and it cannot be greater than 1.00.
Table 2- Assignable Team Roles
	Addiction Therapist
	Physician-Attending
	(Mhtc) Advance Practice Nurse

	Administrative Associate
	Physician-Psychiatrist
	Advance Practice Nurse

	Administrative Coordinator
	Physician-Subspecialty
	Recreation Therapist

	Associate Provider
	Primary Care Provider
	Advance Practice Associate Provider

	Care Manager
	Psychologist
	Peer Support Apprentice

	Case Manager
	Registered Nurse (Rn)
	Clinical Pharmacist Practitioner

	Chaplain
	Rehab/Psych Technician
	Fellow

	Clinical Associate
	Resident (Physician)
	Surrogate Clinical Associate

	Clinical Nurse Specialist
	Social Worker
	Surrogate Primary Care Provider

	Clinical Pharmacist
	Trainee
	(Mhtc) Peer Support Specialist

	Wh Primary Care Provider
	Voc Rehab Spec/Counselor
	Surrogate Associate Provider

	Registered Dietitian
	Homeless Case Manager
	Surrogate Administrative Associate

	Health Technician
	Polytrauma Case Manager
	Chaperone

	Licensed Professional Counselor
	Sci Case Manager
	Medical Director

	Licensed Practical Nurse (Lpn)
	Mhicm Case Manager
	Rehabilitation Therapist

	Licensed Vocational Nurse (Lvn)
	Vist Coordinator
	Mh Provider

	Marriage And Family Therapist (Mft)
	(Mhtc) Addiction Therapist
	Care Coordinator

	Clerk
	(Mhtc) Chaplain
	Other Mh Provider

	Medical Student
	(Mhtc) Clinical Nurse Specialist 
	Pact-Smi Mh Provider

	Surrogate Care Manager
	(Mhtc) Clinical Pharmacist 
	Respiratory Therapist

	Nurse Practitioner
	(Mhtc) Licensed Professional Counselor
	Surrogate Medical Director

	Nurse Practitioner Associate Provider
	(Mhtc) Marriage And Family Therapist 
	Provider

	Occupational Therapist
	(Mhtc) Nurse Practitioner
	Anticoag Clinical Pharmacist

	Lead Coordinator
	(Mhtc) Occupational Therapist 
	Intermediate Care Technician (Ict)

	Transition Patient Advocate
	(Mhtc) Physician Assistant 
	Service Chief

	Program Manager
	(Mhtc) Psychiatrist
	Scheduler

	Other
	(Mhtc) Psychologist
	Triage Specialist

	Patient Services Assistant
	(Mhtc) Recreation Therapist
	Physical Therapist

	Peer Support Specialist
	(Mhtc) Registered Nurse
	Whole Health Coach

	Physician Assistant
	(Mhtc) Rehab/Psych Technician
	Telehealth Clinical Technician

	Physician Assistant Associate Provider
	(Mhtc) Social Worker
	Scribe

	
	(Mhtc) Voc Rehab Spec/Counselor
	


[bookmark: _Toc131158873][bookmark: _Toc164156709]Status Setup Section 
1. Change the status if desired using the Select Status drop-down list (Active is selected by default).
1. Select the calendar icon next to the Effective Date for Status Change field to select the date and time the team role will be effective. (present date and time are shown by default). The date cannot be prior to the team’s creation date.
1. Select a reason for creating the team role from the Select Status Change Reason the drop-down list (New Team Position is selected by default).
[bookmark: _Toc131158874][bookmark: _Toc164156710]Team Placement Section 
1. Select the Team Lead check box to make a team role the team lead. There may only be one active Team Lead per team.
1. Select the Point of Contact - Administrative check box to make a team role the primary point of contact for the team. There may only be one active primary point of contact per team.
1. Select the Point of Contact - Clinical check box to make the team role the secondary point of contact for the team. There may be multiple secondary points of contacts.
[bookmark: _Toc131158875][bookmark: _Toc164156711]Patient Capacity Section 
1. The Position Capacity number is the allowed patient capacity for the calculate team model.
1. For Specific Team Roles Only According to Team Care Type. To override the allowed patient capacity number, select the Allow Position Capacity Override check box.
1. For Specific Team Roles Only According to Team Care Type. Enter the number of patients that will be allowed to be assigned to the team in the Position Capacity Override text box. 
1. For Specific Team Roles Only According to Team Care Type. If desired, enter a justification for the override in the Justification text box.
1. Click the Submit button to save the information to the database.
1. Click the View/Edit the Notification Distribution Rules link to view a list of notification types and settings for the team. 
[bookmark: _Toc131158876][bookmark: _Toc164156712]Assign Staff to a Team Role (Position)
[bookmark: _Toc131158877][bookmark: _Toc164156713]From the Modify an Existing Team page 
1. Click the View Positions and Staff Assignments link. The Position List screen will display. 
62. Click a Not Assigned link in the Staff Name column to display the Assign Staff to a Position screen. The team role must be active.
[bookmark: _Toc131159051][bookmark: _Toc164156877]Figure 24 - Assign Staff to a Position Screen
[image: Position List screen showing staff member unassigned to select for assignment.]
63. Enter all or part of a staff member's last name (with a minimum of 2 letters), select a Staff Role and click Search. If no staff member is found, click the Search VistA button for Vista mapped station or Search Cerner for Cerner mapped station. To assign a staff member, click the Select icon. The Staff Information screen will display.
Note: If the Staff Role has been indicated for the team role, the staff member must match the person class for the assignment to occur. If the staff role has not been indicated for the team role, the staff member must match the person class for the Staff Role Provider Type(s) for the assignment to occur.
PCMM Web will validate the person class of the staff members assigned to the staff roles associated with the team roles of Primary Care Provider, Associate Provider, Care Manager, and Clinical Associate.
The PCMM Web VistA/Cerner staff search will now display all staff members with the same last name in the search for staff results table even if the SSN field is blank in VistA/Cerner. 
64. Enter the Last Name with the First Initial of the First Name up to the FULL First Name of the staff member to narrow the search results (e.g., Smith, J or Smith, Jo or Smith, Jones)
[bookmark: _Toc131159052][bookmark: _Toc164156878]Figure 25 - Search for Staff Role
[image: Search for Staff screen with search section highlighted.]
65. The Assignment Date field will default to the current date. To override, click the calendar icon and select a date and time. The date cannot be prior to the team role’s creation date. If needed, click the calendar icon next to the Unassignment Date field to add an unassignment date.
66. Enter a number in the FTE field. The FTE for the staff member assigned to this team role cannot be greater than 1.00 across all roles/teams to which he or she is assigned within a station or within station(s) with the same first three digits of the station number (i.e., the parent station).
Expected FTE is the portion of a fulltime equivalent required to support the team and will default to 1.0 and may be edited to reflect a value of no less than 0.01. NOTE: Expected and Actual FTE values should be between 0.01 and 1.0. If no FTE is required, this value can be left blank.
Actual FTE is the portion of the fulltime equivalent available to support the team.
The Vacancy FTE is the difference between the Expected and Actual FTE and cannot be edited.
If there is no staff available for a required team role, the Expected FTE value displays as 1.00 by default and the Actual FTE value displays as NOT ASSIGNED. 
67. Primary Care Provider Positions Only. Select the Temporary PCP check box to identify staff temporary covering the Primary Care Provider (i.e., Locums, Gap providers). 
68. When the PCP is providing TelePACT (virtual PCP), select the Virtual PCP check box.
[bookmark: _Toc131159053][bookmark: _Toc164156879]Figure 26 - Staff Information Screen
[image: A graphic showing the Staff Information Screen layout.]
69. Click Submit to continue, Cancel to cancel. A success message and the staff member's name will display in the Staff Name column. 
[bookmark: _Toc131158878][bookmark: _Toc164156714]From the Modify an Existing Position screen
1. Click View Positions and Staff Assignments. The Position List page displays. Click icon in the Actions column that corresponds to the team role. 
[bookmark: _Toc131159054][bookmark: _Toc164156880]Figure 27 - Position List Screen with the Action Icon Selected
[image: The Position List screen showing several positions, the magnifying glass icon is highlighted.]
71. The Modify an Existing Position screen will display. The Current Staff Assignment section will display Staff Name, Role and Actual FTE. Click the Assign Staff button to assign a staff member to the team role. 
[bookmark: _Toc131159055][bookmark: _Toc164156881]Figure 28 - Modify an Existing Position Screen with the Assign Staff Button Selected
[image: The Modify an existing position screen shown with Assign Staff button highlighted.]
72. The Search for Staff dialog box displays. Enter all or part of a staff member's last name (with a minimum of 2 letters), select a Staff Role, and click Search. If no staff member is found, click the Search VistA button for Vista mapped station or Search Cerner button for Cerner mapped station. To assign a staff member, click the Select icon. The Staff Information screen will display
73. The Staff Role is displayed and can be edited. 
Note: If the staff role has been indicated for the team role, the staff member must match the person class for the assignment to occur. If the staff role has not been indicated for the team role, the staff member must match the person class for the Staff Role Provider Type(s) for the assignment to occur.
PCMM Web will validate the person class of the staff members assigned to the staff roles associated with the team roles of Primary Care Provider, Associate Provider, Care Manager, and Clinical Associate. 
[bookmark: _Toc131159056][bookmark: _Toc164156882]Figure 29 - Search for a Staff box with Staff Information Selected.
[image: An example of the Search for Staff box.]
74. Follow the steps described above to assign the staff member to the team role. 
75. When the assignment is created; the assignment date/status/reason will be captured in History.
[bookmark: _Toc131158879][bookmark: _Toc164156715]Mental Health Team Specifics
When assigning a staff member to a mental health team, each staff member is allowed to be assigned to more than one team role on the same team. This is needed since the staff member may serve as Mental Health Treatment Coordinator (MHTC) to some patents and not others. 
[bookmark: _Toc131158880][bookmark: _Toc164156716]Preceptor/Preceptee Relationships
Some of the roles are not licensed to provide medical care on their own but can when they are supervised by another licensed role. This supervision is called a "precept/preceptee relationship" and is always between two staff members in corresponding roles. The supervising member is called the "Preceptor" and the supervised is called the "Preceptee".
[bookmark: _Toc131159269]Table 3 - Preceptor/Preceptee Relationships
	Preceptor
	
	Preceptee
	
	

	If the selected Role is Resident (Physician), Nurse Practitioner (NP), or Clinical Nurse Specialist
	then
	A user must indicate this team role needs to be associated with a staffed preceptor team role on the team in order to save the team.
	>
	A message to indicate that there is not a corresponding staffed preceptor team role currently available will be displayed if there is no current preceptor team role assigned.

	If the Team PCP Role is Nurse Practitioner and is staffed
	then
	It may precept the Associate Provider Nurse Practitioner Student.
	
	

	If the Team PCP Role is Physician Assistant and is staffed
	then
	It may precept the Associate Provider Team Role of Physicians Assistant Student
	
	

	If the Team PCP Role is Physician – <<Name>> and is staffed
	then
	· It may precept all Associate Provider staff roles. 
· Physician Residents can be assigned to the Associate Provider Team Role only. 
	
	


Whenever a preceptor relationship is assigned or unassigned, history regarding the preceptor, the preceptee and their respective staff assignments and dates will be captured in the History.
1. If the team role has an Active Preceptor or Preceptee assignment, the team role cannot be inactivated until all preceptor/preceptee assignments are removed.
77. If the team role is a Preceptor, in order for the Status to be updated from Active to Inactive – all Active Preceptee Assignments for the team role must be unassigned.
78. If the team role is a Preceptee, in order for the Status to be updated from Active to Inactive – all Active Preceptor Assignments for this team role must be unassigned.
[bookmark: _Assigning_a_Preceptor/Preceptee][bookmark: _Toc131158881][bookmark: _Toc164156717]Assigning a Preceptor/Preceptee
The user can setup and staff team roles that act as preceptors first and also to exist for the preceptees.  The ability to establish a preceptor relationship cannot occur until both preceptee and preceptor roles are established and are staffed.
A user can assign a Preceptor to a team role:
1. From the Modify an Existing Position screen (locate the Current Preceptor section. Current Preceptor information is read-only on this screen. Click the Manage Preceptor button. 
Note: Alternatively, if there is an existing Preceptor assignment, click the Add Preceptor Assignment button in the Preceptor Assignment Timeline section. Add a staff member only if more than one staff member is authorized to be a preceptor.
[bookmark: _Toc131159057][bookmark: _Toc164156883]Figure 30 - Modify an Existing Position Screen with the Manage Preceptor Button Selected.
[image: The Modify an existing position screen with the manage preceptor button selected.]
80. The Create/Edit Preception Assignment dialog box is displayed with the current information: 
Click the calendar icon next to the Relationship Start Date field (required) to edit the start date. The current date/time is the default. A past date cannot be used. 
Click the calendar icon next to the Relationship End Date field to enter an end date. This is not required, but a past date cannot be used.
Click the Update button to update the dates.
Preceptor information:
The current staff member is displayed in the Staff Name drop-down list. 
Staff Role: Read-only
Team Role: Read-only
Preceptee information:
Staff Name: Read-only
Staff Role: Read-only
Team Role: Read-only
81. Click Update or click Submit to change the dates or Preceptor Staff Name. Click Cancel to cancel. 
[bookmark: _Toc131159058][bookmark: _Toc164156884]Figure 31 - Create/Edit Preception Assignment Screen
[image: The Create or Edit Preception Assignment window.]
82. A message will display to indicate the preceptor assignment was successful and the assignment/update data will be displayed in the Current Preceptor section. Click Close to close the dialog box.
[bookmark: _Toc131158882][bookmark: _Toc164156718]Preceptor Assignment Timeline
A user can edit an entry or add a new entry using this section. 
To Edit an entry:
1. Click the Edit icon in the Actions column. 
1. The Create/Edit Preception Assignment dialog box is displayed with the current information.
1. Modify the appropriate information. 
To Inactivate an entry:
1. Click the Inactivate icon (red X) in the Actions column.
1. The Are You Sure? dialog box displays. Click Confirm to confirm, Cancel to cancel.
1. The Preceptor will be inactivated. 
To Delete the entry:
1. Click the Delete icon in the Actions column.
1. Login to VistA if prompted (if already logged in, the prompted will not display). Confirm the deletion.
1. The record will be deleted.
[bookmark: _Toc131159059][bookmark: _Toc164156885]Figure 32 - Preceptor Assignment Timeline with Actions Icons Selected
[image: Preceptor Assignment timeline example.]
[bookmark: _Assign_a_Surrogate][bookmark: _Manage_Teams][bookmark: _Toc131158883][bookmark: _Toc164156719]Modify or View a Team Profile
PCMM Coordinators are able to modify and view teams.
1. Select Teams > List All Teams from the main menu to display the Team List page. 
[bookmark: _Toc131159060][bookmark: _Toc164156886]Figure 33 - List All Teams Menu Option
[image: List All Teams option is shown in the Teams menu]
93. The following actions and information are available on the Team List page: 
Team Name. Update a selected team by clicking the Team Name. 
Station number
Primary Care Provider. Email a Primary Care Provider (if there is an email address available) by clicking the email envelope icon.
Access the Position List screen for the selected team by clicking the Positions icon.
Care Type
Focus (if there is a Focus 1 and a Focus 2 listed for the team, they will be listed in this column as Focus1 value/Focus2 value)
Station Number
Status
Admin POC and phone number. Contact an Admin POC by phone, or by email by clicking the email icon.
Assignment status
Assigned Active Total
Assigned Pending Total
Available Capacity
Generate a team by clicking the Create A Team button.
94. The team list will initially be displayed in order by Name and will include all teams. The list can be sorted by any column or narrowed by applying filter values for Care Type, Focus, Station, Status and Assignments.
95. To modify a team, click on a team name link. The Modify an Existing Team page will display and the user has the option to modify fields and options.
[bookmark: _Toc131159061][bookmark: _Toc164156887]Figure 34 – Team List Screen with a Team Name Selected
[image: The team list screen, highlighting where the name of the teams are listed on the left side of the screen.]
96. Enter a new name for the team. If the new team name already exists for the site, an error message will appear.
97. Select a different Focus 1 from the drop-down list. 
98. Select a Focus 2 from the drop-down list, or change the Focus 2 selection.
99. Change the Description. 
100. Click on the Group Membership name to view/change the group associated with the team.
[bookmark: _Toc131158884][bookmark: _Toc164156720]Point of Contact – Administrative section
Displays the administrator staff member, including a phone number and email address, assigned to the team. POC is assigned at the Team Role level. 
[bookmark: _Toc131158885][bookmark: _Toc164156721]Point of Contact – Clinical section
Displays the point of contact staff member, including phone number and email address, assigned to the team. The POC is assigned at the Team Role level.
[bookmark: _Toc131158886][bookmark: _Toc164156722]Patient Capacity section
Note: Some fields may only display according to the Care Type.
1. Change the Assignment Status to allow or disallow future patient assignments to this team. (Open is default). 
1. The maximum number of team patients allowed for a team displays in the Team Capacity field.
1. View the Station Modeled Capacity (Aggregated) number for the team. Click the magnifying glass icon that corresponds to the Modeled Team Capacity to view a complete calculation. 
[bookmark: _Toc131159062][bookmark: _Toc164156888]Figure 35 - View Team Modeled Capacity Calculations
[image: An example of the Modeled Team Capacity Calculator.]
104. Depending on Care Type and to override of the modeled capacity, select the Allow Modeled Capacity Override or Allow Capacity Override check box and enter a value in the Modeled Capacity Override or Capacity Override text box. Enter a reason for the override (mandatory) in the Justification text box. 
105. Click the magnifying glass icon that corresponds to the Available Capacity to view the available assignments. The system will identify the number of available assignments by calculating the difference between the sum of the pending and active assignments from the team capacity.
106. The Assigned PENDING Total field displays the number of assignments with a pending status.
107. The Assigned ACTIVE Total field displays the number of assignments with an active status.
108. The Assigned ALL Totals field displays the number of assignments available. 
[bookmark: _Toc131159063][bookmark: _Toc164156889]Figure 36 - Modify an Existing Team Screen
[image: The Modify an Existing Team Screen.]
109. A confirmation message will display if any changes occur.
110. The Reconcile the team against applicable models option will display on the Modify an Existing Team screen. The option No is automatically selected. Select Yes to view the reconciliation results and the model linked to the team.
[bookmark: _Toc131158887][bookmark: _Toc164156723]Non-Primary Care or Non-VA Teams
The Aggregated Modeled Team Capacity calculations will not be applied to Non‑Primary Care or Non-VA teams and therefore, will not be displayed in the Patient Capacity section. 
If the team created is NOT a Primary Care Team, a user can manually enter a panel size on the View/Adjusted Modeled Capacity screen. This number will display in the Patient Capacity section as the Team Capacity.
[bookmark: _Toc131158888][bookmark: _Toc164156724]Status Change section
Users can change the team's status by clicking the View/Edit Complete Timeline link in the Status Change Timeline box near the bottom of the screen. NOTE: All patients must be unassigned from the team or explicitly assigned team position prior to inactivating a team or team position.
[bookmark: _Toc131158889][bookmark: _Toc164156725]Edit an entry
1. Select the Actions (pencil) icon that corresponds with the entry to edit.
[bookmark: _Toc131159064][bookmark: _Toc164156890]Figure 37 - Status Change Timeline Screen
[image: Status Change Timeline screen, with the edit action button highlighted.]
112. Select the status of entry from the Status drop-down menu.
113. Click the calendar icon next to the Effective Date field to select the date and time the status will be effective.
114. Select a reason for the team entry from the Status Reason drop-down list.
115. Click Submit, or Cancel to cancel the changes.  
[bookmark: _Toc131159065][bookmark: _Toc164156891]Figure 38 - Update Entry Box
[image: The Edit Status Timeline dialog box.]
116. A confirmation message will display. Click Close.
[bookmark: _Toc131158890][bookmark: _Toc164156726]Add a new entry:
1. Click the Add Entry button.
[bookmark: _Toc131159066][bookmark: _Toc164156892]Figure 39 - Status Change Timeline Screen with the Add Entry Button Selected
[image: The Status Change Timeline dialog, showing the location of the Add Entry button.]
118. Select the status of entry from the Status drop-down menu.
119. Click the calendar icon next to the Effective Date field to select the date and time the status will be effective.
120. Select a reason for the team entry from the Status Reason drop-down list.
121. Click Submit, or Cancel to cancel the changes.  
[bookmark: _Toc131159067][bookmark: _Toc164156893]Figure 40 - Add Entry Box Defined and Submit Button Selected
[image: The Add Status Timeline, highlighting the areas to input status, effective date, and status reason.]
122. A confirmation message will display.
All Active staff assignments and all Active positions on the team will be automatically unassigned and Inactivated when the Team is inactivated.
In order for the Status to be updated from Active to Inactive, all Active team roles for the team must be unassigned.
If the Status is updated from Active to Inactive; the Inactive Date must be greater or equal to the Active Date.
The Status Date and Status Reason are required and must be entered anytime the Status is changed.
The status history will also be shown in this list.
[bookmark: _Create_a_Team][bookmark: _Manage_Team_and][bookmark: _Create_a_Position][bookmark: _Toc131158891][bookmark: _Toc164156727]Modify or View a Team Role (Position) 
A user can modify or view team role attributes through the Modify an Existing Position screen. NOTE: For Primary Care care type, staff members can only be assigned one time to a team position and cannot be staffed in two different positions on the same team.
1. Locate the team to view.
1. From the Modify an Existing Team screen, click the View Positions & Staff Assignments link. The Position List screen will display.
[bookmark: _Toc131159068][bookmark: _Toc164156894]Figure 41 - Positions & Staff Assignments Link Selected to View a Team Role
[image: The position list screen, highlighting the View Positions and Staff Assignments button in the upper right of the screen.]
125. The following actions and information are available on the Position List screen:
Click the Create a Position button to create a new team role.
Click the Reconcile with Models button to reconcile the team roles with the available team models.
Team Role
Staff Role
Staff Name. Click the Staff Name link to view details about the staff member. For an unassigned team role, click the Not Assigned link to assign a staff member to a team role.
Preceptor
Preceptee(s)
Status
Expected FTE*
Actual FTE*
Vacant FTE*
Assigned Active
Actions
126. View the team model by clicking the View the Model linked to the Team link. The team care type, focus, station, all model team roles and if the roles are required are displayed. Click Close the Model to hide this information.
FTE: Full Time Equivalent. A FTE of 1.0 and indicates that the team role is a full-time. A FTE of 0.5 indicates the team role will be available half-time.
127. Click the icon in the Action column that corresponds to the desired team role to update. The Modify an Existing Position screen will display.
[bookmark: _Toc131159069][bookmark: _Toc164156895]Figure 42 - Position List with the Actions Icon Selected
[image: The position list screen, highlighting the position of the action buttons on the right side of the screen.]
[bookmark: _Toc131158892][bookmark: _Toc164156728]General Section 
The role in the Team Role drop-down list cannot be updated. A Team Role other than the required Qualifying Roles, may be established more than once within the team. The Description may be used to differentiate between two identical roles. Within some care types, if there are two staff roles on the team with the same role at the same time (active at a certain date), a message indicates the team is inconsistent. 
Note: Primary Care Provider (PCP), RN Care Manager, Clinical Associate, and Administrative Associate Primary Care qualifying roles are restricted to one per PACT.
1. Enter a description of the team role in Description text box. The maximum length is 250 characters.
1. Enter the FTE number the team role would be expected to provide for in the Expected FTE field. It must be greater than 0.00 and it cannot be greater than 1.00.
[bookmark: _Toc131158893][bookmark: _Toc164156729]Current Staff Assignment 
If there are staff members assigned to the team, the following information is displayed:
Staff Name
Staff Role
Actual FTE
Temporary PCP
1. Click the Manage Staff button to view the Staff Information screen. A user can reassign or unassign a staff member to a team role and update the FTE number.
[bookmark: _Toc131158894][bookmark: _Toc164156730]Current Preceptor 
If there is preceptor assigned to the team, the following information is displayed:
Staff Name
Staff Role
Team Role
1. If a Preceptor is not assigned, click the Manage Preceptor button to display the check box to assign a preceptor. There may only be one Active Primary Care role per team. 
[bookmark: _Toc131158895][bookmark: _Toc164156731]Team Placement Section
1. Select the Team Lead check box to make the team role the team lead. There may only be one Active Primary Care role per team. 
2. Select the Point of Contact – Administrative check box to make the team role the primary point of contact for the team. There may only be one active primary point of contact per team.
3. Select the Point of Contact - Clinical check box to make the team role the secondary point of contact for the team.  There may be multiple secondary points of contacts.
[bookmark: _Toc131158896][bookmark: _Toc164156732]Patient Capacity Section
The system will automatically display the allowed patient capacity for the calculated team model. 
1. To override this number, select the Allow Position Capacity Override check box.  
2. Enter the number of Patients that will be allowed to be assigned to the team in the Position Capacity Override text box. 
3. If desired, enter a justification for the override in the Justification text box.
4. Click the magnifying glass icon that corresponds to the Available Capacity to view the available assignments. The system will identify the number of available assignments by calculating the difference between the sum of the pending and active assignments from the team capacity.
· The Assigned PENDING Total field displays the number of assignments with a pending status.
· The Assigned ACTIVE Total field displays the number of assignments with an active status. 
· The Assigned ALL Totals field displays the number of assignments available.
5. Click the View/Edit the Notification Distribution Rules link to view a list of notification types and settings for the team. 
6. Click the Submit button to save the information to the database.
· In order for the Status to be updated from Active to Inactive, all Active Patient Assignments for the team role must be unassigned. 
· If the team role is a Preceptor, in order for the Status to be updated from Active to Inactive, all Active Preceptee Assignments for the team role must be unassigned. 
· If the Status is updated from Active to Inactive; the Inactive Date must be greater or equal to the Active Date. 
· The Status Date and Status Reason are required and must be entered anytime the Status is changed. 
7. Open the View Patient Assignments section to view a list of patients assigned to the team. When selected, the Historical Assignments option displays patients previously assigned to team. 
8. To revert to the current list, select the Current Assignments option. 
9. To filter through the patient list, use the text box provided. 
10. Quickly assign or reassign one or more patient to and from a team or a team role using the Perform Batch Operations button. 
11. Click a patient name to view the Patient Profile screen. 
· Note: Since the patients are assigned to the entire team UNLESS the team has Associate Provider roles(s) established (the user can choose whether they want to assign the PCP or AP to the patient), the patient assignments will vary depending on how the team is set up and staffed.
· A user can delete a team role that is not a part of the basic team model configuration, if no patients have been assigned to the team. 
12. From the Position List screen, click the delete icon in the Actions column that corresponds to the team role.  
· If the delete icon is not present, either the team role is a required for the team model, and the team has been reconciled against that model, or there have been patients assigned to the team. The team role can be inactivated.
13. Open the Staff Assignment Timeline section to view a list of staff records moved from the Current Assignment. 
· The Staff Assignment Timeline includes the Staff Name, Staff Role, Actual FTE, End Date, Reason , Unassignment Reason (if applicable) of all staff members assigned to/unassigned from the team role. 
· A user can add, update and delete an entry in the Staff Assignment Timeline by clicking the icons or update an assignment by clicking the New Assignment button.  The New FTE Entry button enables a user to update the FTE and Effective Date.
14. Open the Preceptor Assignment Timeline section to view a list of preceptor assignments. 
· The Preceptor Assignment Timeline includes the Start Date, End Date, Preceptor and Preceptee information. A user can edit or add a new preceptor from this list by clicking the Add Preceptor Assignment button. 
[bookmark: _Toc131159070][bookmark: _Toc164156896]Figure 43 - Modify an Existing Position Screen
[image: Modify an Existing Position screen example.]
[bookmark: _View/Edit_Surrogate_Staff][bookmark: _Toc131158897][bookmark: _Toc164156733]View or Modify Team Role (Position) History
A user can view a history of assignments and unassignments for a team role from the Team List and Modify an Existing Team screens
[bookmark: _Toc131158898][bookmark: _Toc164156734]Team List screen
1. From the main menu, click Teams > List All Teams to display the Team List page.
[bookmark: _Toc131159071][bookmark: _Toc164156897]Figure 44 - List All Teams Menu Option
[image: List All Teams option is shown in the Teams menu.]
2. Click an item in the Position column for the desired team to display the Positions List page. The team must be active.
[bookmark: _Toc131159072][bookmark: _Toc164156898]Figure 45 - Create a Team Screen with the Positions Icon Selected
[image: The create a team screen, showing the information in the table with the positions icon shown in the positions column.]

[bookmark: _Toc131158899][bookmark: _Toc164156735]Modify an Existing Team screen
1. From the main menu, click Teams > Search for a Team to display the Search for Team box. Enter the search criteria and click on the team name link. 
[bookmark: _Toc131159073][bookmark: _Toc164156899]Figure 46 - Search for Team Menu Option
[image: Search for Teams is shown in the Teams option.]
2. From the Modify an Existing Team screen, click the View Positions and Staff Assignments link. The Position List page will display. 
Figure 47 - View Positions & Staff Assignments Link Selected to Modify a Team Role
[image: The location of View Positions and Staff Assignments link in the Modify an Existing Team screen.]
3. From the Position List page, click the corresponding icon in the Actions column. The Modify an Existing Team Position screen will display.
[bookmark: _Toc131159075][bookmark: _Toc164156901]Figure 48 - Position List Screen with Actions Icon Selected to Modify the Team Role
[image: The position list screen, showing the action buttons in the Actions column.]
4. In the Status Change Timeline section at the bottom of the screen, click the View/Edit Complete Timeline link to display the history information.
[bookmark: _Toc131158900][bookmark: _Toc164156736]Update an Existing Entry
1. A user can change the team role status to Inactive by clicking the (pencil) icon in the Actions column. The Update Entry dialog box will display.
[bookmark: _Toc131159077][bookmark: _Toc164156902]Figure 49 - Updating an Existing Entry
[image: The edit button in the action column on the status change timeline page.]
2. Select a Status, Effective Date (current date/time is selected by default, and a user cannot choose a past date), and Status Reason. 
3. Click Submit to continue, Cancel to cancel. A confirmation message will display in the dialog box and click Close to continue. The updated entry will display. 
[bookmark: _Toc131159078][bookmark: _Toc164156903]Figure 50 - Update Entry Box When Modifying a Team Role
[image: The edit status timeline dialog, highlighting the inputs, status, effective date, and status reason.]
4. Click the Close Timeline link to close this section. 
[bookmark: _Toc131158901][bookmark: _Toc164156737]Add an Entry 
1. A user can add an entry to the timeline by clicking the Add Entry button. The Add Entry dialog box will display. 
[bookmark: _Toc131159079][bookmark: _Toc164156904]Figure 51 - Add an Entry Button Selected
[image: The add an entry button shown on the status change timeline page.]
2. Select a Status, Effective Date (current date/time is selected by default, and a user cannot choose a past date), and Status Reason.
3. Click Submit to continue, Cancel to cancel. A confirmation message will display in the dialog box and click Close to continue. The new entry will display in the list.
[bookmark: _Toc131159080][bookmark: _Toc164156905]Figure 52 - Add Entry Box
[image: Highlighting the Submit button at the bottom of the Add status timeline dialog.]
[bookmark: _Toc131158902][bookmark: _Toc164156738]View Team Role Attribute Change History
A user can view the adjusted capacity change history and the justification for capacity adjustment change history from the History of Position Attribute Changes screen.
1. From the Modify an Existing Position screen, click the View Position Attribute Change History link below the Submit button. The History of Position Attribute Changes screen will display.
[bookmark: _Toc131159081][bookmark: _Toc164156906]Figure 53 – View Position Attribute Change History Link Selected
[image: P1426#yIS1]
2. Open the Adjusted Capacity Change History section to view the adjusted capacity change history of the team. This is displayed in a table format with the following columns: Changed From, Changed To, Changed By, and Changed On date columns. A user can click the email icon (envelope) in the Changed By column to email the staff member. 
[bookmark: _Toc131159082][bookmark: _Toc164156907]Figure 54 – Adjusted Capacity Change History Section Expanded 
[image: P1429#yIS1]
3. Open the Justification for Capacity Adjustment Change History section to view the justification for the capacity adjustment change history. This is displayed in a table format with the following columns: Changed From, Changed To, Changed By, and Changed On date columns. A user can click the email icon (envelope) in the Changed By column to email the staff member.
[bookmark: _Toc131159083][bookmark: _Toc164156908]Figure 55 - View Justification for Capacity Adjustment Change History Section Expanded
[image: P1432#yIS1]
[bookmark: _Toc131158903][bookmark: _Toc164156739]View Team Attributes Change History
A user can view several team change history statistics using the View Team Attributes
[bookmark: _Toc131158904][bookmark: _Toc164156740]Change History link. 
1. From the Modify an Existing Team screen, click the View Team Attribute Change History link near the bottom of the screen.
[bookmark: _Toc131159084][bookmark: _Toc164156909]Figure 56 - View Team Attribute Change History Link Selected
[image: P1438#yIS1]
2. The History of Team Attribute Changes screen displays with the following sections:
· View Team Name Change History
· View Care Type Change History
· View Focus Change History
· View Assignment Status Change History
· View Adjusted Capacity Change History
· View Calculated Model Capacity -- based on the Team Change History’
[bookmark: _Toc131159085][bookmark: _Toc164156910]Figure 57 - History of Team Attribute Change Full Screen
[image: P1447#yIS1]
3. Each of these sections contains the associated data for that section in a standard table format with the following columns: Changed From, Changed To, Changed By, and Changed On date columns. A user can click the e-mail icon (envelope) to e-mail the Changed By staff member if they have an e-mail address associated with their record. 
4. Open each section to view the data associated with that section.
[bookmark: _Toc131159086][bookmark: _Toc164156911]Figure 58 - View Team Name Change & View Care Type History Sections Expanded
[image: P1451#yIS1]
[bookmark: _Toc131158905][bookmark: _Toc164156741]Validate Team Data Consistency
A user can check for data consistency errors using the Validate Team Data Consistency functionality. 
1. From the Modify an Existing Team screen, click the Validate Team Data Consistency link located at the bottom of the page.
[bookmark: _Toc131159087][bookmark: _Toc164156912]Figure 59 - Validate Team Data Consistency Link Selected
[image: P1456#yIS1]
2. A message box will display, indicating if there are any data consistency errors or if none are found.  Correct any data consistency error. Click Close. 
[bookmark: _Toc131159088][bookmark: _Toc164156913]Figure 60 - No Data Consistency Errors Were Found Message
[image: P1459#yIS1]
[bookmark: _Toc131158906][bookmark: _Toc164156742]Search for a Team by Name
[bookmark: _Modify_a_Team]A user can search for a team using the following options:
· the Search for Team screen. 
· the Patient Assignments section of the Patient Profile screen. 
· the Team List screen.  
Any of these search methods enable a user to modify or view a team’s profile. 
[bookmark: _Toc131158907][bookmark: _Toc164156743]Using the Search for Team screen
1. From the main menu, select Teams > Search for Team to display the Search for Team screen. 
[bookmark: _Toc131159089][bookmark: _Toc164156914]Figure 61 - Search for Team Menu Option
[image: Search for Teams is shown in the Teams menu.]
2. Enter part or all of a team’s name in the Name field and click Search to display the teams that match the search criteria. Alternatively, click the Search button to view a list of all teams.  
3. Click the team name link in the Name column to display the Modify an Existing Team page.
[bookmark: _Toc131159090][bookmark: _Toc164156915]Figure 62 - Search for A Team Box with a Team Selected
[image: P1473#yIS1]
[bookmark: _Toc131158908][bookmark: _Toc164156744]Using the Team List screen
1. From the main menu, select Teams > List All Teams to display the Team List screen. 
[bookmark: _Toc131159091][bookmark: _Toc164156916]Figure 63 - List All Teams Menu Option
[image: List All Teams option is shown in the Teams menu.]
2. Scroll down, or use the navigation buttons at the bottom of the page to locate the team's name in the list. 
3. Click on the team name link in the Name column to display the Modify an Existing Team page. 
[bookmark: _Toc131159092][bookmark: _Toc164156917]Figure 64 - Team List with Team Name Selected
[image: P1481#yIS1]
[bookmark: _Toc131158909][bookmark: _Toc164156745]Using the Patient Profile screen
1. From the Patient Profile page, click the View Team Assignments toggle link to display a section that indicates what team(s) the patient is (has been) assigned to. 
2. Click on the team name link in the Team column to display the Modify an Existing Team page.
[bookmark: _Toc131159093][bookmark: _Toc164156918]Figure 65 - Patient Profile with Team Name Selected
[image: P1486#yIS1]



[bookmark: _Toc131158910][bookmark: _Toc164156746]Assign a Surrogate
A PCMM teamlet surrogate is a specific individual in a similar role that is assigned to cover for the corresponding PACT staff-member during short-term or unplanned absences. When a new team is created using the team type of Primary Care, the surrogate team roles of Surrogate Primary Care Provider, Surrogate Care Manager, Surrogate Clinical Associate, and Surrogate Administrative Associate will auto-populate. 
A user can assign someone to receive their PCMM Web notifications from the notification distribution list while they are away. A surrogate receives notifications for a specified team role and can act upon the notifications. 
[bookmark: _Toc131158911][bookmark: _Toc164156747]From the Position List screen
1. From the Modify an Existing Team screen, click the View Positions & Staff Assignments link. The Position List screen will display.
[bookmark: _Toc131159094][bookmark: _Toc164156919]Figure 66 - View Positions & Staff Link Selected to Assign a Surrogate
[image: P1493#yIS1]
2. Locate the Surrogate Team Role type to assign a staff member to and click the Not Assigned link to display the Search for Staff screen.
· Note: For Primary Care Type teams, a user can assign a Surrogate Administrative Associate, Associate Provider, Care Manager, Clinical Associate, or Primary Care Provider.
[bookmark: _Toc131159095][bookmark: _Toc164156920]Figure 67 - Assign a Surrogate on the Position List Screen
[image: P1497#yIS1]
3. Enter at least two characters of a last name for the staff member. Entering first or middle names will narrow the search. Select a Staff Role from the drop-down list.
· A terminated staff member is shown as “Separated” in the search results. 
· Total FTE column includes the sum of team assignments associated with the staff member.
4. Click Search to display a list of staff names results. Click Cancel to cancel the search. 
5. Click the icon in the Select column to view the staff member’s profile. The Staff Profile screen will display.
[bookmark: _Toc131159096][bookmark: _Toc164156921]Figure 68 - Search for Staff to Assign a Surrogate
[image: P1504#yIS1]
· Optional: Click the calendar icon next to Unassignment Date field to change the unassignment date (current date and time is displayed by default).  Choose an Unassignment Reason from the drop-down list.
6. Enter a number in the FTE field.
7. Click the Submit to assign the staff member as a Surrogate.
[bookmark: _Toc131159097][bookmark: _Toc164156922]Figure 69 - Assigning a Surrogate on the Staff Information Screen
[image: P1509#yIS1]
[bookmark: _Toc131158912][bookmark: _Toc164156748]From the Modify an Existing Position screen
1. From the Modify an Existing Team page, click View Positions and Staff Assignments. The Position List page displays. Click icon in the Actions column that corresponds to the surrogate team role to staff.
[bookmark: _Toc131159098][bookmark: _Toc164156923]Figure 70 – Position List Screen with the Actions Icon Selected to Assign a Surrogate
[image: P1513#yIS1]
2. The Modify an Existing Position screen will display. The Current Staff Assignment section will display Staff Name, Role, and Actual FTE. Click the Assign Staff button to assign a staff member to the team role. The Search for Staff box displays.
[bookmark: _Toc131159099][bookmark: _Toc164156924]Figure 71 - Modify an Existing Position with the Assign Staff Button Selected
[image: P1516#yIS1]

3. Enter at least two characters of a last name for the staff member. Entering first or middle names will narrow the search. Select a Staff Role from the drop-down list.
· A terminated staff member is shown as “Separated” in the search results. 
· Total FTE column includes the sum of team assignments associated with the staff member.
4. Click Search to display a list of staff names results. Click Cancel to cancel the search. 
5. Click the icon in the Select column to view the staff member’s profile. The Staff Profile screen will display.
[bookmark: _Toc131159100][bookmark: _Toc164156925]Figure 72 - Search for Staff Screen with Select Icon
[image: P1523#yIS1]
· Optional: Click the calendar icon next to Unassignment Date field to change the unassignment date (current date and time is displayed by default).  Choose an Unassignment Reason from the drop-down list.
6. If required, enter a number in the FTE field. 
7. Click the Submit to assign the staff member as a Surrogate. 
[bookmark: _Toc131159101][bookmark: _Toc164156926]Figure 73 - Surrogate Assigned on Staff Information Screen
[image: P1528#yIS1]
[bookmark: _Toc131158913][bookmark: _Toc164156749]Modify or View Surrogate Staff Assignments
A surrogate receives notifications for a specified team role during a specified date range and can act upon the notifications.
1. From the Position List, select the icon in the Actions column in the same row of the Surrogate assignment to display the Modify an Existing Position screen.
[bookmark: _Toc131159102][bookmark: _Toc164156927]Figure 74 - Modify Surrogate From the Position List Screen
[image: P1533#yIS1]
2. In the Staff Assignments Timeline section, choose a staff member and click the edit (pencil) icon to view the Modify an Existing Position page. 
[bookmark: _Toc131159103][bookmark: _Toc164156928]Figure 75 - Modify Surrogate from the Staff Assignment Timeline Section
[image: P1536#yIS1]
3. A message will display, indicating modifications may affect the preceptor assignments. Click Confirm or Cancel.
[bookmark: _Toc131159104][bookmark: _Toc164156929]Figure 76 - Edit Entry Message
[image: P1539#yIS1]
4. Click the Search Staff button to assign a new Surrogate to the position.
5. Enter a different Assignment Date and/or a different Unassignment Date using the calendar icons.
6. Click Submit, or Cancel to cancel any changes. 
· A success message will display, and a user can view the new changes in the View Staff Assignments table. 
· A user can also choose to delete the staff member from the list. Click the Delete icon. A success message will display, and a user can view the new changes in the View Surrogate Staff Assignments table.
[bookmark: _View_Team_Attributes][bookmark: _Reconcile_Team_with][bookmark: _Toc131158914][bookmark: _Toc164156750]Reconcile Team with Models
Existing team can be reconciled with available models to create modeled team positions. 
· Note: The team must be active for the system to perform this action. 
1. Locate the desired team to reconcile. From the Modify an Existing Team screen, click the View Positions & Staff Assignments link. The Position List screen will display.
[bookmark: _Toc131159106][bookmark: _Toc164156930]Figure 77 - View Positions & Staff Assignment Link Selected to Reconcile Team with Models
[image: P1550#yIS1]View Positions & Staff Assignments hyperlink

2. Select the Yes button for the “Reconcile the team against applicable models” option and then press the submit button. If reconciliation took place, a confirmation message will appear at the top of the screen. A delete icon will appear in the Actions column for any team role that does not match the model. A user can view the reconciliation results and the model linked to the team by clicking the links at the bottom of the page.
[bookmark: _Toc131159107][bookmark: _Toc164156931]Figure 78 - Position List Screen with Message Displaying Team was Reconciled Against Models
[image: P1553#yIS1]
[bookmark: _View_or_Edit][bookmark: _View_Position_Attribute][bookmark: _Maintain_a_Team][bookmark: _Toc131158915][bookmark: _Toc164156751]Maintain a Team Model Configuration 
This task is limited to users with specific permissions and allows a user to search for or create a configuration a team model.
1. Select Teams > Search Model Configuration from the main menu to display the Search for/Create Model Configuration screen.
[bookmark: _Toc131159108][bookmark: _Toc164156932]Figure 79 - Search Model Configuration Menu Option
[image: Search / Maintain Model Configuration option is shown in the Teams menu.]
2. Select the care type from the Care Type drop-down list. 
3. If needed, select a focus from the Focus drop-down list. 
4. Enter the name of a station in the Station text box or select a station name from the list.
5. Click Find to display a list of model configurations at the bottom of the screen. If no configurations are found, a message will display.  
[bookmark: _Toc131159109][bookmark: _Toc164156933]Figure 80 - Search for Create Model Configuration Screen
[image: P1564#yIS1]
· When a team profile is submitted and saved for the first time, the system will automatically create the team roles defined in the Model Team Configuration. The Model Team Configuration is established at the National level and can be overridden if needed at the station level. It represents the required team roles as well as any optional roles that normally exist for the team based on Care Type and Focus (optionally). 
· The system first will check for the existence of a Model Team Configuration for the Team Care Type and the Team Focus for the station number a user is logged into. If a Model Team Configuration does not exist for the Team Care Type and the Team Focus for a station, the National Model Team Configuration will be used. 
· If there is a Model Team Configuration for Team Care Type and not the Team Focus, the Model Team Configuration for the Team Care Type for the station will be used. If there is not a Model Team Configuration for the Team Care Type, the National Team Configuration Model will be used.
· If there is not a Model Team Configuration in existence at the National level for a Team Care Type, there will not be any team roles automatically created.
· If a Model Team Configuration has been applied to the team, the results of the Team Position creation will be displayed.
6. An alert will be generated and sent to each recipient when a Team is created notifying the user that the Model Team Configuration for a team was created/updated in the Alert Rules for additional information on alert types and who they are sent to.
7. A user will have the ability to navigate to the current Model Team Configuration applicable to the team. 
· Note: Any team roles created by the System will appear in the Team Configuration List along with any team roles created by a PCMM Web user.
[bookmark: _Create_a_Team_1][bookmark: _Toc131158916][bookmark: _Toc164156752]Create a Role for a Team Model Configuration 
A user can create a new model role for a model team:
1. Select Teams > Search Model Configuration from the main menu to display the Search for/Create Model Configuration screen.
2. Select the Care Type, Focus, and Station. Select a Role from the Role drop-down list. 
3. Check the Required check box if the role is to be required for the team.
4. Click the Yes button to notify the PCMM Coordinators of the change. No is selected by default. 
5. Click Submit to continue, Cancel to cancel. A confirmation message will display.
[bookmark: _Calculate_Model_Panel][bookmark: _Toc131158917][bookmark: _Toc164156753]Calculate Station Modeled Capacity – Selection of Care Type
1. Select Teams > View/Adjust Station Modeled Capacity Calculation from the main menu to display the Model Panel Size Calculator – Selection of Care Type screen.
· Note: This action and menu option is limited to specific users. 
[bookmark: _Toc131159111][bookmark: _Toc164156934]Figure 81 - View/Adjust Station Modeled Capacity Calculation Menu Option
[image: View / Adjust Station Modeled Capacity Calculation is shown in the Teams menu.]
2. Select a care type from the Care Type drop-down menu.
Select the Primary Care type to display the Calculate Model Panel Size – Primary Care Worksheet screen. 
Select any other care type to display the Station Modeled Capacity Calculation – Adjustment of Model Capacity screen. 
3. Click Submit to continue, Cancel to cancel. 
[bookmark: _Toc131159112][bookmark: _Toc164156935]Figure 82 – Station Modeled Capacity Calculation - Selection of Care Type Screen
[image: P1592#yIS1]
[bookmark: _Calculate_Model_Panel_1][bookmark: _Toc131158918][bookmark: _Toc164156754]Calculate Model Panel Size - Primary Care Worksheet
A user can calculate the model panel size for a Primary Care team through the Primary Care Worksheet screen. 
If a user has selected the Primary Care type from the View/Adjust Modeled Panel Size Calculator screen, the Calculate Model Panel Size – Primary Care Worksheet screen will display.
The data is displayed in a table with two columns: Measure and Value. The last column lists the final Adjusted Model Panel Size. 
Note: This action and menu option is limited to specific users.
In addition, a user can view information by clicking the toggle control for the tables below:
View Primary Care Intensity Based Adjustment 
View Support Staff per PC FTE Based Adjustment 
View Rooms per PC FTE Based Adjustment 
View Modeled Panel Size Change History 
[bookmark: _Toc131159113][bookmark: _Toc164156936]Figure 83 - Model Panel Size Calculation - Worksheet for Primary Care Team Screen
[image: P1604#yIS1]
[bookmark: _Toc131158919][bookmark: _Toc164156755]View Primary Care Intensity Based Adjustment 
NOTE as of 10/2018: The intensity score value has been changed in the database to reflect a value of 1.0 for all patients which has effectively removed the intensity score from influencing the modeled team capacity calculation as a factor. This value continues to display on the patient and team profiles but the value should be 1.0 in all places.
[bookmark: _Toc131159114][bookmark: _Toc164156937]Figure 84 - View Intensity on Patient Profile
[image: P1608#yIS1]
[bookmark: _Toc131159115][bookmark: _Toc164156938]Figure 85 - View Intensity on Team Profile
[image: P1610#yIS1]
[bookmark: _Toc131159116][bookmark: _Toc164156939]Figure 86 - Summary of Calculation Results Screen
[image: P1612#yIS1]
[bookmark: _Toc131158920][bookmark: _Toc164156756]View Support Staff per PC FTE Based Adjustment 
The table in this section lists the Active Primary Care teams for the station with their PC and Support Staff Team Positions. Table data includes Team name, Support Staff Team Positions, Total Team Support Staff FTE, Primary Care Provider Team Positions, and Total Team Primary Care Provider FTE.  
Click a team name link in the Team Name column to open the Modify an Existing Team screen for that team. 
Click a team role link in the Support Staff Team Positions column to open the Modify an Existing Position screen for that team role associated with the team. 
Click a Primary Care team role link in the Primary Care Provider Team Positions column to open the Modify an Existing Position screen for that Primary Care team role associated with the team. 
[bookmark: _Toc131159117][bookmark: _Toc164156940]Figure 87 - Action Primary Care Teams Screen
[image: P1619#yIS1]
At the bottom of the table are displayed the Summary of Calculation Results, the associated table with measure and value columns, and the Support Staff per PC FTE Ranges and their effect on Model Panel Size. 


[bookmark: _Toc131158921][bookmark: _Toc164156757]View Rooms per PC FTE Based Adjustment 
The table in this section displays the Active Primary Care Teams with Room Assignments data with the following columns: Team Name, Examination Room Assignments, Interview Room Assignments, and Total Room Assignments for the team.  
Click a team name link in the Team Name column to open the Modify an Existing Team screen for that team. 
Click on an Examination Room Assignments link, if available, to go to the Modify an Existing Room screen. 
At the bottom of the list is displayed the Institution Totals (FTE) 
At the bottom of the table are displayed the Summary of Calculation Results, the associated table with measure and value columns, the Total Rooms per PC Provider FTE, and the Adjustment. The last table displays the Rooms per PC FTE Ranges and their effect on Model Panel Size: the columns displayed are Rooms per PC FTE Range Between... and Adjustment to Modeled Panel Size in Percent. 
[bookmark: _Toc131159118][bookmark: _Toc164156941]Figure 88 - Action Primary Care Teams with Room Assignments
[image: P1630#yIS1]
[bookmark: _Toc131158922][bookmark: _Toc164156758]View Modeled Panel Size Change History 
The compilation table in this section displays the following columns: Model Size, Start Date, End Date, Primary Care Intensity, Intensity Based Adjustment, Total Support Staff FTE, Total PC FTE, Support Staff per PC FTE, Support Staff Based Adjustment, Total Rooms FTE, Rooms per PC FTE, and the Rooms Based Adjustment.  
[bookmark: _Toc131159119][bookmark: _Toc164156942]Figure 89 - View Modeled Panel Size Change History Section
[image: P1634#yIS1]
[bookmark: _Calculate_Model_Panel_2][bookmark: _Toc131158923][bookmark: _Toc164156759]Station Modeled Capacity Calculation
A user can calculate the model panel size for a team other than a Primary Care team through the Model Panel Size Calculation – Adjustment of Modeled Capacity screen.
If another care type other than the Primary Care is selected from the View/Adjust
Modeled Panel Size Calculator screen, the Model Panel Size Calculation - Adjustment of Modeled Capacity screen will display. 
1. The Station and Care Type is read-only.
2. Enter a number for the Specify Modeled Capacity field (the most current number is the default).
3. Click Submit to continue, Cancel to cancel. A success message will display. 
[bookmark: _Toc131159120][bookmark: _Toc164156943]Figure 90 – Station Modeled Capacity Calculation – Select Care Type Screen
[image: P1643#yIS1]
4. A user can view the Modeled Size Change History by clicking the toggle control to display the table data. The table contains three columns: Model Size, Start Date and End Date, if available. This is a read-only table.
[bookmark: _Toc131159121][bookmark: _Toc164156944]Figure 91 - View Modeled Size Change History Section
[image: P1646#yIS1]
[bookmark: _Update_Primary_Care][bookmark: _Toc131158924][bookmark: _Toc164156760]View Primary Care Intensity
A user with the role of National Coordinator can update the primary care intensity score for a station. This enables the modeled team capacity calculations at a station and team level to be adjusted as needed.
1. From the main menu, select Teams > View Primary Care Intensity from the main menu to display the View Primary Care Intensity screen. The station a user is currently signed into appears in the Station field and is read-only.
2. This intensity value is set as 1.0 throughout the application for all patients and it does not influence the modeled team capacity calculations.
3. Click Cancel to return to the PCMM Web home page.
[bookmark: _Toc131159122][bookmark: _Toc164156945]Figure 92 - View Primary Care Intensity
[image: View Primary Care Intensity is shown in the Teams menu.]
[bookmark: _Toc131159123][bookmark: _Toc164156946]Figure 93 - View Primary Care Intensity Value
[image: P1655#yIS1]
[bookmark: _Validate_Team_Data][bookmark: _Toc131158925][bookmark: _Toc164156761]Patient Management 
[bookmark: _Search_for_a][bookmark: _Toc131158926][bookmark: _Toc164156762]Assign a Patient to a Team
A patient can be assigned to a team from the Patient Profile screen.
130. From the Patient drop-down menu, select Search for Patient to display the Search for Patient screen. 
[bookmark: _Toc131159124][bookmark: _Toc164156947]Figure 94 - Search for Patient Menu Option
[image: P1661#yIS1]
131. Enter the following search criteria: 
Enter the first initial of the last name, plus the last 4 digits of a social security number. 
Enter the Social Security number (complete in xxx-xx-xxxx format) in the SSN text box.
Enter the patient’s last name in the Last Name text box.
Enter the patient’s first name in the First Name text box.
Click Find to display the patient information or a list of patients in the lower part of the screen that match the search criteria.
Note: A user must enter at least the first initial or last 4 digits of SSN, last name, first name OR full SSN to execute a Patient Search. 
[bookmark: _Toc131159125][bookmark: _Toc164156948]Figure 95 - Assigning a Patient to a Team
[image: P1670#yIS1]
If patient record is labeled as Sensitive Patient, the SSN and DOB are masked.
If the system returns more than the maximum number of records allowed, the complete list of records will not display. A user can filter the search criteria further (described below), or search for the patient in VistA/Cerner.
Note: View the Search for a Patient section for further details on how to search for a patient.
132. Select the patient name link to display the Patient Profile screen.
133. In the View Team Assignments section on the Patient Profile, click the Assign button to display the Search for Team box.
[bookmark: _Toc131159126][bookmark: _Toc164156949]Figure 96 - View Team Assignments Section
[image: P1677#yIS1]
134. Enter a team name in the Name field or click the Search button, to search for a team. Select the Entire Team link to assign the patient to the team. For Primary Care, you can select the available position link (e.g., Associate Provider).
[bookmark: _Toc131159127][bookmark: _Toc164156950]Figure 97 - Assigning a Patient to a Team From the Search for Team Box
[image: P1680#yIS1]
135. If assigning to a Primary Care Team Care Type, a confirmation message displays to indicate the patient is successfully assigned to a team. For other Primary Care types (e.g., Mental Health, Community Care), the Team Assignment displays with additional steps.
136. Accept the default current date or enter a date for the Effective Date field. The effective date must be greater than the team’s Active Date and cannot be a future date.
137. In the Assign to section, select the check box beside the appropriate staff member to assign the staff member to the patient. The Mental Health Care Type is used as an example.
[bookmark: _Toc131159128][bookmark: _Toc164156951]Figure 98 - Team Assignment Box
[image: P1685#yIS1]

138. Click Submit to assign the patient to the team. A confirmation message will appear if the assignment was successful. Click OK to continue.
[bookmark: _Toc131159129][bookmark: _Toc164156952]Figure 99 - Attention Message After a Patient is Assigned to a Team
[image: P1688#yIS1]
Patient assignments to Primary Care teams will have an initial status of “Pending” until a qualifying encounter is found with a core qualifying member that was assigned to the team at the time of the encounter and the associated Multi-PACT request (if created) is approved. 
The effective date of the Pending assignment will default to the current date and time the assignment is entered, or if a qualifying encounter is found it can be backdated. After the patient is assigned to the PACT team and the system identifies a qualifying encounter, the status will update from Pending to Active. 
For all care types other than Primary Care, the initial status will be Active and the Effective Date will be the date entered during the assignment.
A patient with a Date of Death (DOD) is not allowed to be assigned to a team.
An assignment status will be Pending when initially assigned to a PACT if either a valid encounter was not found at the time of PACT assignment and will remain until a completed qualifying encounter is found and the associated Multi-PACT request (if created) is approved. Then, the assignment status converts to Active.
The patient’s PACT assignments will be evaluated enterprise wide to determine if an active PACT assignment exists in another 3-digit code station. 
A patient can be assigned to more than one non-primary care team.
The assignment will occur at the Team level, except in the case of a team with a Purpose of Primary Care. All active roles on the team will inherit the team assignment regardless of whether it is staffed or not. PCPs and/or Associate Providers on the team will be shown and a user will be able to select current and active PCP or Associate Provider for patient assignment.
All active roles on the PACT team will inherit the team assignment regardless of whether it is staffed or not. 
· Associate Providers may be added to the PACT and a user will be able to assign specific patients to each AP role.  
NON-PC teams only - The Assignment Effective Date is defaulted to the current date and will allow a user to override it, but not prior to the team’s creation date or last team discharge date, whichever is latest.
If the team is closed, assignment is not allowed.  Teams Closed for Assignment will not appear in the Team Search results list.
If the team has reached its allowed patient capacity, a warning message states that the allowed patient capacity has been reached; however, and the assignment can continue.
If the team has reached its overridden maximum patient capacity, a warning message will be displayed to indicate the maximum allowed patient capacity has been reached and the assignment can continue.
[bookmark: _Toc164156763]Assigning Patients to a Primary HBPC Team
HBPC does not have pending status. HBPC assignments immediately change to a ACTIVE status when assigned to a patient.
If the patient has a HBPC team assignment and the user tries to assign a PACT team, the HBPC assignment is inactivated and the PACT assignment goes to PENDING unless a valid qualifying encounter is found and the associated Multi-PACT request (if created) is approved which will disposition the PACT assignment to ACTIVE.
If the patient has a PENDING or ACTIVE PACT assignment and the user tries to assign a HBPC team, the PACT assignment will be dispositioned to either INACTIVE or CANCELED and the HBPC assignment goes to ACTIVE.
The user must use the “mass reassignment” function to transfer multiple patients from one HBPC team to another HBPC team.
[bookmark: _Toc131158927][bookmark: _Toc164156764]Search for a Patient
When searching for a patient, a user can only view patient information on a need-to-know basis. The role assigned to the user dictates the patient information they are allowed to view. Typically, a user is restricted to viewing patient information only for those patients assigned to the station or stations that has/have been assigned to their User ID.
Note: An employee cannot view their own data.
From the Patient drop-down menu, select Search for Patient to display the Search for Patient screen. 
[bookmark: _Toc131159130][bookmark: _Toc164156953]Figure 100 - Search for a Patient Menu Option
[image: P1713#yIS1]
139. Enter the following search criteria: 
Enter the first initial of the last name, plus the last 4 digits of a social security number. 
Enter the Social Security number (complete in xxx-xx-xxxx format) in the SSN text box.
Enter the patient’s last name in the Last Name text box.
Enter the patient’s first name in the First Name text box.
Click Find to display the patient information or a list of patients in the lower part of the screen that match the search criteria.
Note: A user must enter at least the first initial or last 4 digits of SSN, last name, first name OR full SSN to execute a Patient Search. 
[bookmark: _Toc131159131][bookmark: _Toc164156954]Figure 101 - Search for a Patient Screen
[image: P1722#yIS1]
If patient record is labeled as Sensitive Patient, the SSN and DOB are masked.
If the system returns more than the maximum number of records allowed, the complete list of records will not display. A user can filter the search criteria further (described below), or search for the patient in VistA. 
[bookmark: _Toc131158928][bookmark: _Toc164156765]If the system cannot find a patient
If the system cannot find a patient that matches the criteria entered, the following message will display: 
“No matches found for the criteria entered. Validate or expand your search criteria.” 
1. Click Close to exit out the message box. 
The system will display an additional Find in VistA button for Vista mapped station or Find in Cerner button for Cerner mapped station. 
VistA/Cerner search requires at least three letters of the last name, OR the full SSN, first name, and Date of Birth to perform a search. 
2. Enter the search criteria and select the Find in VistA or Find Cerner button (depending on station mapping). 
Note: Ensure each PCMM Web user has VistA privileges for the Vista mapped station(s) they have access to in PCMM Web. If not, an error may display.
3. The screen will refresh with the VistA or Cerner results displayed. If no records match criteria, a message will display. Validate or try the search criteria again. 
4. To add the VistA or Cerner patient, select the Name link which navigates to the Patients Profile screen. 
5. Once a patient is selected, the system will check to see if the patient is: 
A known patient to PCMM Web for the local station (no further action is require) 
A new patient to PCMM Web.
If the patient record cannot be imported into PCMM Web, a message will display. 
6. Choose Select to validate the patient record; the Patient Profile is displayed. 
Note: Once a patient is pulled into PCMM Web from VistA, the patient will no longer appear in the VistA search results, only in the PCMM Web search results. 
[bookmark: _Perform_Batch_Actions][bookmark: _View_a_Patient][bookmark: _Toc131158929][bookmark: _Toc164156766]View a Patient Profile
A user can view a patient’s profile on the Patient Profile screen. 
1. From the Patient drop-down menu, select Search for Patient to display the Search for Patient screen.
141. Enter the necessary data to narrow the search and click Find to display the patient information or a list of patient names.
[bookmark: _Toc131159133][bookmark: _Toc164156955]Figure 102 - Search for Patient Screen to View or Modify a Patient Profile
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142. Click on a patient name link in the PCMM Search Results to display the Patient Profile screen. 
[bookmark: _Toc131159134][bookmark: _Toc164156956]Figure 103 - Search for Patient Screen with the Patient Name Selected
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The Patient Profile screen displays: 
Patient Demographics
Team Assignments for the Patient
Multiple Primary Care Provider Requests
Active Non-VA Providers
Inactive Non-VA Providers History
Panel Placement Requests 
From this screen, a user can: 
Assign, and unassign a Patient to or from a team (if a user has permission) 
Reassign the direct care provider 
Update/Review a Patient's Multiple PCP Requests
View/Search/Assign for active Non-VA providers
View/Create PACT Panel Requests
[bookmark: _Toc131159135][bookmark: _Toc164156957]Figure 104 - View or Modify the Patient Profile Screen
[image: P1766#yIS1]
[bookmark: _Toc131158930][bookmark: _Toc164156767]Assign Patient to a PACT Team
The following steps explain how to assign a patient to a PACT Team.
1. Navigate to the Patient Profile screen. In the View Team Assignments section, click the Assign button to display the Search for Team box. 
1. Enter a team name in the Name field or click the Search button, to search for a team. Select the Entire Team link to assign the patient to the team.
Note: If Entire Team is selected, this assignment will be inherited by all Qualifying team roles, with an explicit assignment to the PCP.
[bookmark: _Toc131159136][bookmark: _Toc164156958]Figure 105 - Search for Team to Assign a Patient to a PACT Team
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145. Click Submit to assign the patient to the team. A confirmation message will appear if the assignment was successful. Click OK to continue.
Once the patient is assigned, a confirmation message is displayed indicating the assignment was successful.
[bookmark: _Toc131159137][bookmark: _Toc164156959]Figure 106 - Patient Assigned to a Team Attention Box
[image: P1777#yIS1]
The assignment has been made and the assignment information now populates the View Team Assignments section. The patient will need a valid encounter with any member of the teamlet except the Administrative Associate to flip the Status of the PACT team assignment from PENDING to ACTIVE.  
When a valid encounter is detected for the patient, the following occurred for the PACT assignment on the View Team Assignments section on the Patient Profile screen.
Status Column now displays ACTIVE
Start date column now displays the earliest encounter date
Last Encounter column now displays the most current encounter
Direct Care Provider now displays the most current encounter with the care provider
1. Assign a patient to another PACT Team at another facility within the same 3-digit station code. Repeat steps 1-4.
147. After the assignment process the patient has two PACT team assignments, one in ACTIVE status and the other in PENDING status. If an encounter is detected with a qualifying member of the PENDING team assignment, this team assignment will automatically flip to ACTIVE and the ACTIVE team assignment will become INACTIVE.
148. Multiple PACT team assignments per patient are allowed within PCMM Web, providing the following criteria is meet:
Each patient is allowed to have only one ACTIVE and one PENDING PACT assignment simultaneously within the same 3-digit station code to include all of the substations at any given time. The PENDING PACT assignment can only be generated after an ACTIVE assignment exists.
Each patient is allowed to have more than one ACTIVE PACT team assignments across the enterprise ONLY if there is an overall APPROVED Multi-PACT Request that is approved by all 3-digit stations holding a current ACTIVE PACT assignment as well as the station requesting the new PACT assignment.
[bookmark: _Toc131158931][bookmark: _Toc164156768]Encounter Date
When assigning a patient to a new PACT team and the user has clicked the Submit button, PCMM Web will immediately search for any valid encounters in external system (VistA or Cerner, depending on station mapping) within the last 90 days with any qualifying member to include PCP and AP, if a patient is assigned to the AP. If an encounter is found, the Last Encounter date column on the Patient and Team Profiles will be updated to the date of the encounter or the earliest date after the encounter that does not break business rules and the patient’s PACT team Status “flips” automatically to ACTIVE.
Encounters in PCMM Web are considered valid only after they are completed/checked out in external system by the encountering PACT qualifying member. Encounters may start on 1 day but may not be completed/checked out until a future date. The system only evaluates completed/checked out encounters. Encounters are evaluated by 2 processes:  
90-day lookback – This process evaluates encounters from the past 90 days at the time of assigning a patient to the PACT team. This is the only time the 90-day lookback process occurs. If the system finds a valid completed/checked out encounter, it will be applied to the patient’s PACT assignment at the time of assigning the patient to the PACT team.
Nightly Auto-Inactivation (AI) job – This process evaluates completed/checked out encounters from the last date this process ran for patients that are already assigned to a PACT team and are waiting on the encounter to be applied to their PACT assignment. If an encounter occurs after the patient is assigned to a PACT team, then the nightly AI job is responsible for picking up the valid qualifying encounter. This process starts checking for valid qualifying encounters from the last time the nightly AI job ran for a site. 
For an existing ACTIVE PACT assignment, if an encounter has occurred within the past 24 months with any core PACT qualifying member, then the Last Encounter date column on the Patient and Team Profile will be updated. This date will update each time a patient has a valid encounter with one of the PACT qualifying members. 
For a PENDING PACT assignment, if the assignment is in PENDING status and a valid qualifying encounter has been detected by the night AI job, then the Last Encounter Date and the Start Date of this team assignment will be set to the date of this encounter.  This will cause the team Status to “flip” to ACTIVE.
The START DATE of a PACT assignment should reflect the date the patient was assigned to the team if this is a new patient PACT assignment with no previous PACT assignments within the 3-digit station. 
If an encounter is applied to a patient’s profile, the START DATE may or may not change to reflect the First Encounter Date. If the patient had no previous PACT assignments, the First Encounter Date will display as the START DATE. 
If an encounter is applied to a patient’s profile and the patient had previous PACT assignments within the same 3-digit station, then the START DATE will be consistent with the END DATE of the most recent PACT assignment to prevent assignment overlaps within the system.
NOTE: The Administrative Associate does not count since the staff member cannot enter encounters.
[bookmark: _Toc131158932][bookmark: _Toc164156769]Unassign a Patient from a Team
A patient can be unassigned from a team from the Patient Profile screen.
1. In View Team Assignments section of the Patient Profile screen, view the list of teams the patient is assigned or has been unassigned.
1. Click the Unassign Patient from a Team icon (red "X") in the Actions column.  
Note: To view a description of the icon, move the mouse cursor over the icon. 
[bookmark: _Toc131159138][bookmark: _Toc164156960]Figure 107 - Unassign a Patient from a Team from the Patient Profile Screen
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Once clicked, the Confirmation warning box displays to verify whether to unassign the patient from the team. 
151. Click OK to display the Team Unassignment for: Team name dialog box or Cancel to return to the Patient Profile.
[bookmark: _Toc131159139][bookmark: _Toc164156961]Figure 108 - Unassignment Confirmation Message
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152. In the dialog box, select a value from the Reason drop-down menu.
Either accept today's default date or enter a new date in the Effective Date field. The effective date cannot be before the current assignment date and cannot be a past date.
153. Click Submit to save the data, or Cancel to return to the screen without saving the information.
[bookmark: _Toc131159140][bookmark: _Toc164156962]Figure 109 - Team Unassignment Box
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154. The system will display a confirmation message. Click Close to exit.
[bookmark: _Toc131158933][bookmark: _Toc164156770]Verify the Unassignment
To view the unassigned patient to the team, navigate to the Team Profile screen. In the View Patient Assignments section with the Current Assignments radio button selected, the patient deleted no longer displays. Select Historical Assignments radio button and the following information displays:
Status column displays CANCELED for the current team status
· PENDING status goes to CANCELED 
· ACTIVE status goes to INACTIVE
End date column displays the date and time the unassignment was made
End Reason column displays the selected reason
Actions column may display any combination of three options:
· Revert assignment to active
· View patient assignment history
· Convert assignment to canceled. This action is permanent and cannot be undone
[bookmark: _Toc131158934][bookmark: _Toc164156771]Reassign a Patient to Team Role (Position)
A user can reassign a Direct Care Provider associated with a patient.
1. In the View Team Assignments section of the Patient Profile screen, click the pencil icon in the Action column to display the Reassign position for Team box.
156. Select the calendar icon next to the Effective Date field to select a new date or accept the current default date. 
The effective date cannot be before the current assignment date and cannot be in the past. 
157. In the Assign to drop-down, select the care provider to assign to a patient. 
Choose Entire Team if the patient is assigned to a team with a care type of Primary Care or assign to an AP if appropriate. 
If the patient is assigned to a team with a purpose other than Primary Care, the system will display current and active PCP or Associate Providers. 
158. Click Submit.
159. A confirmation message displays indicating that team role reassignment was successfully.
160. In the View Team Assignments section, the Direct Care Provider is updated to reflect the recent reassignment.
To view the patient assignment history associated with any team, click the magnifying glass icon in the Action column to display the Timeline history window.
[bookmark: _Toc131158935][bookmark: _Toc164156772]Reassign a Patient to a Team
On the Patient Profile screen in the View Team Assignments section, the user can reassign a patient to a team by utilizing the same Assign process. This applies to both PC and Non-PC teams.
Note: This process only applies to a single patient. To reassign more than one patient at a time, the user will use the Perform Batch Operations process that allows two or more patients to be moved.
[bookmark: _Toc131158936][bookmark: _Toc164156773]PC Teams Only - Revert INACTIVE assignment to ACTIVE.
1. In the View Team Assignments section of the Patient Profile screen, click the revert icon in the Action column to display the Reassign position for Team box.
[bookmark: _Toc131159141][bookmark: _Toc164156963]Figure 110 - Reassign a Patient from the View Team Assignment Section
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PCMM Web will allow the user to revert an INACTIVE PACT assignment back to its previous ACTIVE status and retain the previous ACTIVE team information, if necessary. This will allow the assignment to the PACT team to bypass the qualifying encounter interrogation and to automatically revert back to Active. This functionality is only available for the latest INACTIVE assignment to the PACT team.
The ‘revert’ icon cannot be used to reactivate the latest INACTIVE assignment back to ACTIVE by removing the End Date if the patient was assigned to another PACT or HBPC team after the assignment was inactivated. A business rule prevents team assignments from overlapping. If another PACT/HBPC team was assigned after the inactivated team needing to be re-activated, then an overlap in the timeline history occurs and the system will prevent this action. For example, Team A unassigned on 8/1/15, then assigned to Team C on 9/1/15. Team A cannot be reverted because now the timeline has another entry for Team C and Team C’s Start Date is after Team A’s End Date. Team C’s Start Date cannot be removed from the timeline history table to allow the revert to occur.
162. The user is prompted to confirm the action to revert the INACTIVE assignment. Click Confirm.
[bookmark: _Toc131159142][bookmark: _Toc164156964]Figure 111 - Revert Assignment to Active Box
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163. A confirmation message is displayed. Click Close to display the Patient Profile screen.
164. The INACTIVE PACT assignment is now displayed as ACTIVE with all of the previous ACTIVE team assignment information. The End Date and End Reason have been removed and the Last Encounter date remains the same.
[bookmark: _Toc131159143][bookmark: _Toc164156965]Figure 112 - Assigned Patient on the View Team Assignments Section
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[bookmark: _Toc131158937][bookmark: _Toc164156774]PC Teams Only - Convert an INACTIVE assignment to CANCELED
PCMM Web will allow the user to convert the Status of an INACTIVE PACT assignment to CANCELED which will allow the user to then reassign the patient to the needed team and team role. 
1. In the View Team Assignments section of the Patient Profile screen, click on the cancel icon under the Actions column. 
Since CANCELED assignments are not considered when interrogating for valid encounters on more recent assignments by PCMM Web, this will allow the user to reassign the patient to the needed PACT team and team role which will create an ACTIVE assignment. 
This functionality is only available for INACTIVE PACT assignments.
Note: If the encounter date for the INACTIVE assignment is more than 60 days old, then a new encounter would be required even if the assignment was converted to CANCELED and the patient reassigned. 
166. Click the convert icon in the Actions column. 
[bookmark: _Toc131159144][bookmark: _Toc164156966]Figure 113 - Reassign a Patient to PC Team on the View Team Assignments Section
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167. The user is prompted to confirm the action to convert the INACTIVE assignment. Click Confirm.
[bookmark: _Toc131159145][bookmark: _Toc164156967]Figure 114 - Reassignment Confirmation Message
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168. A confirmation message is displayed. Click Close to display the Patient Profile screen.
The INACTIVE PACT assignment is now displayed as CANCELED. The End date and End Reason have been updated and the Last Encounter date remains the same. 
169. Click the Assign button to reassign the patient to the needed team and team role.
[bookmark: _Toc131159146][bookmark: _Toc164156968]Figure 115 - Reassign Patient to PACT Team on View Team Assignments Section
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The CANCELED PACT assignment is now displayed as ACTIVE. The user selected to assign the patient to the AP instead of the PCP during this reassignment. The End date and End Reason have been removed and the Last Encounter date was updated with the most recent encounter date within the past 60 days. PCMM Web found the encounter date that was used for the previous assignment to the team and used it to flip this assignment to ACTIVE.
[bookmark: _Toc131159147][bookmark: _Toc164156969]Figure 116 - Assigned Team Displays as Active
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[bookmark: _Toc131158938][bookmark: _Toc164156775]Non-PC Team assignments
The patient can have many other Non-PC team assignments. When assigned, the team assignment is automatically displayed as ACTIVE. Encounter dates are not used to activate Non-PC care types. These assignments will be either ACTIVE or INACTIVE.
Only the assigned MHTC for MH teams and Lead Coordinator for Transition and Care Management teams will be displayed in the Direct Care Provider column.
Note: For Transition and Care Management teams, the patient can ONLY be assigned to one of these teams per 3-digit station code to include all substations. Once a team has been created with this Care Type, the Care Type will no longer be displayed in the Care Type drop-down when creating a new team. The existing team for Transition and Care Management will be displayed in the List all Teams and Search for Team displays.

[bookmark: _Toc131158939][bookmark: _Toc164156776]Mass Reassign/Unassign Patients 
The mass transfer process enables a user to assign, reassign or unassign one or more patients from a team to another team, or a one position to another position on the same team.
To transfer patients from one team to another team, the user MUST be on the Team Profile screen.
To transfer patients from one position to another position on the same team (e.g. AP to Entire Team (PCP) / Entire Team (PCP) to AP / AP to AP), the user MUST be on the Team Position Profile screen that the staff members are explicitly assigned to before the moved is allowed. A validation error will occur when moving patients on the same team from the Team Profile screen. 
Patients with a date of death (DOD) cannot be transferred.
When transferring patients from one team to another team, the patients will be unassigned from the current team and can be viewed from the Historical Assignments in the View Patient Assignment section. 
When transferring a patient from one active team to another active team with an APPROVED Multi PACT for the previous assignment, that status is transferred to the new assignment. 
To reassign patients back to a team, navigate to Historical Assignments in the View Patient Assignments section either on the Team Profile screen or Team Position Profile screen.   
[bookmark: _Toc131158940][bookmark: _Toc164156777]Mass Reassign from the Team Profile Screen
1. In the View Patient Assignments section on the Modify an Existing Team screen, select patient name checkboxes to reassign and click the Perform Batch Operations button. The Launch Batch Operations on Patient page displays.
[bookmark: _Toc131159148][bookmark: _Toc164156970]Figure 117 - Mass Reassign on the Team Profile Screen
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171. Click the Mass Reassign button to reassign the patients to a team. To remove a patient from the list, unselect the check box next to the patient’s name. 
[bookmark: _Toc131159149][bookmark: _Toc164156971]Figure 118 - Mass Reassign on the Launch Batch Operations on Patients Screen
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172. A confirmation box displays. Click Confirm to continue or Cancel to exit the mass reassignment process. The Search for Team box displays.
[bookmark: _Toc131159150][bookmark: _Toc164156972]Figure 119 - Confirmation Message for the Mass Reassignment
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173. Enter a team name in the Name field or click the Search button, to search for a team. Click either the Entire Team, Associate Provider, or Medical Student link to display the Patient Batch Transfer/Assign screen.
[bookmark: _Toc131159151][bookmark: _Toc164156973]Figure 120 – Entire Time Link Selected on the Search for Team Box
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174. Select a reason for the transfer from the Reason drop-down. The Effective Date and Assign to auto-populates. The Assign to displays the name of the PCP, AP, or Medical Student when patients are assigned.
175. Click Submit to complete the transfer.
[bookmark: _Toc131159152][bookmark: _Toc164156974]Figure 121 - Patient Batch Transfer/Assign Box
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176. A message displays, indicating the patients are reassigned and to view the Alerts for the completion status of the assignment and to verify the assignment was made to the correct team. 
[bookmark: _Toc131158941][bookmark: _Toc164156778]Verify the Assignment
To view the newly assigned patients to the team, navigate to the Team Profile screen. In the View Current Assignments section, the Status is now Pending and will require a new encounter with a qualifying member to make the new assignment Active. Since the patients were assigned to the Entire Team, the Direct Care Provider column now displays the PCP’s name. Or, verify on the Team Position screen. In the View Team Assignments section, view the patients that were successfully assigned to the provider they were assigned.
Also, verify the historical trail of assignments for the patients are correct. The newly reassigned patients to the team will still have an entry for the previous assignment with the End date. In the View Patients Assignments section of a Team Profile or Team Position screen, select the Historical Assignments radio button. The dates for the reassignment should not overlap with the dates of the unassignment. All assignment dates should flow in a sequential pattern. 
[bookmark: _Toc131158942][bookmark: _Toc164156779]Transfer Patients from Positions on the Same Team
1. In the View Patient Assignments section on the Modify an Existing Position screen, select patient name checkboxes to reassign and click the Perform Batch Operations button. The Launch Batch Operations on Patient page displays.
178. The team and the position information involved with the transfer are displayed above the patient list.
179. Click the Mass Reassign button to reassign the patients to a team. To remove a patient from the list, unselect the check box next to the patient’s name.
180. A confirmation box displays. Click Confirm to continue or Cancel to exit the mass reassignment process.
181. Since the transfer is between positions on the same team, enter the same team name that the patients are currently assigned in the Name field or click the Search button, to search for a team. 
182. Click either the Entire Team, Associate Provider, or Medical Student link to display the Patient Batch Transfer/Assign screen.
183. Select a reason for the transfer from the Reason drop-down. The Effective Date and Assign to auto-populates. The Assign to displays the name of the PCP, AP, or Medical Student when patients are assigned.
184. Click Submit to complete the transfer.
185. A message displays, indicating the patients are reassigned and to view the Alerts for the completion status of the assignment and to verify the assignment was made to the correct team. 
[bookmark: _Toc131158943][bookmark: _Toc164156780]Mass Assignment From Historical Assignment
If one or more patients are unassigned from the Team Profile screen or the Team Position Profile screen, a mass reassignment is possible through the Historical Assignments.
1. In the View Patient Assignments section on the Modify an Existing Team or Modify an Existing Position screen, select the Historical Assignments radio button.
1. Select the patient name checkboxes and click the Perform Batch Operations button.
1. The team and the position information involved with the transfer are displayed above the patient list. Click the Mass Reassign button to reassign the patients to a team. To remove a patient from the list, unselect the check box next to the patient’s name.
1. A confirmation box displays. Click Confirm to continue or Cancel to exit the mass reassignment process.
1. Enter a team name in the Name field or click the Search button, to search for a team. Click either the Entire Team, Associate Provider, or Medical Student link to display the Patient Batch Transfer/Assign screen.
1. Select a reason for the transfer from the Reason drop-down. The Effective Date and Assign to auto-populates. The Assign to displays the name of the PCP, AP, or Medical Student when patients are assigned.
1. Click Submit to complete the transfer.
1. A message displays, indicating the patients are reassigned and to view the Alerts for the completion status of the assignment and to verify the assignment was made to the correct team. Also, the user can verify that the Status has changed to Pending requiring a new encounter date to make the new assignment active.
· When assigning patients from a Historical Assignment, the original historical entry for the patient will not be removed. This will allow the historical entry to remain, but the patient is moved to the Current Assignment list.
[bookmark: _Toc131158944][bookmark: _Toc164156781]Mass Unassign Patients
A user can perform a mass unassignment of patients from the Team Profile screen or the Team Position Profile screen. Both can be completed in the View Patient Assignments section and applies for current assignments. The example below is from the Team Profile screen.
1. In the View Patient Assignments section on the Modify an Existing Team screen, select patient name checkboxes to unassign and click the Perform Batch Operations button. The Launch Batch Operations on Patient page displays.
[bookmark: _Toc131159153][bookmark: _Toc164156975]Figure 122 - Unassign Patients from the Team Profile Screen
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195. Click the Unassign button to unassign the patients to a team.
[bookmark: _Toc131159154][bookmark: _Toc164156976]Figure 123 - Unassign from the Launch Batch Operations Patients Screen
[image: P1940#yIS1]
196. A confirmation box displays. Click Confirm to continue or Cancel to exit the unassignment process. The Unassign Selected Patients box displays.
[bookmark: _Toc131159155][bookmark: _Toc164156977]Figure 124 – Unassign Confirmation Message
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197. Select a reason for the unassignment from the Reason drop-down.
198. Select the calendar icon next to the Effective Date field to select a new date or accept the current default date. The effective date can be a past date but cannot be future dated. 
199. Click Submit to display the Patient Batch Transfer/Assign screen.
[bookmark: _Toc131159156][bookmark: _Toc164156978]Figure 125 - Unassign Selected Patients Box
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200. A message displays, indicating the patients are unassigned and to view the Alerts for the completion status and to verify the unassignment was made to the correct team.
During the process of unassigning patients from the team, patients are automatically unassigned from any explicit assignments to a team position. The unassigned patients now display in the Historical Assignments on both the Team Profile screen and the Team Position Profile screen.
If an unassigned patient was assigned to the PCP position or the Entire Team, the unassigned patient will be displayed in the PCP Position Profile screen as a Historical Assignment in the View Patient Assignments section.
If an unassigned patient was explicitly assigned to an AP position, the unassigned patient will be displayed in the AP Position Profile screen as a Historical Assignment in the View Patient Assignments section.
The user can verify that the Status of the team assignments have changed from Active assignments to Inactive assignments or Pending assignments to Canceled assignments along with the End date and time and the Reason.
[bookmark: _Un-assign_a_Patient][bookmark: _Reassign_a_Patient][bookmark: _Auto_Inactivation_of][bookmark: _Toc131158945][bookmark: _Toc164156782]Auto Inactivation of a Patient from a Team
Patients must have been established and have an assignment to Primary Care teams to be eligible for Auto Inactivation. A patient’s assignment status to a team will be inactivated automatically by the system in the following circumstances.
1. Automatic inactivation due to inactivity.
For each patient that has an active team assignment with a Care Type = Primary Care, the system will check when the patient had an encounter with any member of the PACT teamlet (i.e., the Primary Care Provider, Associate Provider, Nurse Care Manager, Clinical Associate) and will use that last encounter date as follows:
Patients must have active assignments to teams and be eligible to have their Last Encounter Date with that team recorded. 
When a patient has been identified for auto inactivation, the selected date will be displayed in the View Team Assignments table. Icons will display the amount of days before the patient will be auto inactivated.
[bookmark: _Toc131159157][bookmark: _Toc164156979]Figure 126 - Patient has been Identified for Auto Inactivation
[image: P1961#yIS1]
When a patient dies who is assigned to a team, the patient record is automatically moved from the Current Assignments list to the Historical Assignments list.
The system will schedule the patient for automatic inactivation and send out a email if the patient
has never had qualifying encounter within 120 days before 12 months from assignment to the team
— OR —
has had at least one previous qualifying encounter but not had another within 120 days before 36 months from the active assignment date
If the Scheduled Inactivation Date is within 120 days of the current date, PCMM Web will send out an alert stating that the patient will be automatically inactivated in 120 days unless an encounter occurs with a member of the PACT teamlet or is extended by a PCMM Web user. When the date of the scheduled inactivation arrives, and the patient is not extended or does not have a qualifying encounter, the patient will be automatically unassigned from his current PACT team and team roles. Assignments will then reflect a status of “Automatically unassigned due to Inactivity.” 
If Date Flagged for Inactivation had been previously recorded and a subsequent qualifying encounter is found before the team role and the team were unassigned; the assignment will remain active.
202. Automatic inactivation due to Date of Death recorded for a patient in VA teams.
When a Date of Death is recorded, the patient will be automatically unassigned from the current PC team and team role assignments with a status of Automatically unassigned due to death.  The system will send out the Automatically Inactivated Death alert) stating that the Patient has been automatically inactivated.
When a Date of Death is rescinded, the patient will be automatically reassigned to the current PC team and team role assignments.  The system will retrieve this data and populate the Position and Team Assignment Date on the PCMM Patient Team Assignment file and the Patient Provider Relationship (if needed) file. The date the patient was reassigned to the team will be recorded and displayed in PCMM web. 
[bookmark: _Inactivation_of_a][bookmark: _Toc131158946][bookmark: _Toc164156783]Manual Unassignment of Patient from a Team
[bookmark: _Unassign/Transfer_Batch_Actions]A patient’s assignment to any team can be unassigned by clicking the red “X” in the ACTION column. 
1. Once the patient’s profile is opened in PCMM Web, click the View Team Assignments toggle link to display the current list of teams to which the patient is assigned. 
204. Verify that the Show: Current Assignments radio button is selected (it is by default).
205. Click on the red “X” to manually unassign a patient from the team.
[bookmark: _Toc131159158][bookmark: _Toc164156980]Figure 127 - Manually Unassign a Patient from a Team
[image: P1978#yIS1]
206. Once the red “X” has been clicked, a Confirmation pop up appears with a WARNING for the user.
[bookmark: _Toc131159159][bookmark: _Toc164156981]Figure 128 - Manual Unassignment Warning Box
[image: P1981#yIS1]

207. User will click OK. 
208. The Team Unassignment pop-up appears and allows a user to select a REASON and EFFECTIVE DATE. The EFFECTIVE DATE can be backdated but it cannot be future dated.
209. Select Submit or Cancel to cancel.
[bookmark: _Toc131159160][bookmark: _Toc164156982]Figure 129 - Team Unassignment Reason
[image: P1987#yIS1]

[bookmark: _Create/Update/Review_Multiple_PCP][bookmark: _Multiple_PACT_Requests][bookmark: _Toc131158951][bookmark: _Toc164156784]Multiple PACT Requests for Patient
Each patient must have only one assigned PACT within the VA system.  When multiple PACT assignments are requested, a clinical decision (approval/denial) will be required. There can only be one active request per patient per 3-digit station at a time. Also, there can be multiple requests for the same patient at different stations at one time. A user can view all requested assignments for Multiple PC teams for a patient on the Patient Profile screen.
Note: Multiple PACT requests were previously known as Dual Assignment Request. Multiple PACT requests, MPACT, and Multiple PCP requests refer to the same process – all are interchangeable terms.
· If there are no active PC Assignments for this Patient at other stations, the multiple PACT request cannot be created.  
· A multi-PACT request will be auto-generated while the assignment has a pending status.
When a patient is being assigned to a PACT team at the local station, the patient’s PACT assignments will be evaluated enterprise-wide to determine if an active PACT assignment exists in another 3-digit code station. If determined and the patient has one or more active PACT assignment(s) at other 3-digit code stations, then the system will automatically generate a Multiple PACT Request (MPACT).
There can only be one pending request per patient per 3-digit code station at a time. The Multiple PACT request cannot be used to request an assignment within the same 3-digit code station.
There can be multiple requests for the same patient for different 3-digit code stations at one time.
In order to create/edit a Multiple PACT request for a patient, the patient must not have a Date of Death associated. If so, a Multiple PACT request will not be created. 
If there is a PENDING PACT assignment that turns to ACTIVE at another 3-digit station after a MPACT Request has an overall status of APPROVED for another 3-digit station, the MPACT Request WILL NOT change but the system will automatically generate a new MPACT Request for this new ACTIVE PACT assignment and add all stations that have ACTIVE PACT assignments to the Required PACT Approvers section of the MPACT Request.
[bookmark: _Toc131158953][bookmark: _Toc164156785]MPACT Request Quick Summary
Below is a quick summary of a Multiple PACT Request process. Refer to the MPACT Request Process section for a detailed outline of how a MPACT is approved and conditional requirements.
1. A PCMM PACT assignment is entered on a Patient Profile. PCMM Web will immediately search to determine if an ACTIVE PACT assignment exists at another facility.
1. If there is an active PACT assignment located, the MPACT request is automatically generated and an actionable alert is sent to the TVC at local station. All alerts are sent within PCMM Web. Only a TVC with the “Clinical Approval by” role and a person class of RN, NP, or PA, will be allowed to approve/deny a MPACT request. 
Note: Anyone can view a MPACT request on the Patient Profile once it is created.
1. Local station TVC selects the following options for the MPACT Request on the Patient Profile: (TVC will select the Reason first, enter Comments if needed on the Request and then select to Approve or Deny)
Reason: Medically Necessary or Permanent Relocation (Located towards top of request)
Comment: optional (This is provided to document any other information the TVC wants to share regarding the request)
Approve or Deny – Once the Approve or Deny button is selected, the request expands to display the approval/denial criteria. (Located at bottom of request.)
Clinical Decision by: select the clinician who approved the MPACT (i.e., doctor, TVC)
· Comments: optional (This comment is for the approval/denial process - Required if MPACT Request is denied)
213. When the local station’s MPACT request is approved, actionable alerts are sent within PCMM Web to all TVC(s) at the other stations listed on the MPACT Request requiring action on request.
214. Receiving station(s) TVC selects the following options for the MPACT Request on the Patient Profile: (TVC will select to Approve or Deny)
Approve or Deny – Once the Approve or Deny button is selected, the request expands to display the approval/denial criteria. (Located at bottom of request.)
Clinical Decision by: select the clinician who approved the MPACT (i.e., doctor, TVC)
Comments: optional (Required if MPACT Request is denied)
215. TVCs at all locations approve the MPACT Request. 
216. Pending PACT assignment status will advance to an Active PACT assignment status when a qualifying encounter is found.
217. If any of the approving stations deny the MPACT Request, the overall status of the MPACT Request will automatically change to DENIED and the PENDING PACT assignment associated with the MPACT Request will automatically be CANCELED.
All TVC coordinators on the request at every site except the site that denied the request will receive an alert.
All PCMM coordinators on request at every site except the site that denied the request will receive an alert.
218. There are three Escalation alerts that are sent regarding the MPACT Request. These escalation alerts are sent using Microsoft Outlook.
15 day Escalation Alert – Re-send alert to TVC that has not taken action on the request since the first alert was sent.
30 day Escalation Alert – Sent to VISN TVC notifying them that no action has occurred yet on the MPACT Request since the first alert was sent.
45 day Escalation Alert – Sent to National Coordinator notifying her that no action has occurred yet on the MPACT Request since the first alert was sent.
[bookmark: _Toc131158955][bookmark: _Toc164156786]Automatic Multiple PACT Request
1. The Multiple PACT request process starts when a patient is being assigned to a PACT team at the local station.   
Note: Ensure to be logged into another station than the 3-digit station code of the patient’s existing ACTIVE PACT team assignment(s).
220. On the Patient Profile screen, expand Multiple PACT Requests section to view the overall Status of the request, the date the status changes, and the Receiving Station Name which will include the team name and focus. The Reason and Action columns will populate after the local TVC approves the request.
221. In the View Team Assignments section, the user can view the existing PACT assignment(s) and all other team assignments which will include ACTIVE and PENDING assignments for the patient. The user can assign a patient to a local PACT team in the process of assigning a patient to a team.  
222. Click the Assign button to display the Team Assignment box.
223. Select the PACT team from the Assign to drop-down list and click Submit to complete the assignment.
224. If the system finds the patient is active at another station, The Multiple PACT Automatic Creation popup box will display. Click Assign Anyway to continue and complete the pending assignment, or Cancel to cancel. The Attention popup box will display. Click OK.
[bookmark: _Toc131159167][bookmark: _Toc164156983]Figure 130 - Warning: Multiple PACT Automatic Creation Message
[image: P2033#yIS1]
225. The system creates a Multiple PACT request. The Multiple PACT Request section in the Patient Profile will contain a table that lists all of the requested assignments for the Primary Care teams and display the following fields:
Status
Pending - Default when creating a new request, if all involved stations have not approved or denied the request.
Approved - If all involved stations have approved the request. 
Denied - If any of the involved stations have denied the request or
Withdrawn - If the station needing assignment cancelled the request 
Status Date
Receiving Station Name
Station Name (Station #)
Team name
Focus
Reason
Medically Necessary or Permanent Relocation
Action to view the request details
[bookmark: _Toc131159168][bookmark: _Toc164156984]Figure 131 - Multiple PACT Request section on the Patient Profile Screen
[image: P2049#yIS1]
226. A confirmation message displays stating the patient was assigned successfully to the PACT team.
227. The system sends out alerts to all involved stations (i.e. those stations holding a current active PACT assignment or the station needing assignment). An Informational Alert is sent to the station needing assignment PCMM Coordinator for awareness and an Actionable Alert to the Station Needing Assignment TVC requesting to Approve OR Deny an existing Multiple PACT Request.
· Only the facility’s Travelling Veteran Coordinator (TVC) and VISN TVC (and backups) can enter the approval/denial.
· All involved stations must approve or deny the new pending request in order for the PACT assignment at the requesting station to be considered for activation.
228. The authorized user (TVC) opens the Alerts list (see the View Open Alerts List for a Current Station section), locates the correlating Actionable alert for the request, and clicks the View/Action on Alerts icon in the Actions column. The system will display the Patient Profile screen. 
[bookmark: _Toc131159169][bookmark: _Toc164156985]Figure 132 - A MPACT Request for a Patient Alert
[image: P2056#yIS1]

229. Navigate to the Patient Profile.
230. On the Patient Profile screen, the PACT team assignment is now displayed in the View Team Assignments section. The Status is PENDING and depends on two requirements before the assignment turns to ACTIVE. The system will validate that each requirement has been met before the PACT assignment turns ACTIVE. An encounter date alone will NOT change a PENDING PACT assignment associated with a Multi PACT Request.
Requirement 1 – The patient must have a valid encounter date with a qualifying member of this team within the last 60 days.
Requirement 2 - The overall Status of the MPACT must be approved. The overall status is displayed on the patient’s profile in the Multiple PACT Requests section in the Status column. The MPACT Request will remain in PENDING status until ALL approvers listed in the Required PACT Approver table of the MPACT Request have provided an approval.
231. The Multiple PACT Requests section on the Patient Profile has been populated with the newly generated MPACT information. The following displays
Status for the Request
Pending (default when generating a new request and overall status if all involved stations have not yet approved or denied the request)
Approved (If all involved stations have approved the request)
Denied (If one of the involved stations have denied the request)
Canceled (If the station needing assignment cancelled the request)
Status Date
As the MPACT request receives approvals/denials from other stations, the overall Status and Status Date will be automatically updated to reflect new Status/Status Date.
Receiving Station Name 
Station Name (Station#), Team name, Focus
Reason (only populates after the local TVC selects it and approves the request locally)
Medically Necessary
Permanent Relocation
Action to view the request details
[bookmark: _Toc131158956][bookmark: _Toc164156787]Approving Multiple PACT Request
1. Click the Actions icon (magnifying glass) to display the Create or Edit Multiple PACT Request screen. This screen will display: 
The Multi PACT Request form will auto-populate and display the overall status of the request in the Status of the Request field. This will be Pending until all approvals are received.
Request Entered On - (user that generated the request)
Station Receiving Request – (station that generated the pending PACT assignment request)
TVC's listed for that station – (Station Name and Station Number)
This section will list the TVCs assigned to the selected station and will automatically populate users holding the “Traveling Veteran Coordinator” role (TVC) at the station. The TVC Phone and Email icon will display, if available.
Reason for Multiple PACT Request (Medically Necessary or Permanent Relocation)
Comments – (TVC may enter any additional comments, if needed.)
The Required PACT Approvals section will include: 
Station - This column will display all station names and numbers that have an ACTIVE PACT assignment and these stations will receive the Multi PACT actionable alert requesting approval/denial.
TVCs – This column will display all available TVCs for each station listed. It will display the TVC(s) name, phone number, and email address, if available.
Status:
· Pending
· Approved
· Denied
· Withdrawn
· Not Yet Submitted for Approval – Once a request is first submitted during the patient team assignment process, all other stations listed on the request form will display a Status of Not Yet Submitted for Approval to indicate the Multiple PACT Request has not been sent to the other stations for approval/denial. The Receiving Station TVC must approve or deny and select a reason before other stations are notified. Once the local TVC approves the request, the status will change for the local station to APPROVED and display as PENDING for all other stations listed on this request. Once all stations have approved this request, the Status column for all stations will display APPROVED.
Status Date – This will display a date and time any action was taken for an existing PENDING Multiple PACT Request.
Clinical Approval By
Traveling Coordinator
Comments (if any)
Actions - Resend Alerts (Only available for Station Needing Assignment)
Reason for Multiple PACT Request (Medically Necessary or Permanent Relocation)
Comments – (TVC may enter any additional comments, if needed.)
233. Select the appropriate reason from the Reason for Multiple PACT Request drop-down field. 
234. Enter any additional information or comments in the Comments field. This is optional, but helps to communicate between TVCs.
[bookmark: _Toc131159170][bookmark: _Toc164156986]Figure 133 - Create or Edit Multiple PACT Request Screen
[image: P2103#yIS1]
235. Click Approve to continue, or Deny to deny the requested approval. The status will be changed to Approve. The Entered by will be populated. The Approver selects an option from the Clinical Decision by:  drop-down field, and comments may be entered.
236. Click Submit to continue, Withdraw the Request to withdraw, or Cancel to cancel the request. If submitted, the system changes the Status to Approved in the Patient Profile and sends an alert to the original station. 
If the TVC denies the request, the pending PACT assignment request will be cancelled and closed with a reason of Denied.   
If the Multi PACT Request is Pending, ONLY the Station Needing assignment TVC role can WITHDRAW the request. This will send an Informational alert to all station(s) TVC(s) and PCMM Coordinator(s) listed on the request, stating the request is no longer needed.  The station needing the assignment can cancel the request as long as the overall status of the MPACT request is Pending. Even if the station needing assignment has approved the Multi PACT request that station can still cancel the request if its overall status is still Pending.
If another station has a pending assignment that flips to Active while a Multi PACT request still has an overall status of Pending, this station will be added to the Multi PACT request as a Required PACT Approver. The appropriate alerts will be sent to the appropriate staff members. 
Once the overall status of a Multi PACT request changes from Pending to Approved or Denied, the request will be closed and no further changes are permitted.
237. A confirmation message displays. Click Close.
[bookmark: _Toc131159171][bookmark: _Toc164156987]Figure 134 - Your Multiple PACT Request was Saved Successfully Attention Message
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238. Upon the TVC closing the Confirmation message, the system performs the following actions:
Updates the MPACT Request on the Patient Profile.
Displays the Status of the MPACT Request as PENDING since all other stations involved have not submitted approvals.
Updates the Status Date column to reflect the date and time the Station approved the request.
Displays the reason selected by the TVC for this request in the Reason column.
Sends Actionable alerts to all TVC(s) at the other stations listed on the MPACT Request in the ‘Required PACT Approvals’ section requiring action on this request.
[bookmark: _Toc131158957][bookmark: _Toc164156788]  Approve Station Process
1. The TVC at the receiving station opens the Alerts list, locates the correlating Actionable alert for the request, and clicks the View/Action on Alerts icon in the Actions column. The system will display the Patient Profile screen.  
[bookmark: _Toc131159172][bookmark: _Toc164156988]Figure 135 - Multiple Pact Approval Alert
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240. The TVC opens the Multiple PACT Requests section and clicks the icon in the Action column for the corresponding record to display the Multiple PACT Automatic Creation box.
[bookmark: _Toc131159173][bookmark: _Toc164156989]Figure 136 - Multiple Pact Requests with a Pending Status
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241. The TVC scrolls down to the Required PACT Approvals section. 
242. The TVC has the option of resending the alert to the stations listed by clicking the Resend Alert button in the Actions column. 
243. The TVC clicks Approve to continue (and may enter comments if desired), Deny to suspend the approval process. If Deny is selected, the TVC will be required to select a Reason and Date. 
All involved stations must approve or deny the new pending request in order for the PACT assignment at the station to be considered for activation.
Once a request has been approved or denied – no further edits are permitted.
The other involved stations cannot edit any data. Stations can only approve or deny the request.  
The TVC(s) must enter who made the clinical decision to Approve or Deny the request.  This indicates if the TVC is approving the request or on behalf of someone else who authorized the approval. This drop-down list will include all PCMM Web users who hold the clinical approver permission and is required.
[bookmark: _Toc131159174][bookmark: _Toc164156990]Figure 137 - Approving a MPACT on the Required Pact Approvals Section
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244. The TVC clicks Submit and the record is saved. 
245. The request will be saved with an assignment status of Approved for the station approving the request. The overall status of the request will remain Pending until all required approvals have been obtained. An Informational Alert will be sent to all TVC(s) at the other approving station(s) except the TVC’s station that just provided the approval.
If the MPACT request is approved by all involved stations being asked to approve/deny the request, the status of the entire request will then be Approved. An information alert will be sent to all TVC(s) and PCMM Coordinators. 
[bookmark: _Toc131158958][bookmark: _Toc164156789]TVC Denial of Request
[bookmark: _Panel_Placement]The request will be saved with an assignment status of Denied. An Informational Alert will be sent to all TVC(s) and PCMM Coordinator(s) at the other approving station(s) except the TVC’s and PCMM Coordinator’s station that just provided the denial. 
If the MPACT request is denied by one station within all the stations being asked to approve/deny the request, the status of the entire request will then be Denied. No further action on this request will be possible by any other approvers whose approval may be pending.
1. The system displays the details of the submitted request in the timeline on the Patient Profile screen.
The system will track that all approvals needed are received.  When they are, the assignment will be interrogated for activation.  If a qualifying encounter has been recorded within the previous 60 days from the team assignment date; the assignment status will be changed from Pending to Active using the encounter date as the effective date for the activation. 
Once a MPACT Request is approved and in Approved status, it will be considered valid for 24 months using the Approval date from the last station to submit its approval on the request. If the patient is unassigned from that team and is re-assigned again or if the team itself is inactivated/re-activated in this time period, the earlier approval will be considered 'valid' during this 24 month period.
If the 24 month timeframe has passed and a patient is then unassigned from the team, a new MPACT Request is required.
If the 24 month timeframe has passed and the patient is still assigned to the team, the original MPACT Request is still considered valid.
If a MPACT Request is still Pending 15 days after the request’s creation, the system will automatically generate an informational alert to all of the outstanding station approver(s) by sending an Outlook email to remind the recipient(s) to look at the PCMM Web Alerts and that action is needed.
If a MPACT Request is still Pending 30 days after the request’s creation, the system will generate an informational Escalation Alert to the VISN TVC coordinator of each station that has not responded to the MPACT Request by sending an Outlook email stating that a MPACT Request has been pending for 30 days and to look at the PCMM Web Alerts to take action on this request.
· If a MPACT Request is still Pending 45 days after the request’s creation, the system will generate an informational Escalation Alert to the PCMM Web National Coordinator by sending an Outlook email stating that a MPACT request has been pending for 45 days and to look at the PCMM Web Alerts to take action on this request.
If a date of death (DOD) occurs for a patient in the station needing assignment while a Multi PACT Request is in Pending status, the system will automatically unassign the patient from the pending assignment and the Multi PACT Request will be WITHDRAWN. An information alert will be sent to all appropriate people.
If the Multi PACT Request already has a status of APPROVED or DENIED or WITHDRAWN, no changes will occur to those requests.
If a DOD occurs for the patient at one of the approving stations, the Multi PACT Request will not be affected. (The auto inactivation process of the active assignment at the other station will resolve this issue.)
[bookmark: _Toc131158959][bookmark: _Toc164156790]Required PACT Approvals Station(s) Process
All other involved stations listed in the Required PACT Approvals section must approve or deny the new pending request in order for the PENDING PACT assignment at the Station Needing Assignment to be considered for activation. These involved stations will not be able to edit any data, they will only be able to approve or deny the request. 
Each TVC at all other stations listed in the Required PACT Approvals section of the MPACT Request will review the Actionable alert requesting approval of a MPACT Request for a new PACT assignment for the patient.  
1. Navigate to the Patient Profile.
1. In the Multiple PACT Requests, click the Actions icon (magnifying glass) to display the Create or Edit Multiple PACT Request popup screen. 
1. Navigate to the bottom of the request to access the Approve or Deny buttons.
Note: The WITHDRAW button is no longer displayed since ONLY the Station Needing Assignment can WITHDRAW a request.
250. Click Approve.
251. The system automatically displays the Request Status and Entered By for this action.
252. The status will be changed to Approve. The Approver selects a Clinical Decision by:, and comments may be entered if desired.
253. Click Submit.
254. A Confirmation message is displayed and the Patient Profile is displayed.
255. That status of the MPACT has changed to APPROVED in the Multiple PACT Request section.
256. The system performs the following actions:
Updates the MPACT Request on the Patient Profile:
Displays status as APPROVED since all stations involved have provided the necessary approvals.
Updates the date and time the MPACT request was approved Status Date column.
Displays the reason for the MPACT request in the Reason column.
Sends an Informational alert stating this station has just approved the request to all other stations on the MPACT Request except the station that that approved it. Since there is no limit as to how many ACTIVE PACT assignments a patient can have with an APPROVED MPACT Request for each PACT assignment, there could be several stations listed as approving stations on the request. This Informational alert will be sent each time a station approves until all approvals are received from all stations involved on the request.
Sends Informational alerts to all TVC(s) and PCMM Coordinator(s) at all stations involved with the request stating that all approvals have been received and the MPACT Request has been approved.
The PENDING PACT assignment associated with this APPROVED MPACT Request is still in PENDING status. Even with an APPROVED MPACT Request, the assignment will not flip to ACTIVE until a valid encounter with a qualifying member of the team the patient is assigned is detected by the system.
257. The TVC at the original station the request was submitted can view the PENDING PACT assignment on the Patient Profile screen.
Note: The patient could have already had an encounter with a qualifying member and the PENDING PACT assignment would have flipped simultaneously to ACTIVE when the overall Status on the MPACT Request changed to APPROVED.
258. The patient’s PENDING PACT assignment is now ACTIVE after the system verified the two requirements needed to flip this PACT assignment to ACTIVE. Those requirements are:
An overall APPROVED MPACT Request
A valid encounter with a qualifying member
259. When the PACT assignment flips from PENDING to ACTIVE, the Start Date and time will update to reflect the date of the encounter which is the date the team assignment starts as ACTIVE. Unless the patient has historical PACT assignments, the START DATE will not overlap the END DATE of a recent historical PACT assignment.
260. The MPACT Request process is to allow a patient’s multiple PACT assignments throughout the enterprise has been completed successfully.
[bookmark: _Toc131158960][bookmark: _Toc164156791]Permanent Relocation Process
If the TVC at the station needing assignment selects Permanent Relocation as the reason for the Multi PACT Request, it is to assist the patient with an easy transition to the patient’s new station. Once overall approval is received by the station needing assignment, the following alerts will be sent:
An informational alert will be sent to all TVC(s) on the request stating the relocation has completed and the request has been WITHDRAWN.
An actionable alert will be sent to all PCMM Coordinator(s) on the request stating the relocation has completed; that all Active PACT assignments need to be unassigned at each of the approving station(s); and the request has been WITHDRAWN.
[bookmark: _Toc131158961][bookmark: _Toc164156792]PACT Panel Placement
The PACT Panel Placement is used as a communication tool for coordinators within the same 3-digit station codes to assist with the transition of teams within the same facility or between facilities and coordinate a change in the a patient’s PACT team. 
This request is used for communication purposes only for the user to facility information regarding the patient’s PACT team assignment and must be used within the same 3-digit code station. There can be multiple requests for the same patient for different divisions at one time. The patient must have an active PACT team assignment at one station before this function can be performed. 
1. Expand the View Panel Placement Requests section from the Patient Profile screen.
1. The following columns will display:
Status
Status Date
Station Name
Group
Team
Requester
Effective Date
Actions
263. To create a PACT Panel Placement request, click the Create a Request button. The Create Panel Placement Request popup box will display.
[bookmark: _Toc131159175][bookmark: _Toc164156991]Figure 138 - View Panel Placements Request with the Create a Request Button Selected
[image: P2199#yIS1]
264. Enter some text to filter to search for a station in the Search Receiving Station text field.
265. Select the station in the Receiving Station drop-down list. (required)
266. Select the group number in the Group drop-down list.
267. Select the team for the panel placement request in the Team drop-down list.
268. Select a reason for the panel placement request in the Reason drop-down list. (required)
269. Select the type of requester in the Requester drop-down list. (required)
270. Select the calendar icon next to the Effective Date field to change the current date and time. Past dates are not allowed.
271. Add any additional information in the Comments text field.
272. Click Submit. The Attention popup box will display with a success message. Click Close.
[bookmark: _Toc131159176][bookmark: _Toc164156992]Figure 139 - Create Panel Placement Request Screen
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273. The record will appear in the View Panel Placement Requests section with a status of Pending. 
274. A user can edit the request while still in a Pending status by clicking the icon in the Actions column. The Edit Panel Placement Request popup box will display. Edit fields, if desired.
[bookmark: _Toc131159177][bookmark: _Toc164156993]Figure 140 – Edit a Request from the View Panel Placement Requests Section 
[image: P2214#yIS1]
275. Click Submit. The Attention popup box will display with a success message. Click Close. 
276. An alert will be sent to the user of the site that generated the request and the user of the site that is listed on the request stating that a request was created. This alert will be sent from the system to each recipient each time a PACT Panel Placement Request is created or when the Team or Station on the request is updated.
277. The View Panel Placement Request section is populated on the Patient Profile. The Panel Placement Request can be updated by clicking icon the Actions column. New alerts are sent only when updating the group or team for the request. This will trigger new alerts to both facilities. Only updates to the team or group will trigger a new alert.
Move/Relocate request: if the record contains a Move/Relocate reason for the request, the system will automatically unassign the patient from the active team assignment at the first station and creates the Pending assignment at the new station when an encounter date occurs for the Pending assignment at the new station.
[bookmark: _Toc131158962][bookmark: _Toc164156793]Staff Management
[bookmark: _Search_for_VA][bookmark: _Toc131158963][bookmark: _Toc164156794]Search for VA Staff
A user can quickly search for a VA staff member using the menu option.
1. Select Staff > Search for VA Staff from the main menu to display the Search for Staff window.
[bookmark: _Toc131159178][bookmark: _Toc164156994]Figure 141 - Search for VA Staff Menu Option Selected to Manage VA Staff
[image: Search for VA Staff is shown in the Teams menu.]
279. Enter at least two characters of a last name for the staff member. Entering first or middle names will narrow the search.
A terminated staff member is shown as “Separated” in the search results. 
Total FTE column includes the sum of team assignments associated with the staff member.
280. Enter the Last Name with the First Initial of the First Name up to the FULL First Name of the staff member to narrow the search results. (E.g. Smith,J or Smith,Jo or Smith,Jones)
281. Click Search to display a list of staff names results. 
282. Click the icon in the Select column to view the staff member’s profile. The Staff Profile screen will display.
[bookmark: _Toc131159179][bookmark: _Toc164156995]Figure 142 - Search for Staff Box to Manage VA Staff
[image: P2232#yIS1]
283. The following information displays on the Staff Profile screen:
Name, Title, Phone, Pager, and Email.
If the Staff Member has an email, click the email icon to email the VA staff member.
Expand the View Team Assignment toggle link to view a list of team assignments. 
Click on a team name link. The Modify an Existing Team page will display and the user has the option to modify fields and options. 
[bookmark: _Toc131159180][bookmark: _Toc164156996]Figure 143 - Modifying a Staff Member on the Staff Profile Screen
[image: P2239#yIS1]
If the system cannot find a staff member:
If the system cannot find a record, a message will display in the Search for Staff window. Click the Find in VistA button for Vista mapped station or Find in Cerner button for Cerner mapped station to search for the staff member in VistA/Cerner that is not listed in the PCMM Web Search results list. VistA requires at least two letters of the last name to perform a search. Enter the search criteria and select the Find in VistA or Find in Cerner button.
Enter the Last Name with the First Initial of the First Name up to the FULL First Name of the staff member with no space after the comma to narrow the search results. (E.g. Smith,J or Smith,Jo or Smith,Jones)
The PCMM Web VistA staff search will now display all staff members with the same last name in the search for staff results table even if the SSN field is blank in VistA.
The screen will refresh with the VistA results display. Click the icon in the Select column that corresponds to view the staff member’s profile. 
[bookmark: _Assign_Staff_to][bookmark: _Remove/Un-assign_Staff_from][bookmark: _Toc131158964][bookmark: _Toc164156795]Remove or Unassign Staff from a Team Role (Position)
A user can remove staff from a team role from the Position List screen. The associated team must have an active status. 
[bookmark: _Toc131158965][bookmark: _Toc164156796]From the Team List screen
1. From the main menu, click Teams > List All Teams or Teams > Search for a Team. Click on the team name link.
285. From the Modify an Existing Team screen, click View Positions and Staff Assignments. The Position List page will display.
Figure 144 - View Positions and Staff Assignments Link Selected to Remove or Unassign a Staff from a Team Role
[image: P2253#yIS1]
286. Alternatively, from the Position List page, click the icon in the Actions column.
287. Click the Manage Staff button in the Current Staff Assignments section. 
288. Click the name link in the Staff Name column to display the Staff Information page.
289. Click the Unassign button to remove the staff member name and profile from the team role.
[bookmark: _Toc131159183][bookmark: _Toc164156998]Figure 145 – Unassigning a Staff from a Team Role
[image: P2259#yIS1]
290. A box will display, indicating whether to unassign the staff member. Click Close to close the message. The Staff Information screen displays.
[bookmark: _Toc131159184][bookmark: _Toc164156999]Figure 146 - Confirmation of Unassignment of Staff from the Team Role Message
[image: P2262#yIS1]
291. Click the calendar icon next to Unassignment Date field to change the unassignment date (current date and time is displayed by default). 
292. Choose an Unassignment Reason from the drop-down list.
293. Click the Submit button to confirm the unassignment, or Cancel to cancel.
294. When the unassignment occurs, the unassignment date/status/reason will be captured in History with who requested the change and when.
Note: If the team role is a preceptee that has a preceptor assigned, the team role may not be de-staffed until the preceptor relationship is terminated. A user will be presented with a message indicating the team role has a preceptee and cannot be de-staffed without first unassigning the preceptee. 
[bookmark: _Reassign/Change_Staff_Assignment][bookmark: _Toc131158966][bookmark: _Toc164156797]Reassign or Modify Staff Assignment
A user can reassign or change staff assignments from the Position List screen. The associated team must have an active status.
[bookmark: _Toc131158967][bookmark: _Toc164156798]From the Team List screen
1. From the main menu, click Teams > List All Teams.
296. Click the icon in the Position column for the desired team to display the Positions List page. The team must be active.
[bookmark: _Toc131158968][bookmark: _Toc164156799]From the Modify an Existing Team screen
1. From the main menu, click Teams > Search for a Team. Click on the team name link. 
298. From the Modify an Existing Team screen, click View Positions and Staff Assignments. The Position List page will display. Alternatively, from the Position List page, a user can click the icon in the Actions column. 
299. Click the Manage Staff button in the Current Staff Assignments section. 
300. Click a name link in the Staff Name column to display the Staff Information page.
301. Click the Reassign button. A Confirmation dialog box displays to confirm the reassignment of the staff member. Click Confirm to continue and display the Search for Staff dialog box or Cancel to exit.
[bookmark: _Toc131159186][bookmark: _Toc164157000]Figure 147 - Reassigning a Staff Member from the Assign Staff to a Position Screen
[image: P2282#yIS1]
302. A box will display, indicating whether to unassign the staff member. Click Close to close the message. The Staff Information screen displays.

[bookmark: _Toc131159187][bookmark: _Toc164157001]Figure 148 - Reassignment Confirmation Message
[image: P2286#yIS1]
303. Enter at least two characters of a last name for the staff member. Entering first or middle names will narrow the search. Click Search. If the system cannot find the staff member, click the Search VistA button for Vista mapped station of Search Cerner for Cerner mapped station.
304. Click the icon in the Select column. The Staff Information dialog box will display. A user can start the search process again to choose another staff member. Click the Search Staff button to proceed with this process.
[bookmark: _Toc131159188][bookmark: _Toc164157002]Figure 149 - Searching for Staff Member on the Search for Staff Box
[image: P2290#yIS1]
305. Click the calendar icon next to the Effective Date field (current date and time is displayed by default). 
306. Enter the FTE (current FTE is displayed by default).
307. Click the Submit button to confirm the reassignment, or Cancel to cancel. The Modify an Existing Position screen will display and the new Current Staff member's information will display. 
[bookmark: _Toc131159189][bookmark: _Toc164157003]Figure 150 – Defining the Effective Date for the Reassignment 
[image: P2295#yIS1]
308. When the reassignment occurs, the reassignment date/status/reason will be captured in History with who requested the change and when.
Note: If the team role is a preceptee that has a preceptor assigned, the team role may not be de-staffed until the preceptor relationship is terminated. A user will be presented with a message to indicate the team role has a preceptee and cannot be de-staffed without first unassigning the preceptee.
[bookmark: _Toc131158969][bookmark: _Toc164156800]Create a Non-VA Provider
A user can create a Non-VA Provider that provides Non-VA Care to the patient through the VA. Non-VA Care consists of three categories: Veteran’s Choice, Community Nursing Home, and Veteran State Home.
A user can create a new Non-VA Provider from the Patient Profile screen.
1. Expand the View Non-VA Providers section on a Patient Profile screen and click the Assign button to display the Assign a Non-VA Provider to a Patient screen.
[bookmark: _Toc131159190][bookmark: _Toc164157004]Figure 151 - View Non-VA Providers Section with the Assign Button Selected
[image: P2303#yIS1]
310. [bookmark: _Toc131159191]Click the Find button next to Provider to display the Search for Non-VA Provider screen.
[bookmark: _Toc164157005]Figure 152 - Searching for a Provider
[image: P2306#yIS1]
User must first search for a Non-VA Provider before one can be created. 
311. Enter the search criteria and click the Find button. If the Non-VA Provider is not found in the system or if the necessary provider is not listed, the Create New Provider button displays. Click the Create New Provider button to display the Assign a Non-VA Provider to a Patient screen. 
Note: Only after clicking the Find button, will the Create New Provider button display. This enables a user to verify first, if the Non-Provider exists before a new one is entered in the system.
[bookmark: _Toc131159192][bookmark: _Toc164157006]Figure 153 - Search for Non-VA Provider Screen with the Create New Provider Button Selected
[image: P2311#yIS1]
312. The Find button displays to allow the user to search for a Non-VA Provider during the creation process.
313. Select the Non-VA Category type from the Category drop-down. Options are:
Community Nursing Home
DoD
Private Sector
Veteran State Home
Veteran’s Choice
[bookmark: _Toc131158970][bookmark: _Toc164156801]Name Section
1. Enter the last name of the Non-VA Provider in the Last Name text box.
1. Enter the first name of the Non-VA Provider in the First Name text box.
1. Enter the middle name of the Non-VA Provider in the Middle text box.
1. Enter the suffix of the Non-VA Provider in the Suffix text box.
[bookmark: _Toc131158971][bookmark: _Toc164156802]Address section 
Note: only displays for the DoD Category
1. Enter the address of the Non-VA Provider in the Address Line 1, Line 2, and Line 3 text box(es). 
319. Enter the city where the Non-VA Provider resides in the City text box.
320. Select the state where the Non-VA Provider resides in the State drop-down.
321. Enter the Zip Code where the Non-VA Provider resides in the Zip text box.
322. Select a role from the Role drop-down list (required) and select a specialty from the Specialty drop-down list.
323. Click the Search button to create or assign a Non-VA Practice to a Non-VA Provider.  Click the name link to assign a Non-VA Practice.
324. Select the calendar icon to indicate the assignment date.
325. Click the Search button to assign a Coordination Team. This option available for all Non-VA Provider Categories expect for DoD.
326. Click Submit to save the information and display the Non-VA Provider Information screen. The new provider will be listed. Or click Cancel to display a dialog box that asks to confirm the cancelation and warns that no information will be saved.
[bookmark: _Toc131159193][bookmark: _Toc164157007]Figure 154 - Assign a Non-VA Provider to a Patient Screen
[image: P2336#yIS1]
[bookmark: _Search_for_a_4][bookmark: _Toc131158972][bookmark: _Toc164156803]Search for a Non-VA Provider
A user can search for a Non-VA Provider in the PCMM Web system in order to view and update provider information. 
1. Select Non-VA Provider> Search for Non-VA Provider from the main menu to display the Search for Non-VA Provider window.
[bookmark: _Toc131159194][bookmark: _Toc164157008]Figure 155 - Search for Non-VA Provider Menu Option
[image: P2341#yIS1]
328. Select a Non-VA Provider type from the Category drop-down list. The following are
329. available:
DoD
Private Sector
Veteran's Choice
Community Nursing Home
Veteran State Home
330. Enter the full name for the Non-VA Provider in the Name text box.
331. Enter the phone number associated with the Non-VA Provider in the Phone text box.
332. Enter the email address associated with the Non-VA Provider in the Email text box.
333. Enter the practice name associated with the Non-VA Provider in the Practice Name text box.
334. Enter the city associated with the Non-VA Provider in the City text box.
335. Select the state associated with the Non-VA Provider in the State drop-down menu.
336. Click Search to display search results. The Results list will display the Provider Name, Category, Roles, Specialties, Practice Name and Provider Contact information. The list can be sorted by any column or narrowed by using a filters. If the Non-VA Provider has an email, click the e-mail icon that corresponds to the provider name.
337. Click Cancel to cancel the search.
338. Click the name link to view or modify the Non-VA Provider on the Non-VA Provider Profile screen.
[bookmark: _Toc131159195][bookmark: _Toc164157009]Figure 156 - Search for Non-VA Provider Screen
[image: P2359#yIS1]
[bookmark: _Update_an_Existing][bookmark: _Toc131158973][bookmark: _Toc164156804]Assign a Non-VA Provider to Patient
A user can assign a Non-VA Provider from the Patient Profile.
1. From the Patient Profile screen, click the View Non-VA Providers toggle link to display a list of Non-VA Providers the patient is assigned or has been unassigned.
1. Click the Assign button to display the Assign a Non-VA Provider to a Patient screen.
[bookmark: _Toc131159196][bookmark: _Toc164157010]Figure 157 - View Non-VA Providers Screen with the Assign Button Selected
[image: P2365#yIS1]
341. Click the Search button to display the Search for Non-VA Provider window.
[bookmark: _Toc131159197][bookmark: _Toc164157011]Figure 158 - Assign a Non-VA Provider to a Patient Screen Searching for a Provider
[image: P2368#yIS1]
342. Select the type of Non-VA Provider from the Category drop-down menu. Available options are:
DoD
Private Sector
Veteran's Choice
Community Nursing Home
Veteran State Home
343. Enter the last name for the Non-VA Provider in the Name text box.
344. Enter the phone number associated with the Non-VA Provider in the Phone text box.
345. Enter the email address associated with the Non-VA Provider in the Email text box.
346. Enter the practice name associated with the Non-VA Provider in the Practice Name text box.
347. Enter the city associated with the Non-VA Provider in the City text box.
348. Select the state associated with the Non-VA Provider in the State drop-down menu.
349. Click Search to display search results. The Results list will display the Provider Name, Category, Role, Specialty, Practice Name, Phone Number, Email, and Address. The list can be sorted by any column or narrowed by using a filters. If the Non-VA Provider has an email listed, click the e-mail icon that corresponds to the provider name to send a message.
350. Click the name link to assign the Non-VA Provider to the Patient and to display the Assign a Non-VA Provider to a Patient screen.
[bookmark: _Toc131159198][bookmark: _Toc164157012]Figure 159 - Search for Non-VA Provider Screen
[image: P2384#yIS1]
351. Select the Non-VA Provider type in the Category drop-down menu. After the Category is selected, the Non-VA Practice associated displays and is automatically selected. For the Private Sector and DoD Categories, a user has the option to keep the preselected Non-VA Practice or to select the No Practice Selected radio button.
352. Select the role type from the Role drop-down list.
353. Select the specialty from the Specialty drop-down list.
354. Click the calendar icon next to the Assignment Date field to select the date and time the assignment will be effective.
355. Click Submit to assign the patient to the Non-VA Provider.
[bookmark: _Toc131159199][bookmark: _Toc164157013]Figure 160 - Submitting the Patient Assignment to the Non-VA Provider
[image: P2391#yIS1]
356.  A confirmation message will appear if the assignment was successful. Click OK to continue.
[bookmark: _Toc131158974][bookmark: _Toc164156805]Modify an Existing Non-VA Provider
Users can edit Non-VA Provider records already listed in PCMM Web.
1. Locate the Non-VA Provider's information using the Search for Non-VA Provider window or from the View Non-VA Providers section from a Patient Profile screen.
358. Click the provider name link listed in the Provider Name or Name column. 
[bookmark: _Toc131159200][bookmark: _Toc164157014]Figure 161 – Search for a Non-VA Provider with the Name Link Selected
[image: P2398#yIS1]
359. The Non-VA Provider Profile screen will display. Modify any or all of the fields shown. 
[bookmark: _Toc131159201][bookmark: _Toc164157015]Figure 162 – Edit a Non-VA Provider Profile Screen
[image: P2401#yIS1]
360. Click the View Patient Assignments toggle link at the bottom of the screen to view a list of patient assignments. When selected, the Historical Assignments option displays patients previously assigned to team. To revert to the current list, select the Current Assignments option. To filter through the patient list, use the text box provided.
[bookmark: _Toc131159202][bookmark: _Toc164157016]Figure 163 - View Patient Assignment Section
[image: P2404#yIS1]
361. Click the View Practices toggle link at the bottom of the screen to view a list of practice assignments. The View Practices section includes the Practice Name, Phone Number, and Email Address and an Action column. If the Non-VA Provider has an email, click the email icon to email the staff member. 
To delete a Practice from the Non-VA Provider, select the Delete icon in the Action column.
To add a new Practice to the Non-VA Provider, click the Add button to display the Search for Non-VA Practice box. Enter the appropriate search criteria and then select the Non-VA Practice.
[bookmark: _Toc131159203][bookmark: _Toc164157017]Figure 164 - View Practices Section to View a List of Practice Assignments.
[image: P2409#yIS1]
362. Click Submit to continue, Cancel to cancel.
363. The Non-VA Provider Profile screen displays, with the changes saved in the record
[bookmark: _Toc131158975][bookmark: _Toc164156806]Create a New Non-VA Practice
A user can create a Non-VA Practice, associated with a Non-VA Provider to provide care to the patient, outside the VA. A user can create a Non-VA Practice when searching for a Non-VA Provider to assign to a Patient, or from the main menu.
1. Select Non-VA Providers> Search for Non-VA Practice from the main menu to display the Search for Non-VA Practice screen.
[bookmark: _Toc131159204][bookmark: _Toc164157018]Figure 165 - Search for Non-VA Practice Menu Option Selected to Create a Non-VA Practice
[image: P2416#yIS1]
365. Click the Search button or enter the search criteria for a Non-VA Practice. 
Note: To avoid duplications of practices, a user must search for an existing Non-VA Practice before being allowed to create a new one. If the practice is not available when the search criteria are returned, a user can then create the Non-VA Practice.
366. If a Non-VA Practice is unavailable, click the Create New Practice button to display the Create a Non-VA Practice screen.
[bookmark: _Toc131159205][bookmark: _Toc164157019]Figure 166 - Search for Non-VA Practice Screen with the Create New Practice Button Selected
[image: P2421#yIS1]
367. Enter the Non-VA Practice in the Name text box.
368. Enter the phone number in the Phone text box.
369. Enter the fax number in the Fax text box.
370. Enter the main email address for the Non-VA Practice in the Email text box.
371. Enter the address(es) for the Non-VA Practice in the Line 1, Line 2, and Line 3 text boxes.
372. Enter the city in the City text box.
373. Select the state in the State drop-down menu.
374. Enter the ZIP code in the Zip Code text box.
375. Click Submit to continue, Cancel to cancel.
[bookmark: _Toc131159206][bookmark: _Toc164157020]Figure 167 - Create a Non-VA Practice Screen
[image: P2432#yIS1]
[bookmark: _Toc131158976][bookmark: _Toc164156807]Update an Existing Non-VA Practice
Users can edit Non-VA Practice records in PCMM Web.
1. Locate the Non-VA Practice using the Search for Practice window or from the View Practice section of the Non-VA Provider Profile screen. 
377. Click the provider name link listed in the Provider Name or Name column.
[bookmark: _Toc131159208][bookmark: _Toc164157021]Figure 168 - Search for Non-VA Practice Screen with Practice Selected
[image: P2440#yIS1]
378. The Non-VA Practice Profile screen will display. Modify any or all of the fields shown.
379. Click Submit to continue, Cancel to cancel.
[bookmark: _Toc131159209][bookmark: _Toc164157022]Figure 169 – Non-VA Practice Profile Screen
[image: P2444#yIS1]
[bookmark: _Toc131158977][bookmark: _Toc164156808]Rooms Management
[bookmark: _Toc131158978][bookmark: _Toc164156809]Create a Room
To Create a Room:
1. Select Create a Room from the Rooms drop-down menu to display the Create a New Room screen.	
[bookmark: _Toc131159210][bookmark: _Toc164157023]Figure 170 - Create a Room Menu Option
[image: Create a Room option is shown in the Rooms menu.]
Note: Or a user can navigate to the Create a New Room screen by following this path: Rooms drop-down menu > List All Rooms > List All Rooms screen > Create a Room button.
[bookmark: _Toc131159211][bookmark: _Toc164157024]Figure 171 - Room List Screen with the Create a Room Button Selected
[image: P2453#yIS1]
381. Enter a unique room number in the Number field. This is an alphanumeric field.
382. Enter a room name in the Name field.
383. Select a room type. (Exam is selected by default). For each selection, a description of the room type is displayed.
384. Enter an expected FTE value. It must be greater than 0.00 and it cannot be greater than 1.5.
385. Enter a room description in the Description field.
386. Accept the default room status of Active, or select Inactive. A user can edit the room information later.
387. [bookmark: _Toc131159212]Click Submit to save the data and display the Rooms List page. The new room will be listed.
[bookmark: _Toc164157025]Figure 172 - Create a New Room Screen
[image: P2462#yIS1]
[bookmark: _Manage_Rooms][bookmark: _Toc131158979][bookmark: _Toc164156810]Manage Rooms
PCMM Coordinators are able to manage rooms using the List All Rooms screen.
1. Select List All Rooms from the Rooms drop-down menu to display the Rooms List screen.
[bookmark: _Toc131159213][bookmark: _Toc164157026]Figure 173 - List of All Rooms Menu Option to Manage Rooms
[image: List All Rooms is shown in the Rooms menu.]
389. For each room, the list will display the:
Total Exam Rooms (Active)
Total Interview Rooms (Active)
Total Rooms (Active)
Room Number
Room Name
Room Type (examination, interview, or both)
Room Description
Expected FTE Usage (0.01 – 1.00)
Actual FTE Usage
Available FTE for Assignment (determined by system)
Room Status (Active/Inactive)
The room list will initially be displayed in order by Number and will include all rooms. The list can be sorted by any column or narrowed by applying filter values for Type and Status. A user can perform the following tasks on this screen, depending on the user role:
Create a room by clicking the Create a Room button.
Modify a selected room by clicking the Room Name link.
[bookmark: _Toc131159214][bookmark: _Toc164157027]Figure 174 - Room List Screen to Create or Modify a Room
[image: P2484#yIS1]
[bookmark: _Create_a_Room][bookmark: _Search_for_a_3][bookmark: _Toc131158980][bookmark: _Toc164156811]Search for a Room
1. Select Search for Room on the Rooms drop-down menu on the PCMM Web home page to display the Search for Room dialog box.
[bookmark: _Toc131159215][bookmark: _Toc164157028]Figure 175 - Search for Room Menu Option
[image: Search for Rooms is shown in the Rooms menu.]
391. Enter all or part of the room desired in the Number field and click Search to display a list of rooms below the Search button. Alternatively, leave the Number field blank and click the Search button to display a list of all rooms for that station.
392. The Search for a Room dialog box will display. The following columns are displayed in the room list table:
Number
Name
Description
Status
Select
393. [bookmark: _Modify_an_Existing_1]Click the icon in the Select column for the desired room to display room information in the Modify An Existing Room screen. Alternatively, click Cancel to cancel out of the search.
[bookmark: _Toc131159216][bookmark: _Toc164157029]Figure 176 - Search for a Room to Modify 
[image: P2498#yIS1]
[bookmark: _Modify_an_Existing_2][bookmark: _Toc131158981][bookmark: _Toc164156812]Modify an Existing Room
To Modify an Existing Room:
1. Search for a room to modify from the Search for Room dialog box or from the Rooms List screen.
1. On the Modify an Existing Room screen, modify the following information for that room:
Number
Name
Type
Expected Examination Usage FTE
Expected Interview Usage FTE
Description
Status (Active/Inactive)
Every field value except for Room Name and Description is required and must contain a value.
396. Click Submit to save the information and display the Room List screen. 
From this screen a user can also view the Active Team Assignments and the Inactive/Historical Team Assignments for the room. 
[bookmark: _Toc131159217][bookmark: _Toc164157030]Figure 177 - Modify an Existing Room Screen
[image: P2514#yIS1]
[bookmark: _Assign_a_Room][bookmark: _Toc131158982][bookmark: _Toc164156813]Assign a Room to a Team
1. From the Modify An Existing Room screen, click the View Active Team Assignments toggle link to view a list of team and room assignments. 
1. Click Assign Team to display the Team Assignment dialog box.
[bookmark: _Toc131159218][bookmark: _Toc164157031]Figure 178 - View Active Team Assignments Section with the Assign a Team Button Selected
[image: P2519#yIS1]
399. Click Find to display the Search for Team dialog box.
[bookmark: _Toc131159219][bookmark: _Toc164157032]Figure 179 - Team Assignment Box
[image: P2522#yIS1]
400. Enter all or part of the team name desired in the Name field and click Search to display a list of teams. Alternatively, leave the Name field blank and click the Search button to display a list of all teams.
401. Select the team name link in the Name column to return to the Team Assignment dialog box and populate the Team field. 
[bookmark: _Toc131159220][bookmark: _Toc164157033]Figure 180 - Searching for a Team to Assign to a Room
[image: P2526#yIS1]
402. Enter an Actual FTE value for the exam, Interview, or both rooms. The FTE value must be greater than 0.00 and it cannot be greater than 1.5. If the FTE value entered for the team assignment is greater than the FTE value assigned to the room, an error message will display.
403. Click Submit to save the information and display the Modify an Existing Room screen.
[bookmark: _Toc131159221][bookmark: _Toc164157034]Figure 181 - Actual Exam FTE Defined for the Team Assignment
[image: P2530#yIS1]
404. Click the View Active Team Assignments toggle link to view a list of teams and room assignments. The new team and room assignment is listed.
[bookmark: _Toc131159222][bookmark: _Toc164157035]Figure 182 - Newly Assigned Room to the Team
[image: P2533#yIS1]
405. Unlink a team from the room assignment, or change the actual FTE value for a team's use of the room by clicking the X icon in the Actions column that corresponds to the team to unlink.
[bookmark: _Toc131159223][bookmark: _Toc164157036]Figure 183 - Red X Icon Selected to Unlink a Team from a Room
[image: P2536#yIS1]
406. An Are you sure dialog box will display. Click Confirm to continue; Cancel to cancel.
[bookmark: _Toc131159224][bookmark: _Toc164157037]Figure 184 - Confirmation to Unlink the Team from the Room Message
[image: P2539#yIS1]
407. Click the View Inactive/Historical Team Assignments toggle link to view the team's assignment record.
[bookmark: _Toc131159225][bookmark: _Toc164157038]Figure 185 - Viewing Team Assignment Records in the View Inactive/Historical Team Assignments Section
[image: P2542#yIS1]
408. To change the Actual FTE value for a team’s use of the room, click the pencil icon in the Actions column that corresponds to the team's FTE.
[bookmark: _Toc131159226][bookmark: _Toc164157039]Figure 186 - Action Icon Selected to Change the Actual FTE Value
[image: P2545#yIS1]
409. The Change Actual Assignment FTE dialog box will display. Enter an Actual FTE for the team.
[bookmark: _Toc131159227][bookmark: _Toc164157040]Figure 187 - Change Actual Assignment FTE box
[image: P2548#yIS1]
410. Click Submit to continue, Cancel to cancel.
411. If the FTE value entered for the team assignment is greater than the FTE value assigned to the room, an error message will display. Click Close and enter a valid FTE value.
412. Click Submit to save the record.

[bookmark: _View_Room_Assignments][bookmark: _Toc131158983][bookmark: _Toc164156814]View Room Assignments for a Team
1. From the Modify an Existing Room screen, click the View Active Team Assignments toggle link to view a list of team and room assignments. The following information will display:
Team
Care Type
Focus
Station
Actual FTE Usage
Assignment active since
Actions (Use this column to either unlink the team from the room assignment or change the Actual FTE value for a team’s use of the room.)
The list can be sorted by any column or narrowed by applying filter values for Care Type and Focus.
[bookmark: _Toc131159228][bookmark: _Toc164157041]Figure 188 - View a Room Assignment on the View Active Team Assignments Section
[image: P2564#yIS1]
414. Click the View Inactive/Historical Team Assignments toggle link to view a list of past team and room assignments. The following information will display:
Team
Care Type
Focus
Station
Actual FTE Usage
Assignment Start Date
Assigned End Date
The list can be sorted by any column or narrowed by applying filter values for Care Type and Focus. 
[bookmark: _Toc131159229][bookmark: _Toc164157042]Figure 189 - View Inactive/Historical Team Assignments Section
[image: P2575#yIS1]
[bookmark: _Toc131158984][bookmark: _Toc164156815]Group Management
[bookmark: _Create_a_New]Utilizing groups is an administrative tool that allows the user to group similar teams together, such as team purpose or location. A user is able to create a new group and add the group information to the PCMM Web system. This adds the group name to the Group List screen and allows a user to search for the group information.
[bookmark: _Toc131158985][bookmark: _Toc164156816]Create a New Group
1. From the Groups drop-down menu, select Create a Group to display the Create a New Group screen. A user also can display this screen by clicking the Create a Group button on the List Groups screen (Groups > List All Groups > List Groups).
[bookmark: _Toc131159230][bookmark: _Toc164157043]Figure 190 - Create a Group Menu Option
[image: Create a Group option shown in the Groups option.]
416. Enter a name for the group. The system will ensure that the new name is unique across all stations with the same three-digit code as the currently logged-in station.  The system will display an error message if a duplicate group name is found. If so, please enter a new unique group name.  
417. Enter a description of the group in the Description field.
418. Enter a Primary Point of Contact name. 
419. Enter a Primary Point of Contact phone number.
420. Enter a Primary Point of Contact city and state.
421. Click Submit to save the group information and display the Groups List screen. The new group will be listed with a current status of Active. Click Cancel to return to the Groups List screen without saving any data.
The system will display an error message for any required field that is not completed. Complete the fields before re-submitting the group information.
The system will validate the values of the required fields for Name and Primary Point of Contact Email to ensure proper entry.
A Current Status field will automatically populate with an Active status once a group is created and will be displayed on the “Modify an Existing Group” screen. A user can also inactivate a group.
[bookmark: _Toc131159231][bookmark: _Toc164157044]Figure 191 - Create a New Group Screen
[image: P2592#yIS1]
[bookmark: _View_Groups_List][bookmark: _Toc131158986][bookmark: _Toc164156817]View Groups List
A user can view a station-level summary list of all active groups. This allows a user to view or modify group information, email a group’s primary point of contact, view information about a group’s teams, and inactivate a group.
1. From the Groups drop-down menu, select List All Groups to display the Groups List screen.
[bookmark: _Toc131159232][bookmark: _Toc164157045]Figure 192 - List All Groups Menu Option to View Group Lists
[image: List All Groups shown within the Groups menu.]
423. For each group listed for that station, the list will display:
Name
View or modify group information by clicking a name link in the Name column. This will display the Modify an Existing Group screen.
Description
Primary Point of Contact Name
Primary Point of Contact Phone
Primary Point of Contact E-mail
Email a group’s primary point of contact by clicking the envelope icon in the Primary Point of Contact E-mail column.
Teams
A user can view information about teams assigned to a group by clicking a team name link in the Teams column. This will display the Modify an Existing Team screen.
Status (Active or Inactive)
Actions
Inactivate a group by clicking the icon in the Actions column. Note that once a group is inactivated, all teams assigned to the group are unassigned from the group and the group cannot be reactivated. See the Inactivate a Group section for more information
424. The list can be sorted by any column or narrowed by using a filter for Current Status. Active teams are listed first, followed by inactive teams.
Note: the list of groups can be narrowed by using a filter for Current Status. Active teams are listed by default.
[bookmark: _Toc131159233][bookmark: _Toc164157046]Figure 193 - Group List Screen
[image: P2614#yIS1]
[bookmark: _Search_for_a_2][bookmark: _Toc131158987][bookmark: _Toc164156818]Search for a Group
A user can search for a group to view or modify.
1. Select Search for Group on the Groups drop-down menu on the PCMM Web home page to display the Search for Group dialog box.
[bookmark: _Toc131159234][bookmark: _Toc164157047]Figure 194 - Search for Group Menu Option
[image: ]
426. Enter all or part of the group name desired in the Name field and click Search to display a list of groups with that search criteria. Alternatively, a user can also leave the Name field blank and click the Search button to display a list of all groups for that station.
427. The Search for Group dialog box will display. The following columns are displayed in the group list table:
Name
Description
Select
428. Click an icon (blue check) in the Select column for the desired group to display the Modify an Existing Group screen. See the Modify an Existing Group section for more information.
[bookmark: _Toc131159235][bookmark: _Toc164157048]Figure 195 - Search for Group Screen
[image: P2627#yIS1]
[bookmark: _Modify_an_Existing][bookmark: _Toc131158988][bookmark: _Toc164156819]Modify an Existing Group
A user can view or modify information for a group in the Modify an Existing Group screen.
1. From the Modify An Existing Group screen for the group (see the Modify An Existing Group section), the following information will be displayed:
Name
Station
Description
Primary Point of Contact Name
Primary Point of Contact Phone
Primary Point of Contact E-mail
Primary Point of Contact City
Primary Point of Contact State
Current Status (Active or Inactive)Activation Date
430. A user can edit the Name, Description, and all Primary Point of Contact information.
[bookmark: _Toc131159236][bookmark: _Toc164157049]Figure 196 - Modify an Existing Group Screen
[image: P2642#yIS1]
431. A user can also:
Click the View Active Team Assignments toggle link at the bottom of the screen to view a list of team and room assignments. 
Make new team assignments to the group by clicking the View Active Team Assignments toggle link, and then clicking the Assign Team button. 
Click the View Inactive/Historical Team Assignments toggle link at the bottom of the screen to view a list of historical data. 
432. Click Submit to save any changes and display the Groups List screen. A confirmation message will appear at the top of the screen.
[bookmark: _Toc131159237][bookmark: _Toc164157050]Figure 197 - View Active Team Assignments Screen
[image: P2649#yIS1]
[bookmark: _Assign_and_Unassign][bookmark: _Assign_and_Un-assign][bookmark: _Toc131158989][bookmark: _Toc164156820]Assign and Unassign a Team from a Group
A user can assign or unassign a team to or from a group in the Modify an Existing Group screen.
[bookmark: _Toc131158990][bookmark: _Toc164156821]Assign a Team to a Group
1. [bookmark: _Inactivate_a_a]From the Modify an Existing Group screen for the group (See the Modify An Existing Group section), click the View Active Team Assignments toggle link at the bottom of the screen to view a list of team and room assignments. The following information will display:
Aggregate Panel Details (total for the whole group)
Aggregate Modeled Capacity
Aggregate Maximum Capacity
Aggregate Assigned
Aggregate Available
Team
Care Type
Focus
Station
Modeled (Team Capacity)
Maximum (number of patients assigned)
Assigned (patients assigned to the team)
Available (number of patients available to be assigned to the team)
Assignment Start Date
Actions (Use this column to unlink the team from the group assignment. See the next section for more information.)
The list can be sorted by any column or narrowed by applying filter values for Care Type and Focus. 
434. Click the Assign Team button to display the Team Assignment dialog box. 
[bookmark: _Toc131159238][bookmark: _Toc164157051]Figure 198 - Assigning a Team to a Group
[image: P2672#yIS1]
435. Click the Search button to display the Search for Team dialog box. 
[bookmark: _Toc131159239][bookmark: _Toc164157052]Figure 199 - Team Assignment Box with the Search Button Selected
[image: P2675#yIS1]
436. Enter all or part of a team name and click Search to display a list of team names. Alternatively, leave the field empty and click Search to display a list of all available team names.
[bookmark: _Toc131159240][bookmark: _Toc164157053]Figure 200 - Search for Team Screen to Assign Team to Group
[image: P2678#yIS1]
437. Click the name link to populate the Team field in the Team Assignment dialog box.
[bookmark: _Toc131159241][bookmark: _Toc164157054]Figure 201 - Team Assignment Box with Team Selected
[image: P2681#yIS1]
438. Click Submit to continue, Cancel to cancel. A confirmation message will display at the top of the screen.
[bookmark: _Toc131158991][bookmark: _Toc164156822]Unassign a Team from a Group
1. Click the View Active Team Assignments toggle link.
1. Click the red X icon in the corresponding Actions column.
[bookmark: _Toc131159242][bookmark: _Toc164157055]Figure 202 - Assigning a Team from Group
[image: P2687#yIS1]
441. The Are You Sure? dialog box will display. Click Confirm to unlink the team from the group, or click Cancel to close the dialog box without making changes.
[bookmark: _Toc131159243][bookmark: _Toc164157056]Figure 203 - Confirmation to Unlink Team from Group
[image: P2690#yIS1]
442. Click the View Inactive/Historical Team Assignments toggle link. The following information will be displayed:
Team
Care Type
Focus
Station
Assignment Start Date
Assignment End Date
The list can be sorted by any column. 
443. The inactive team assignment will be displayed in the list.
[bookmark: _Toc131159244][bookmark: _Toc164157057]Figure 204 - View Inactive/Historical Team Assignment Screen
[image: P2701#yIS1]
[bookmark: _Inactivate_a_Group][bookmark: _Toc131158992][bookmark: _Toc164156823]Inactivate a Group
[bookmark: OLE_LINK1][bookmark: OLE_LINK2]A user can inactivate a group in the List Groups screen.
1. From the Groups List screen, click the icon (trash can) in the Actions column. Note that once a group is inactivated, all teams assigned to the group are unassigned from the group and the group cannot be reactivated.
[bookmark: _Toc131159245][bookmark: _Toc164157058]Figure 205 - Group List Screen to Inactive Group
[image: P2706#yIS1]

445. The Are You Sure? dialog box will display. Click Confirm to inactivate the group, or click Cancel to close the dialog box without making changes.
[bookmark: _Toc131159246][bookmark: _Toc164157059]Figure 206 - Confirmation to Inactive Group from Team
[image: P2709#yIS1]
446. The View an Existing Group screen will display, with a confirmation message and the Status listed as Inactive. All values will be defaulted to zero in the View Team Assignments section. 
447. Click the View Inactive/Historical Team Assignments toggle link. The following information will be displayed:
Team
Care Type
Focus
Station
Assignment Start Date
Assignment End Date
The list can be sorted by any column. 
[bookmark: _Toc131158993][bookmark: _Toc164156824]Reports
[bookmark: _Background_Job_Log][bookmark: _Toc131158994][bookmark: _Toc164156825]Background Job Log
A user can search and view background job logs from this screen. 
1. From the main menu, click Reports > Background Job Log. The job list will display all records associated with the station the user is logged into when signed in to PCMM Web. 
[bookmark: _Toc131159247][bookmark: _Toc164157060]Figure 207 - Background Job Log Menu Option Selected
[image: Background Job Log is shown in the Reports menu.]
449. Use the selection criteria to choose another query. Select:
Job Type, if desired (Any is the default, but a user can filter by CPRS Header Sync, CPRS Header Sync Monitor, Patient Auto-Inactivation, Patient Bulk Transfer, Staff Update or VistA Sync ). Vista specific jobs only run for Vista mapped stations.
Job Started After (Current day and time is the default)
Job Started Before, if desired
Include jobs not associated to any station and Include jobs linked to a specific station are checked by default. Uncheck if desired
Station. 
[bookmark: _Toc131159248][bookmark: _Toc164157061]Figure 208 - Background Job Log Screen
[image: P2732#yIS1]
450. Click Submit to continue, Cancel to cancel.
451. The system will display a table with the following columns:
Station
Type
Start Time
End Time
Initiator
Actions
Filter the results by Station, Type and Initiator. 
[bookmark: _Toc131159249][bookmark: _Toc164157062]Figure 209 - Station Table Details Screen
[image: P2743#yIS1]
452. To see the details of a job, click the View Job Results Details icon in the Actions column that corresponds to the job to view. 
[bookmark: _Toc131159250][bookmark: _Toc164157063]Figure 210 - View Job Results Details Screen
[image: P2746#yIS1]
453. The Result of Batch Job Execution screen will display with the following columns:
Patient
Position
Team Status
Result Details
Completion Time
454. Depending on the type of job selected, the appropriate details will display in the table. 
The CPRS Header Sync job type will display the Patient name that links to Patient Profile screen.
[bookmark: _Toc131159251][bookmark: _Toc164157064]Figure 211 – CPRS Header Sync Job Screen
[image: P2756#yIS1]

Note: to see a patient’s profile, click the Patient Profile link in the job report.
[bookmark: _Toc131158995][bookmark: _Toc164156826]Canned and Ad Hoc Reporting
[bookmark: _Toc131158996][bookmark: _Toc164156827]Active Panel Report
This report depicts the Capacity and FTE for each team and optionally each staffed team roles on each team. Note: PCMM Web uses SQL Server Reporting Services to run PCMM Web reports. This enables reports to return results faster than having PCMM Web run reports through its own web application. 
With the appropriate permissions, a user can run reports. If not, they will be read-only. 
1. Click Reports > Canned and Ad-Hoc Reporting. The SQL Server Reporting Services open in a new internet browser. 
[bookmark: _Toc131159252][bookmark: _Toc164157065]Figure 212 - Canned and Ad-Hoc Reporting Menu Option
[image: Canned and Ad-hoc Reporting is shown in the Reports menu.]
456. Click the appropriate folder view the PCMM Web reports. The following reports are: 
[bookmark: _Toc131158997][bookmark: _Toc164156828]Active Panel Report
1. Select from the following SSRS parameters:
Date (required): Default to current date/time, or enter in text box or choose from calendar control). If applicable, the information for the report will display everything on record through the specified date and time.
Report level: (required): Default to station, but can choose from National, VISN, or station. For stations, a user can choose Position Detail.
Care Type (required): Default is All
Focus 
458. The following fields will be displayed:
Station
Team
Care Type/Focus
Name
· Position(s) (Note: Only display this field when “Include Position Detail” check box is selected
Team Status (Indicator for Team)
Capacity
Allowed (Total Number of Patients Allowed for each active team role on the team)
Assigned (Total Number of Patients with current active assignment to the team)
Available (Patient allowed minus patient assigned)
Utilization (Patient assigned divided by patient allowed times 100 = percentage)
FTE
Expected (Total expected FTE for each active team role on the team)
Actual (Total actual FTE captured for each active staff assignment to each active team role on a team)
Utilization (Actual FTE divided by expected FTE divided by 100 = percentage)
459. Include Position Detail
· If the Include Position Detail box is checked, all active team roles with active staff assignments will be displayed.
· This option provides the capacity and FTE for all the active positions with the active staff assignments for each team included in the report and will be listed under the Team Name.  (Ex. Staff Name - Position Assignment)
The data for the assigned capacity and FTE associated with each team role can be retrieved from the following screens:
Position Profile (Allowed Patients, Assigned Patients, Available Patients, Expected FTE)
Show Staff (Actual FTE)
The Position Detail will be listed in the following order:
PCP, if applicable (If there is an active preceptor on team; search for Preceptor but display as PCP)
AP(s), if applicable (If there are any active preceptees for team; search for Preceptee but display as AP
If Preceptor/Preceptees are listed; then a Subtotal row will be provided for the assignments of PCP/AP for capacity and FTE.
Care Manager 
Clinical Associate (Clinical Assc)
Administrative Associate (Admin Assc)
Any additional active team roles with staff assignments will be listed.
[bookmark: _Toc131158998][bookmark: _Toc164156829]Pending Patient Assignment Report
This report determines how long PACT assignments took to activate. This report displays all patient assignments to teams with a care type of “Primary Care” that have a “Pending” status. The items reported include:
Pending Assignments to Primary Care Teams.
Canceled Assignments to Primary Care Teams.
1. Select from the following SSRS parameters:
Report Type: Detail
Target Audience: VISN and Principal Facility PCMM Coordinators
Update Frequency:  This report extracts data from PCMM Web and is generated in real time.
Parameters to be included: Number of pending, active and cancelled patients by National, VISN, facility, and divisions.  
VISN: All VISNs the user is authorized to view are displayed. User selects the VISN(s) to include on the report. 
Station: All Stations for the selected VISN(s) are displayed. User selects the Station(s) to include on the report.
Division: All Divisions for the selected Station(s) are displayed. User selects the Division(s) to include on the report.
Focus: All Focuses are displayed. User selected Focus(s) to include on the report.
Current Assignment Status: User selects Canceled or Pending or Both. 
Data Columns: 
VISN # 
Station # 
Focus 
Current Assignment Status
# Days Pending: The number of days the patient’s PACT team assignment has a PENDING status since assigned to the PACT team. 
MPACT: The overall status of a MPACT Request will display in the report if a MPACT Request is associated with a PACT team assignment for a patient.
Team Name: The name of the assigned PACT team.
PCP Name: The name of the primary care provider the patient is assigned to on the PACT team.
Assignment Start Date: The date and time the patient was originally assigned to the PACT team.
Assignment End Date: The date and time the patient was unassigned from the PACT team.
Unassign Reason: The reason for unassignment.
Patient Name – Includes the last name, first name, and middle name of the patient. This may be restricted to some users.  
Patient SSN – Includes the Social Security Number of the patient. This may be restricted to some users.
[bookmark: _Toc131158999][bookmark: _Toc164156830]Alerts And Notifications
Alerts and notifications are used for efficiently communicate tasks and information to users within the PCMM Web application. Notifications are system generated messages that is assigned to a team or a user when a when a death, transfer, inactivation, or a team change occurs and no further action is required. Alerts are system generated message assigned to a user to take action within PCMM Web, or outside of the application. These alerts are sent to the PCMM Coordinator and/or PCMM TVC.
[bookmark: _View_Alerts_Summary][bookmark: _Toc131159000][bookmark: _Toc164156831]Manage Team and Team Role (Position) Notifications
For teams at Vista mapped stations, PCMM Web will generate VistA mailman messages to team members when certain assignment/unassignment activity occurs.  If needed, a user has the ability to select which notification(s) are received by which team member(s) on both the Team Profile and Team Position Profile screens. 
1. Once the View/Edit the Notification Distribution Rules link is expanded, select PCMM or CPRS from the Filter drop-down list to filter the list by Originator settings.
462. Select the Do Not Send check boxes next to the notifications that are not sent to the team (all notification types selected by default). Notification Types are:
Death
Inpatient Admit/Transfer/Discharge
Automatic Inactivation
Team
[bookmark: _Toc131159253][bookmark: _Toc164157066]Figure 213 - Notifications List Screen
[image: P2842#yIS1]
463. Click Submit to save any changes. A message will appear at the top of the screen to indicate team changes were saved successfully.
If a notification is deselected, select either:
All Team Patients (to send notifications regarding all team patients), or
Only Patients assigned to this Position (to send notifications regarding just patients assigned to the team role).
Note: Users may use the filters above and below the table to restrict or expand the number of rules shown.
[bookmark: _Toc131159001][bookmark: _Toc164156832]Manage Alerts
There are two types of alerts:
Actionable - requires action on behalf of a user.
Informational - for information purposes only.
[bookmark: _Toc131159002][bookmark: _Toc164156833]Actionable Alerts
Staff:
PCMM Coordinator receives an alert when a Staff Member has a Termination Date.
PCMM Coordinator receives an alert when the person class for the staff has changed and is no longer valid for the team role.
Auto-Inactivation:
PCMM Coordinator receives an alert when Patient Scheduled for Inactivation.
MVI ICN:
PCMM Coordinator receives an alert when a patient was moved via MVI ICN mismatch process (Surviving/Deprecated).
PCMM Coordinator receives an alert when the patient and all his assignments were merged due to duplication. (Surviving/Deprecated).
Multi PACT Request:
Local TVC receives an alert for approval/reason entry of a pending PACT assignment at local station.
All TVC(s) at the station(s) listed in the “Required PACT Approvers” section receives an alert requiring approval/denial.
Only TVC(s) at stations that have not responded to the request receives the resent alert.
Alert is sent to all PCMM Coordinator(s) on the request to unassign a patient from the station(s) PACT team when a Permanent Relocation has been completed and a request has been withdrawn.
Informational Alerts:
Team Configuration:
PCMM Coordinator receives an alert when one or more team roles were created/updated by applying a model team template.
PCMM Coordinator receives an alert when a model that may apply to this team has been updated.
Batch Job Execution:
PCMM Coordinator and the user receive an alert when a batch process to historical assign, unassign, or transfer patients between team roles was completed.
Auto-Inactivation:
PCMM Coordinator receives an alert when: 
Patient Automatically Inactivated due to Death Entry
Patient Automatically Inactivated due to Inactivity
Patient Automatically Reactivated due to Death Entry Revocation
Panel Placement Request:
PCMM Coordinator at site generating the request and the PCMM Coordinator at the site listed on the request receives alert when a Panel Placement Request was created or updated.
Multi PACT Request:
[bookmark: _Toc131159003]All TVC(s) and PCMM Coordinator(s) at all stations listed in the “Required PACT Approvers” receive an alert for the overall status of the request. (Approved/Denied/Withdrawn).
All TVC(s) and PCMM Coordinator(s) at all stations receive the denial alert with the exception of the station that just denied it.
All TVCs and PCMM Coordinators on the request receive an alert when request is Withdrawn or Auto Canceled due to identity issues.
Escalation alert is sent to the station TVC who has not taken action on the request within 15 days.
Escalation alert is sent to the VISN TVC when the station TVC has not taken action on the request within 30 days.
Escalation alert is sent to the National PCMM Coordinator if no action is taken on the Multi PACT request within 45 days.
[bookmark: _Toc164156834]View Alerts Summary for a Station
The Alerts Summary displays a summary of all available alerts from all authorized stations that the user is assigned. Only stations that have alerts available for viewing will be displayed. 
1. From the PCMM Web Home Page, click the Alerts menu and select Alerts Summary to display the Alerts Summary screen. 
[bookmark: _Toc131159254][bookmark: _Toc164157067]Figure 214 - Alerts Summary Menu Option Selected
[image: Alerts Summary is shown in the Alerts menu.]
465. If any alerts are pending, a notice box in the top right side of the PCMM Web home page will display. Click the link to display the Alerts Summary screen.
466. The Alerts Summary screen provides the following alert information:
The station name and number.
The number of alerts for each station listed.
A user can use the First, Previous, Next, and Last buttons to navigate the list of alerts. 
Display the number of rows shown by selecting a number from the Display Records drop-down menu.
[bookmark: _Toc131159255][bookmark: _Toc164157068]Figure 215 - Alert Summary Screen
[image: P2898#yIS1]
467. To view the alert details for each message, click the icon in the View column. The Open Alerts List screen will display. 
Note: If selecting a different station, the system will automatically change the station for the user and allow them to view the alerts.  The user will receive a message stating that the station has been changed once a station has been selected.
468. The Open Alerts Lists screen will display all of the Actionable and Informational alerts available for the user. 
469. For each alert with an Alert Type of Informational:  
One alert will be sent to each user who holds the security role defined as an Alert Recipient.  Each user will be responsible for managing their own Informational alerts. If the specific alert does not exist for the user; it will be created.  If the specific alert already exists for the user; another alert will not be created (i.e. the user will not see two of the exact same alerts).  
470. For each alert with an Alert Type of Actionable:  
One alert will be sent to each user who holds the security role defined as an Alert Recipient. The actionable alert will then be closed and removed from each user’s alert list who received the alert.
[bookmark: _Toc131159256][bookmark: _Toc164157069]Figure 216 - Open Alerts List Screen
[image: P2907#yIS1]
[bookmark: _View_Open_Alerts][bookmark: _Toc131159004][bookmark: _Toc164156835]Open Alerts List for a Current Station
A user can view and update all open alerts for a station.
1. From the PCMM Web Home Screen, click the Alerts menu and select Open Alerts List for Current Station to display the Open Alerts List screen. 
[bookmark: _Toc131159257][bookmark: _Toc164157070]Figure 217 - Open Alerts List for Current Station Menu Option
[image: P2912#yIS1]
472. A user can perform the following functions on the Open Alerts List screen:
Click the View Alert Summary link to view the summary of alerts all assigned station.
Click the View Closed Alerts link to view all closed alerts for the station. 
Click the + symbol in the header to show all comments for all alerts in the list. 
Click the + symbol next to an alert to view comments only for that alert. 
To delete an alert, select the check box next to the alert or select the All check box to delete all alerts on the screen. Click the Delete button.
Sort by Actionable and Informational alerts by using the filter drop-down list above the Type column.
Sort by system using the filter drop-down list above the Sender column.
Sort all other columns using the arrow icons. The default listing order is by Requires Action type and by date and time. 
Use the First, Previous, Next, and Last buttons to navigate the list of alerts. 
Change the number of rows shown by selecting a new number from the Display Records drop-down list.
[bookmark: _Toc131159005][bookmark: _Toc164156836]Updating an Alert
1. Click the View/Action on Alerts icon in the Actions column to display the appropriate screen that the alert was generated from.
1. A message displays at the top of the screen with two links. Click the Save for Later link to save the alert in the Open Alerts List Alert screen. Click the Mark as Complete link to mark the alert as complete and move the alert to the Closed Alerts List. 
Note: The message will remain visible on the screen until the user completes one of the actions. If the user navigates away from screen, the same message will display on the next screen until action is taken.
[bookmark: _Toc131159006][bookmark: _Toc164156837]Adding Comments to an Alert:
1. Click the Update Comments icon in the Actions column to display the Enter a Comment dialog box.
1. Enter the necessary information and click Submit to save a comment or Cancel to return to the Open Alerts List screen without saving the comment.
1. The Comment is now attached to the alert and can be viewed when the user clicks the expand plus sign on the left of the alert.
[bookmark: _Toc131159007][bookmark: _Toc164156838]Deleting an Alert
1. Click the Delete Alert icon in the Actions column to display a dialog box to either confirm or cancel the deletion. 
[bookmark: _Toc131159258][bookmark: _Toc164157071]Figure 218 - Deleting or Adding Comments to an Alert
[image: P2935#yIS1]
[bookmark: _View_Closed_Alerts][bookmark: _Toc131159008][bookmark: _Toc164156839]View Closed Alerts List for a Current Station
A user can view all the closed alerts and alerts marked as complete for the station. The alert is never deleted and a historical record is kept in the system. The Alert table displays the user that closed the alert and the date and time of that action. No further action can be made to closed alerts.
1. From the PCMM Web Home Screen, click the Alerts menu and select Closed Alerts List for Current Station to display the Closed Alerts List screen.
[bookmark: _Toc131159259][bookmark: _Toc164157072]Figure 219 - Closed Alerts List for Current Station Menu Selection
[image: Closed Alert List is shown in the Alerts menu.]
A user can perform the following functions on the Closed Alerts List screen:
· Click the View Alert Summary link to view the summary of alerts all assigned station.
· Click the View Open Alerts link to view open alerts a station.
· Click the + symbol in the header to show all comments for all alerts in the list. 
· Click the + symbol next to an alert to view any comments only for that alert. 
· Sort by Actionable and Informational alerts by using the filter drop-down list above the Type column.
· Sort by system using the filter drop-down list above the Sender column.
· Sort all other columns using the arrow icons. 
· Change the number of rows shown by selecting a number from the Display Records drop-down menu.
· Send an email to the user who closed the alert by clicking the envelope icon next to their title.
[bookmark: _Result_of_Batch][bookmark: _Toc131159009][bookmark: _Toc164156840]Result of Batch Job Execution
Once a batch process is submitted, a user will be notified that the batch job is complete. A use can then view the alert and additional details in the Batch Execution Results screen.
1. From the Alerts drop-down menu, select Open Alerts List for Current Station to display the Open Alerts List screen. Alternatively, any alerts pending display in the notice box in the top right side of the PCMM Web home page. This notice provides a link to the Alerts Summary screen.
[bookmark: _Toc131159260][bookmark: _Toc164157073]Figure 220 - Open Alerts List for Current Station Menu Option
[image: Open Alerts List for current station is shown in the Alerts menu.]
481. Select the View/Action on Alerts icon in the Actions column to display the Result of Batch Job Execution screen.
[bookmark: _Toc131159261][bookmark: _Toc164157074]Figure 221 - Selecting Actions Icon to View Results of Batch Job Execution
[image: P2958#yIS1]
482. View the list of batch results for each patient. A user can filter the list using the controls next to each heading.
[bookmark: _Toc131159010][bookmark: _Toc164156841]Administration
[bookmark: _Performing_Administrative_Tasks][bookmark: _Toc131159011][bookmark: _Toc164156842]Performing Administrative Tasks
Administrators have the ability to manage various tasks. They can do the following:
Manage the permissions settings that drive the activities a particular system user can perform. 
Assign administrative and functional stations to a system user within their own station.
Manage the users under their own area or those of areas under their responsibility.
Local Administrators can assign stations to a system user within their own station. Each PCMM Web user must have VistA privileges for each specific division at vista mapped station they need to access per 5 digit station level. Access to a main facility (i.e., 3 digit station level) will only provide access to the main facility data.
Regional and National Administrators have a larger pool of stations available to them for assignment of users. This is helpful when a system user is an Occupational Health (OH) provider at multiple facilities. 
[bookmark: _Manage_Reference_Data][bookmark: _Toc131159012][bookmark: _Toc164156843]Manage and Modify Reference Data
A PCMM Web National Administrator is able to view and manage the data on the drop-down lists within the PCMM Web application, so that the selection list of values will not require modification by developers and will be available immediately.
[bookmark: _Toc131159013][bookmark: _Toc164156844]Manage Reference Data
1. From the Administration drop-down menu, select Manage Reference Data to display the Manage Reference Data screen.
1. Select a reference type from the Reference drop-down list and click View to display a list of data. 
1. Click a name link in the Name column to display the Modify Reference Data screen. The Modify Reference Data screen will display the Care Type and Focus data, while the Manage Reference Data screen will display for the Non-VA Provider Role choice.
1. Enter/change the following information:
Name
Description
Sort Order
Justification
Check the box to inactivate the data record, if desired. An Inactivate Reason will be required to save the record. If the record is an existing record, the Code cannot be changed
487. Click Submit/Confirm to save, Cancel/Confirm to exit without saving changes and return to the Manage Reference Data screen.
488. A user also has the option of selecting another reference type to display. Select another choice from the Reference: Type drop-down list and click View. 
[bookmark: _Toc131159014][bookmark: _Toc164156845]Add a New Value
1. Add a new value by clicking the Add New Value button. The Add Reference Data screen will show. Enter:
Code (required)
Name (required)
Description (required)
Sort Order
Justification
Inactivate (this can be used to initially inactivate, enter the data and activate at a later date)
If Inactivate is chosen, an Inactivate Reason text box will display. Enter a reason.
490. Click to Submit and save changes, or Cancel to cancel.
[bookmark: _Toc131159015][bookmark: _Toc164156846]Help File
A user can view the PCMM Web Help from the Help Menu for step-by-step procedures on how to assign a team, assign a patient to a profile, update a team role, and more. Additionally, helpful hints and information about the application is available in the help file.
1. Select Help > Web Help from the main menu to display the PCMM Web Help File.
[bookmark: _Toc131159262][bookmark: _Toc164157075]Figure 222 - Web Help Icon Selected
[image: P2996#yIS1]
Note: The PCMM help file is also launched by click the [image: P2997#yIS1] icon and is available on the upper left side of the screen, below the Main Menu and bread crumb links.
[bookmark: _Toc131159263][bookmark: _Toc164157076]Figure 223 - Help Icon in PCMM Web
[image: P2999#yIS1]
492. A user can view the following information by clicking on the Table of Contents icon.
[bookmark: _Toc131159264][bookmark: _Toc164157077]Figure 224 - PCMM Web Help File
[image: P3002#yIS1]
1. In the PCMM Web Help File, users can search for a specific topic or subject by selecting the Index, Search, and Glossary tabs.
Index – Lists keywords alphabetical. Click the keyword to display a pop-up menu of topics related to the selected keyword.  Select the topic to view additional information.
[bookmark: _Toc131159265][bookmark: _Toc164157078]Figure 225 - Index in PCMM Web Help File
[image: P3006#yIS1]
Search – Enables a user to search for a topic by entering the keyword.  All topics with the keyword display, according to rank.
Glossary – Lists glossary terms alphabetical. 
[bookmark: _Toc131159016][bookmark: _Toc164156847]Help Menu
The Reference Menu provides a user with easy access to important links, policies and procedures, and other publications directly from PCMM Web.
[bookmark: _Toc164157079]Figure 226 - Help Menu and possible selections
[image: Help menu and all associated selections within it.]
[bookmark: _Toc164156848][bookmark: _Toc131159017]Web Help
This selection will open the PCMM Help File. This resource is able to answer many questions of the functions within PCMM.
[bookmark: _Toc164157080]Figure 227 - PCMM Web Help
[image: An example of the PCMM Web Help.]
[bookmark: _Toc164156849]Primary Care Links
1. Select Help > Primary Care Links > PACT SharePoint from the main menu to display the PACT SharePoint site.
The SharePoint site provides helpful resources to implement the Patient Aligned Care Team (PACT) at your local facility. 
495. Select Help > Primary Care Links > PCMM Training from the main menu to display the Primary Care Management Module (PCMM) Training Home page.
The PCMM Training page provides links to training material and information related to PCMM. 
496. Select Help > Primary Care Links > VSSC PCMM Coordinator List from the main menu to display the National PCMM Coordinator & Referral Case Manager List.
The National PCMM Coordinator & Referral Case Manager List provides a list of PCMM VA facilities and coordinators. 

[bookmark: _Toc131159018][bookmark: _Toc164156850]Mental Health Links
1. Select Help > Mental Health Links from the main menu to display the Mental Health Services Training Resources SharePoint site.
The SharePoint site provides helpful resources to implement the related Mental Health PCMM. 
498. Select Help > Mental Health Links > BHIP Team Basics from the main menu to display the Behavioral Health Interdisciplinary Program Teams page.
The BHIP page provides tools to help build Collaborative Teams, Veteran Centered Care, and Care Coordination and Access related to mental health care for Veterans. 
499. Select Help > Mental Health Links > Mental Health Dashboard from the main menu to display the Mental Health Dashboard report page.
The Mental Health Dashboard includes a report summary and stats for several VA facilities. 
500. Select Help > Mental Health Links > Electronic Technical Manual from the main menu to display the Electronic Technical Manual.

[bookmark: _Toc131159019][bookmark: _Toc164156851]Troubleshooting
If screen display issues occur when working in PCMM Web, enable Compatibility Mode in the browser. This issue may occur in Internet Explorer browsers. To manually enable the setting, open PCMM in Internet Explorer and click the Tools button and then click Compatibility View settings. Under Add this website, enter the PCMM Web URL site to add to the list and click Add.
[bookmark: _User_Roles][bookmark: _Toc131159020][bookmark: _Toc164156852]User Roles
The following are the available roles to assign a user in PCMM Web.
[bookmark: _Toc131159270]Table 4 - User Roles, Descriptions, and Permissions
	Role
	Description

	PCMM Coordinator
	Able to utilize all functionality to create, manage and assign to any PCMM team.

	PCMM MH Coordinator
	Able to utilize all functionality to create, manage and assign to MHTC PCMM teams only. 

	PCMM MultiPCP Clinical Approver
	Clinicians currently and potentially caring for the patient or their clinical designee responsible for determining whether there is compelling clinical need for Multi-PACT assignments.

	PCMM Specialty Coordinator
	Responsible for Non-PACT PCMM management, setup and patient assignments. 

	PACT Administrator – Limited View
	Able to view all areas within the application except for patient level data

	PACT Administrator – View All
	Able to view all areas within the application including patient level data. 

	PCMM Clerk
	The role assigned for staff members who performs data entry tasks.

	PCMM MH Clerk
	The role assigned for staff members who performs data entry tasks for MH teams only. 

	PCMM Reports Only
	User access to PCMM reports only

	PCMM Specialty Clerk
	The role assigned for staff members who performs data entry tasks for Non PACT areas only. 

	PCMM Traveling Veteran Coordinator
	Facilitates PCMM Multi-PACT requests while acting as the liaison between sending/receiving facilities for traveling veterans needing care coordination and communicates with the TVC at the other facility to obtain/send information.

	PCMM Back-up Traveling Veteran Coordinator
	Serves as the back-up to the TVC

	PCMM VISN Coordinator
	This designated staff member serves as the VISN’s PCMM technical expert with the ability to utilize and troubleshoot all areas of the application and has the ability to access and delegate PCMM user permissions and necessary user training.

	PCMM VISN Traveling Veteran Coordinator
	Serves as the VISN TVC SME with the ability to act on the VISN’s facilities PCMM Multi-PACT requests as needed.  

	PCMM Backup Principal Facility Coordinator
	Serves as the back up to the Principal Facility Coordinator

	PCMM Principal Facility Coordinator
	There is one PCMM Principal Facility Coordinator for each station (parent station and divisions).  This designated staff member serves as the facility’s PCMM technical expert with the ability to utilize and troubleshoot all areas of the application and has the ability to access and delegate PCMM user permissions and necessary user training.



[bookmark: _Toc131159271]Table 5 - Detailed Role Table
	 
	PCMM National Coord.
	PCMM VISN Coord.
	PCMM Principal Facility Coord.
	PCMM Coord.
	PCMM Clerk
	PCMM VISN Traveling Veteran Coord.
	PCMM Traveling Veteran Coord.
	PCMM MH National Coord.
	PCMM MH Coord.
	PCMM MH Clerk
	PCMM Specialty Coord.
	PCMM Specialty Clerk

	Patient Management

	Assign Patient to PC
	x
	x
	x
	x
	x
	 
	 
	 
	 
	 
	 
	 

	Assign Patient to MH
	x
	x
	x
	 
	 
	 
	 
	x
	x
	x
	 
	 

	Assign Patient to Spec
	x
	x
	x
	 
	 
	 
	 
	 
	 
	 
	x
	x

	Assign Patient to NVA Care
	x
	x
	x
	 
	 
	 
	 
	 
	 
	 
	 
	 

	View Patient
	x
	x
	x
	x
	x
	x
	x
	x
	x
	x
	x
	x

	Team Management

	Create PC Teams
	x
	x
	x
	x
	 
	 
	 
	 
	 
	 
	 
	 

	Update PC Teams
	x
	x
	x
	x
	 
	 
	 
	 
	 
	 
	 
	 

	Delete PC Teams
	 
	 
	 
	x
	 
	 
	 
	 
	 
	 
	 
	 

	Create MH Teams
	x
	x
	x
	 
	 
	 
	 
	x
	x
	 
	 
	 

	Update MH Teams
	x
	x
	x
	 
	 
	 
	 
	x
	x
	 
	 
	 

	Delete MH Teams
	 
	 
	 
	 
	 
	 
	 
	x
	x
	 
	 
	 

	Create Spec Teams
	x
	x
	x
	 
	 
	 
	 
	 
	 
	 
	x
	 

	Update Spec Teams
	x
	x
	x
	 
	 
	 
	 
	 
	 
	 
	x
	 

	Delete Spec Teams
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 
	x
	 

	Create NVA Care Teams
	x
	x
	x
	 
	 
	 
	 
	 
	 
	 
	 
	 

	Update NVA Care Teams
	x
	x
	x
	 
	 
	 
	 
	 
	 
	 
	 
	 

	Delete NVA Care Teams
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 

	View Teams
	x
	x
	x
	x
	x
	x
	x
	x
	x
	x
	x
	x

	Room Management

	Create Rooms
	x
	x
	x
	x
	 
	 
	 
	 
	 
	 
	 
	 

	Update Rooms
	x
	x
	x
	x
	 
	 
	 
	 
	 
	 
	 
	 

	View  Rooms
	x
	x
	x
	x
	 
	 
	 
	 
	 
	 
	 
	 

	Assign Rooms
	x
	x
	x
	x
	 
	 
	 
	 
	 
	 
	 
	 

	Group Management

	Create Groups
	x
	x
	x
	x
	 
	 
	 
	 
	 
	 
	 
	 

	Update Groups
	x
	x
	x
	x
	 
	 
	 
	 
	 
	 
	 
	 

	View Groups
	x
	x
	x
	x
	 
	 
	 
	 
	 
	 
	 
	 

	Assign Groups
	x
	x
	x
	x
	 
	 
	 
	 
	 
	 
	 
	 

	Model Configuration

	Create Models
	x
	x
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 

	Update Models
	x
	x
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 

	Delete Models
	x
	x
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 

	View Models
	x
	x
	 
	x
	x
	 
	 
	 
	 
	 
	 
	 

	

	Non-VA Provider

	Create NVA Provider
	x
	 
	x
	x
	x
	 
	x
	x
	x
	 
	x
	 

	Update NVA Provider
	x
	 
	x
	x
	x
	 
	x
	x
	x
	 
	x
	 

	Assign NVA Provider
	x
	 
	x
	x
	x
	 
	x
	x
	x
	 
	x
	 

	View NVA Provider
	x
	x
	x
	x
	x
	x
	x
	x
	x
	x
	x
	x

	Manage Reference Data

	Create Reference Data
	x
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 

	View Reference Data
	x
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 

	Update Reference Data
	x
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 

	Delete Reference Data
	x
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 

	Reports
	x
	x
	x
	x
	x
	x
	x
	x
	x
	x
	x
	x

	User Management
	x
	x
	x
	 
	 
	 
	 
	x
	 
	 
	 
	 



[bookmark: _Toc131159272]Table 6 - Detailed Care Type Table
	 
	PCMM National Coord.
	PCMM VISN Coord.
	PCMM Principal Facility Coord.
	PCMM Coord.
	PCMM Clerk
	PCMM MH National Coord.
	PCMM MH Coord.
	PCMM MH Clerk
	PCMM Specialty Coord.
	PCMM Specialty Clerk
	PCMM Non-VA Care Coord.

	Primary Care
	x
	x
	x
	x
	x
	
	
	
	
	
	

	Primary Care - HBPC
	x
	x
	x
	x
	x
	
	
	
	
	
	

	Case Management
	x
	x
	x
	
	
	
	
	
	x
	x
	

	Community Care
	x
	x
	x
	
	
	
	
	
	x
	x
	

	Inpatient SCI
	x
	x
	x
	
	
	
	
	
	x
	x
	

	Mental Health
	x
	x
	x
	
	
	x
	x
	x
	
	
	

	Non-PC Specialty (Med/Surg)
	x
	x
	x
	
	
	
	
	
	x
	x
	

	Non-VA Care
	x
	x
	x
	
	
	
	
	
	
	
	x

	Transition and Care Management
	x
	x
	x
	
	
	
	
	
	x
	x
	



Table 7 - Team Roles within PCMM



[bookmark: _Toc131159021][bookmark: _Toc164156853]Glossary
A
ACOS: Associate Chief of Staff.
Admin Coordinator: The administrative coordinator for Primary Care and Non-Primary Care Teams. This person is involved with administrative (MAS requirements and/or Clinic Administration) duties as well as oversight of the Scheduling process and Primary Care team definition. 
Alerts: Alerts are system-generated messages that provide information. Alerts are either Informational or Actionable. A user must have the appropriate security access to view alerts.
Arrow: Arrow is a symbol that is used to scroll up and down lists, and left to right for moving objects (patient names, e.g.). 
Associate Provider: An Associate Provider is authorized to provide primary care, but cannot act as a Primary Care Provider. In PCMM, a Resident is designated as an Associate Provider. A Nurse Practitioner and/or Physician Assistant may be designated as an Associate Provider also. Per VHA Directive every patient is to be assigned to a Primary Care Provider, who is responsible for coordinating a patient’s overall care. Thus, the Associate Provider on a Primary Care Team must be assigned to a preceptor who can be a Primary Care Provider (must have a Primary Care Provider preceptor assigned to them).
Austin Automation Center: The central repository for National Care Patient Care Database.
Auto Team Enrollment/Discharge: This is an option when setting up Teams that will automatically enroll a patient to a TEAM when the patient is enrolled in a clinic that is associated with that team. A user can also discharge from a TEAM (if not assigned to a team role in a team) when the patient is discharged from a clinic associated with that team.
B
Button Bar: A Button Bar is also referred to as a Tool Bar - small boxes that contain graphic figures that represent various functions. 
C
Calendar Display: Within PCMM, when there is a date field, the user can “double click” the field and a miniature calendar will ‘pop up’ for selection of a date and year. This is used for Activation and Deactivation dates as well as Discharge dates. 
Care Type: A required field that describes the type of service being delivered by the teamlet. The user must select an item from the list displayed.
Clerk: This person is a clerk who performs data entry. 
Context Bar: The dark blue banner at the bottom of the Banner that shows the user’s duty station, user name, and log out link. There are also buttons of the applications that the user has permissions to use. If the user is an administrator, they can sign on with no duty station specified (as in the example above) until they begin to perform the functions they have authorization to do.
Clinical Pharmacist: Performs patient care duties related to patient medications as assigned or granted by the appropriate governing committee at the facility. These privileges may include and may or may not be limited to: 
(1) Initiation of renewal orders for chronic maintenance medications 
(2) Initiation of orders for laboratory tests necessary to monitor existing drug therapy. 
Clinical Service: A Service defined at the medical center, e.g. Medicine, Surgery, Intermediate Medicine, etc.
Closing: Another term for ‘inactivating’ a team role or team.
Consults: When a patient is referred to a clinic on a one-time basis, he/she is not normally enrolled in that clinic.
Control Key: A Control Key is the key on the lower left and right hand side of the keyboard that is entitled ‘CTRL’. When a user presses this key along with another character (e.g. CTRL + O), the user can select and OPTION, etc.
D
Database: This refers to the information that is stored in your medical center’s computer program, e.g., patient information, service information, clinic information, etc.
Dialogue Box: A dialogue box is a box or window that is placed within a screen that allows the user to enter a ‘free text’ message or description of the object being created (in some cases, the description of what a team is supposed to represent).
Dietitian: Performs patient care duties related to nutrition and weight management.
Display Box: This is a window that displays information or lists available clinics, team roles, or teams to choose from. The user may select an item from the list displayed.
Double Arrow: Double arrows are two arrows next to each other indicating that more than one patient name may be moved over from an inactive status to an active status and back to an inactive status. (>>)
Drop-Down List: When a user selects an item from the menu bar, a list is displayed in a vertical format. For example, if a user selects File, a list drops down showing all options that are available under the main heading File: File, Edit, Print, Save.
Duty Station: A duty station is a location where a person is based (typically, it is where a person receives a paycheck). It may be a place where health care is not provided, such as a national cemetery or an office building.
E
E-Mail Messages: These are the messages that are generated by a software event that delivers information to designated users via MailMan. E-mail messages in the PCMM module would include information about death notifications, inpatient movements, consult notifications, and team notifications or changes.
F
Footer:  The Footer is displayed at the bottom of every window. It displays the version of the application, the copyright date, and a link to contact the application owners.
Functional Station:  A location where health care is provided (a treating facility), such as a VA Hospital/Medical Center or clinic.
Focus: The focus further identifies the type of service being delivered by the teamlet.  Focus 1 is required for the Care Type of Primary Care and should reflect the principal service delivered. Focus 2 is optional and may serve to further define additional services delivered by the teamlet.  The selection of a Focus under the Care Type of Primary Care will auto populate teamlet positions.
H
Highlight: To ‘Highlight’ a name, team, team role, or date, one would place the cursor (or arrow) on the name, team, or team role they wish to choose and ‘click’ the mouse button to select it or highlight it.
History File: Although not specific to any one document, a history file is a compilation of various pieces of information pertaining to individual teams, team roles, etc. for future reference and clarification.
I
Icon: An Icon is an image or snapshot of something that is visually understood and is represented in a ‘box’. For instance, an ICON that stands for ‘cutting’ a piece of text out of a document would be a box with a picture of a pair of scissors in it. They are also known as ‘buttons’.
Intern (Physician): Performs patient care duties in accordance with Medical Center Policy and is supervised by a Preceptor who can act as a Primary Care Practitioner. Duties include, but may not be limited to, (1) completing history & physical examinations, (2) obtaining blood and other specimens, and (3) provision of patient medical care as permitted. The person cannot act as Primary Care Provider. The Intern is an Associate Provider within a Primary Care Team (see Associate Provider Term). 
IRM: Information Resource Management
M
MAS ADPAC: Medical Administration Service Automated Data Processing Applications Coordinator
Medical Student: Performs patient care duties in accordance with Medical Center Policy and is supervised by a Preceptor who can act as a Primary Care Practitioner.
Menu: The list of items on the left side of the window. The Menu displays the actions that are available to a user, based on the role.
N
NPCD: National Patient Care Database - is maintained in Austin and receives selected demographic and encounter-based clinical, diagnostic data form VA medical centers. This data enables a detailed analysis of VHA inpatient and outpatient health care activity.
Nurse (LPN): Provides a variety of nursing services that do not require full professional nurse education, but are represented by the licensing of practical and vocational nurses by a State, Territory or the District of Columbia. Persons in these team roles may also provide administrative assistance, such as making appointments, etc.
Nurse (RN): Provides care to patients in clinics and other settings, administers anesthetic agents and supportive treatments to patients undergoing outpatient surgery and other medical treatments, promotes better health practices, and consults or advises nurses providing direct care to patients. Persons in this team role require a professional knowledge and education in the field of nursing.
Nurse Practitioner: Performs patient care duties in accordance with Scope of Practice under the supervision of a designated physician or physicians and Medical Center Policy. Duties include, but are not limited to, appropriate assessments, orders diagnostic tests and consultations as necessary, prescribes treatment interventions in accordance with established protocols, provides or arranges follow-up care, and provides health teaching and supportive counseling. Is authorized to act as a Primary Care Provider or Associate Provider. The ability to act as a Primary Care Provider is decided by individual facilities.
O
OIF/OEF: Operation Iraqi Freedom/Operation Enduring Freedom.
Other: A general classification for those team members who do not belong in any of the listed Standard Position entries.
P
Panel: A panel is a group of individual patients for which the Primary Care Provider has accepted primary care responsibility.
Patient Panel: Group of individual patients assigned to a Team/Position.
Practitioner: Can be either Primary Care or Non Primary Care patients; e.g., the Practitioner’s Patients Report includes both Primary Care and Non Primary Care patients assigned to the practitioner in the Patient Panel Count.
Patient Services Assistant: Provides clerical and patient processing support to outpatient clinics, or other unit of a medical facility, in support of the care and treatment given to patients. This includes duties as receptionist, record-keeping duties, clerical duties related to patient care, and miscellaneous support to the medical staff of the unit.
PC Coordinator: Primary Care Coordinator
PCMM: Patient-Centered Management Module
Person Class File: Consists of provider taxonomy developed by Health Care Finance Administration (HCFA). The taxonomy codifies provider type and provider area of specialization for all medical related providers.
Physician Assistant: Performs patient care duties in accordance with Scope of Practice under the supervision of a designated physician or physicians and Medical Center Policy. Duties include, but are not limited to, diagnostic and therapeutic medical care and services, taking case histories, conducting physical examinations, and ordering lab and other studies. Physician Assistants also may carry out special procedures, such as giving injections or other medication, apply or change dressings, or suturing minor lacerations. The ability to act as a Primary Care Practitioner is decided by individual facilities.
Physician-Primary Care: As a physician, incumbent's duties are to advise on, administer, supervise or perform professional and scientific work in one or more fields of medicine. The degree of Doctor of Medicine or Doctor of Osteopathy is a fundamental requirement, along with a current license to practice medicine and surgery in a US State, territory or the District of Columbia. As a Primary Care practitioner, the incumbent provides the first point of assistance for a patient seeking care. Primary Care duties include: (1) Intake and initial needs assessment, (2) Health promotion and disease prevention, (3) Management of acute and chronic biopsychosocial conditions, (4) Access to other components of health care, (5) Continuity, and (6) Patient and non-professional care giver education & training. (from IL 10-93-031, Under Secretary for Health's Letter) Can act as Primary Care Practitioner.
Physician-Psychiatrist: As a physician, incumbent's duties are to advise on, administer, supervise or perform professional and scientific work in one or more fields of medicine. The degree of Doctor of Medicine or Doctor of Osteopathy is a fundamental requirement, along with a current license to practice medicine and surgery in a US State, territory or the District of Columbia. The incumbent is also granted clinical privileges (by the appropriate governing Credentials committee) in regard to the practice of Psychiatry.
Physician-Subspecialty: As a physician, incumbent's duties are to advise on, administer, supervise or perform professional and scientific work in one or more fields of medicine. The degree of Doctor of Medicine or Doctor of Osteopathy is a fundamental requirement, along with a current license to practice medicine and surgery in a US State, territory or the District of Columbia. The incumbent is also granted clinical privileges (by the appropriate governing Credentials committee) concerning the practice of Specialty or Subspecialty care in the areas of Medicine or Surgery.
Position: Or referenced as Team Roles. Teams are comprised of one or more staff positions (or team roles). Individual practitioners are assigned to a team position (or role). A position (or role) is designated to serve certain roles in the overall primary care setting.
Preceptor: Responsible for providing the overall care for patients assigned to an Associate Provider or Medical Student. On Primary Care Teams, the Preceptor must be able to provide Primary Care.
Primary Care: Primary care is the provision of integrated, accessible health care services by clinicians that are accountable for addressing a large majority of personal health care needs.
Patient-Centered Management Module (PCMM): Patient-Centered Management Module is the application for VA facilities to use for implementing primary care teams. Teams are created, team roles associated with the teams are created, staff members are assigned to team roles, and patients are assigned to the teams and team roles.
Primary Care Provider: In PCMM, the Primary Care Provider is the team role determined to be responsible for the coordination of the patient’s primary care.
Psychologist: Performs patient care duties in accordance with Clinical Privileges as assigned or granted by the appropriate governing committee in the area of Psychology and Mental Health. This may include individual, family and group counseling and psychotherapy, assertiveness and other behavior training, etc.
R
Rehab/Psych Technician: Provides patient care in accordance with Clinical Privileges as assigned or granted by the appropriate governing committee in the area of Psychology and Mental Health. This may include individual, family or group counseling. A degreed Psychologist or Mental health practitioner typically supervises the incumbent.
Remedy Ticket: A support request that is sent to the VA Service Desk.
Resident (Physician): Performs patient care duties in accordance with Medical Center Policy and is supervised by a Preceptor who can act as a Primary Care Practitioner. Duties include, but may not be limited to, completing history and physical examinations, obtaining blood and other specimens, and provision of patient medical care as permitted. The resident is an Associate Provider within a Primary Care Team. As a Resident, the incumbent is responsible for providing patient care as directed by the Preceptor. Cannot act as Primary Care Provider.
Role: A function or task of a staff member involved with the implementation, maintenance and continued success of primary care.
S
Section 508 Compliance: Applications that are Section 508 compliant can be used with assistive technology software.
Social Worker: Performs patient care duties in accordance with Clinical Privileges as assigned or granted by the appropriate governing committee in the area of Social Work. Provides direct services to individuals, groups and families with counseling, discharge planning, crisis intervention, etc.
Specialty Clinics: A set of clinics that are defined as SUBSETS of generalized Service clinics such as Cardiology (specialty of Medicine); Orthopedics (specialty of Surgery), etc.
T
Team: Teams are groups of staff members organized for a certain purpose (e.g., Primary Care).
Team Capacity Override: This option is available when the user selects to override the capacity and represents the adjusted number of patients that should be assigned to this team.  This functionality is only used with Primary Care types that have a Focus of Primary Care Only or Women’s Health. This field.  This adjusted value must be > 0 and can be < or > the Team Modeled Capacity. 
Team Modeled Capacity: The total number of patients that should be assigned to this team (e.g. the Panel Size for the team). This value is take from the Aggregated Modeled Team Capacity for station and adjusted according to the team’s Primary Care Direct Care, Support Staff FTE, and Room Utilization. 
Team Pharmacist: A pharmacist who: (1) Is authorized to Fill/Dispense medications (2) Enter/Verify medication orders (3) Provide patient education relating to medications (4) Renew established medications under the protocols defined by the medical center.
Team Profile: This is a screen within PCMM that shows the various characteristics of a particular team, e.g., number of patients allowed for enrollment, name, team roles assigned, etc.
Text Box: The text box is also known as the DIALOGUE box as described above. It provides the user with an area in which to identify certain characteristics of a particular component of PCMM. For example, the description of what a team is for (provides primary care to patients that have been discharged from the hospital within the last 6 months).
Title Bar: Title bar is the bar that shows the TITLE of the screen that the user is presently accessing. For instance, the TITLE BAR on the Team Set-Up screen could be ‘Team Profile.’
Tool Bar: The Tool Bar is what is displayed either at the top of the screen or at the button, and contains a picture of all of the available ICONS that may be chose to perform certain tasks. Unlike the MENU BAR, the menu bar contains the ‘words’ for functions, whereas the TOOL BAR contains the ‘pictures’ that represent functions.
Tool Buttons: A tool button is ONE of the icons that is shown across the top (or bottom) of a screen on the TOOL BAR.
TPA: Transition Patient Advocates assist in tracking the treatment of seriously ill veterans of Operation Iraqi Freedom (OIF) and Operation Enduring Freedom (OEF).
U
Uniques: Uniques for the purpose of PCMM Primary Care are defined as the individual veteran (patient) enrolled in VA health care that makes up the primary care provider’s panel.
User Class: User Class is a file that will be transported with the Primary Care Management Module that stores the users (physicians, social workers, staff clerks, etc.) actual position titles as defined by the site.
User Profile: A user profile is called My Profile and is accessed from the left menu bar. It contains user information such as the user’s role.
V
VistA: Veterans Health Information Systems and Technology Architecture, formerly known as Decentralized Hospital Computer Program, encompasses the complete information environment at VA medical facilities.
VHA: Veteran's Health Administration
[bookmark: _Toc511130650]VISN: Veterans Integrated Service Network
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Patient Centered
Management Module

Patient-Centered Management Module

This application is being incrementally developed to fully support a team based, patient-centric approach
to healthcare delivery. It will allow a team to be formed and aligned around a patient, including providers
across multiple VA sites and in non-VA settings to enable care coordination and communication. It will also
support automated data collection for management metrics and analysis related to access, workload, and
panel management

'VHAs model of team-based care is known as the PACT. The PCMM software application will evolve to

identify all team members and specialists (VA and non-VA) involved in the care of the patient, and provide
modalities to faciltate provider-to-provider communication

« For PCMM permission changes, please contact your VISN or Facility PCMM Coordinator
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Alert Summary

Q
Station Name Number of Alerts Actions
CHYSHR (#983) 16
COLUMBUS VAMC (#757) 2
DAYSHR (#984) 40
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PCHMHM Help - Windows Internet Explorer =100] ],

| @ http://10.208.148.71: 10 100 pemmhelpjindex.htm

2]

[ contents [ index | Seach | Glossay |

] System Requirements.

5] LogInto ClSS.

5] Log Into PCHM

[E] PCHM Home Screen

5] Log Out of PCHM

5] Help With Error Messages
5] Automatic Time out

5] Log In Lockout

5] Select or Change a Station
@ Patient lanagement

@ Team tanagement

@ Staf tianagement

@ Rooms Hianagement

@ Group lanagement

@ Reports

@ Hierts

@ Acministration

Home > Getting Started > PCMM Overview

Ltide |
PCMM Overview

The Patient-Centered Management Module (PCMM) is a web-based application
that was developed to assist VA facilities in implementing primary care. PCMM
supports both primary care and non-primary care teams. Teams are groups of
staff members organized for providing the Veteran patient continuous and
quality care. The software allows you to:

* Set up and define a team

* Assign positions to a team
* Assign staff to a position wit
* Assign patients to a team

* Assign patients to a practitioner within a team

* Reassign patients from one team to another team

These PCMM help topics provide detailed information to assist Clinical
Information Support System (CISS) site staff members and other users to
successfully use CISS and PCMM. CISS is the web portal that hosts the PCMM
application.

The PCMM documentation is located on the VA Software Document Library
(VDL) Web site.
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=] System Requrements

[5) Access PCMM Web

[5) Select or Change a Station
5] PCMM Web Home Page
5] Log Out of PCMM Web

[5) Automatic Time out

5] Helo With Error Messages
[5) User Management

@ Team Management

@ Patient Management

@ Staff Management

@ Rooms Management

@ Group Management

@ Alerts and Notifications

@ Reports

@ Administration

@ Helo File

@ Reference

PCMM Web Overview

The Patient Centered Management Module (PCMM) Web application ass
integrated through the Clinical Information Support System (CISS) portal.

The newly developed Primary Care (PC) system balances productivity witt
delivering essential health care, coordinating all health care services, and
multiple VA sites and in non-VA settings for efficient care coordination anc
Additionally, teams can be grouped together for a larger collaborative tea

‘Within PCMIM Web, users can establish and define a healthcare team, ass
assigned to multiple PACT teams. Those assignments are tracked across V
stations are allowed, but there can only be one active assignment per pat

When PCMM Web data is entered in a standardized manner, it can be use

manage the overall care provided to a majority of VA health care systems,

For additional PCMM Web documentation, refer to the VA Software Docu
http:/Awwvva. govivdl/

Note: The National Service Desk (NSD), also known as the Helpline, will p
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« Due to the width of some tables, PGMM is best viewed by maximizing the web browser window to full screen mode.
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